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Introduction

Archive Manager for Exchange is a comprehensive solution to consolidate, preserve, and retrieve
your organization's emails from Microsoft Exchange Servers. This guide describes the information
available to monitor and manage your deployment, the options, actions, and processes that you
can leverage to archive emails, and the powerful search capability to locate and manage the
archives.

Managing the deployment

Whether you have a single-instance or a load-balanced distributed deployment with multiple
archive and retrieval servers, managing their health is centralized in the Archive Manager for
Exchange Administration Center (AMAC). The AMAC gives you full control of automated archival
jobs for user mailboxes and public folders, Microsoft Exchange Server synchronization,
compression, retention and threshold settings for mailboxes and groups, and a host of other
controls to fine-tune the solution to the needs of your organization.

Email archiving

When emails are archived with Archive Manager for Exchange, emails on the Microsoft Exchange
Server or Exchange Online are replaced by a shortcut. The original email and all its versions are
stored in configurable external data stores. When you activate the Single Instance Store (SIS),
duplicate copies of emails going to multiple users are automatically removed during the archival
process. As a result, large amounts of corporate storage space is saved, dependency on PST files
is eliminated and your Microsoft Exchange Server retains its stability by eliminating the
unnecessary data.

Advanced search and eDiscovery

With the powerful search capability of the AMAC, you can retrieve emails on demand. You can
conduct focused searches by name, date range, and specific words, and export the results for
review. You can put selected groups of data on legal hold, or suspend them from disposition
policies.

The Archive Manager for Exchange solution offers a variety of installable features and extensions
that simplify the collection, storage, availability, and protection of your organization's data.

PST protection and elimination

The PST Gatherer is an extension that complements the PST Importer feature to help you collect,
upload, and archive PST files. Emails are safely archived and available on-demand even when
working remotely and without changing the end user’s Outlook folder structure. You can
eliminate corrupted files, password-protected files, and islands of information. For more
information see the PST Importer Administration Guide.

Quest® Archive Manager for Exchange Administration Guide
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Lifecycle management

You can capture, route, store, restore and manage archived emails externally with the
Hierarchical Storage Management (HSM) archive engine. HSM automatically controls the
retention policy of archived emails. The HSM engine can control a large range of external stores
like DVD, CD-ROM, HDD, tape, SAN, Jukebox systems, EMC Centera, NetApp, JVC, and many other
on-premise or cloud-based data storage solutions. You can move emails to cheaper locations as
their relevance changes and keep the option of deleting old messages unless they are on legal
hold. For more information see the Hierarchical Storage Management (HSM) Guide.

Disaster management and high availability

You can archive messages in parallel to multiple locations in real-time and provide a backup of
the archive on-the-go. With HSM, you can quickly retrieve archived emails from either location
and activate continuous off-site replication for deploying data disaster recovery, so end-users are
covered in the event of an outage.

Online on-demand access

With ArchiveWeb installed, you can work with archived emails even if the Microsoft Exchange
Server is unavailable. When you install the Outlook AddIn for your users, they can archive and
restore their emails on the go. For more information see the MS Outlook Addin User Guide. With
the Archive Manager Outlook Web Access (OWA) support emails are available to users online. For
more information see the OWA Installation Guide. Also, mobile users, Mac users, and Linux users
can work with archived emails when the Archive manager Universal Access extension is installed.
For more information see the Universal Access Installation Guide.

1 | NOTE: Native rehydration or exports are intended for small data sets. For operations on
large data sets, use a specialized utility such as Quadrotech Archive Shuttle (QAS).
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About the Administration Center

The Archive Manager for Exchange Administration Center (AMAC) provides you with all the
information available to monitor and manage your deployment, the options, actions, and
processes that you can leverage to archive and work with emails, and a powerful search capability
to locate and manage the archives.

In this chapter:

e Starting the AMAC

e Managing Sessions

e Views
o Manager View
o Status View
o Archive View
o Toolbar Icons
e Tools

e Hel

Starting the AMAC
You can start the AMAC in two ways:
1. Login to the Archive Manager for Exchange server.

Unless you added and granted the necessary permission to additional users, you must login as
the superuser to access the AMAC. A superuser account is a windows account with enterprise
administrator privileges to work with the Archive Manager for Exchange administration tools,
run services, manage databases, and manage extensions. It also has elevated privileges to
interact with the on-premise or online Microsoft Exchange servers.

If the Archive Manager for Exchange server is connected to Exchange Online, you must login
as the superuser.

You can grant logon permissions to additional users from the Tools > Options > User Roles tab.
For more information see Tools, Options and Settings. If you attempt to start the AMAC while
logged on as another user without sufficient rights, a notification dialog appears which
informs you that your user does not have enough permission to log on.

Quest® Archive Manager for Exchange Administration Guide
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Archive Manager for Exchange

¥ou do nat have permission ko log on.
Please contack your syskem adminiskrator or log on as superuser,

2. Go to Start > Programs > Quest > Archive Manager for Exchange.
or

GotoC:\Program Files (x86)
\Quest\MAM4Exchange\Applications\EnterpriseManager and click
PamEnterpriseMan.exe

3. The AMAC opens and the Manager view is displayed.

Managing Sessions

Via Archive Manager for Exchange administrator can connect to and administer also other Archive
Manager servers, if such are installed. To do so, on the Session menu click Connect to server. New
window pops-up. Switch to Remote host and enter the name of the server you want to connect to
in the Server name combo box. Then click OK.

Archive Manager for Exchange

Session | View  Tools  Help

Connect Archive Manager for Exchange
Connect to server -
| : | Connect to Host
Disconnect
Exit — Select the server vou want ko connect o,

l To access the server installed on the local computer, choose
= Local hast,

(®) Local host
() Remote host

Server name:

5t Restart service and repair connection,

v [ ExchangePaMManagersy (Reconnect recommended)

To access the server installed on the local computer, switch to Local host and click OK.

Quest® Archive Manager for Exchange Administration Guide
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Views
There are three views in the AMAC:

e Manager view - default view that provides you with all the capabilities to manage your
deployment.

e Status view - provides the information to monitor and your deployment and start or stop
services.

e Archive view - provides a full range of manual archival and retrieval features for mailboxes and

publicfolders.
There are three ways to open or move between these views:
1. Use the following keyboard keys
e CTRL-1for the Manager view.
e CTRL 2 for the Status view.
e CTRL 3 for the Archive view.

2. Open the View menu and select Manager, Status, or Archive

Session | View | Tools Help

% Manager =R - |
ﬂ Status

& Archive

Groups s || Jobs Retention | Locations

3. Click the respective icons in the lower left corner of the AMAC.

1 | NOTE: AMAC can run in Full Access or Read-only mode. In the read-only mode the
configuration is locked, but archive management through the Archive view is not affected.
So in read-only mode you can manually archive and restore emails, but the settings cannot
be changed.

Quest® Archive Manager for Exchange Administration Guide
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Manager View

This is the default view. It is used to configure the automated archiving of mailbox user groups or
public folders with jobs, scheduling jobs, configuring archive settings and manage the locations
of several Archive Manager for Exchange servers in a distributed deployment. The image below
displays the default Groups tab that helps you manage settings for various user groups. Notice
that some groups are displayed in green. The green color indicates that the mailboxes of group
members have been activated for automated archiving. For more information see Manager view.

Archive Manager for Exchange PFEREERR

Session  View Tools  Help

FREREXDOGDe |

Groups " Settings H Public Folders H Jobs H Retention " Locations
Sef filter | | Clear filker |
Group name Alias Property Value
Dnmain Users Domain Users Scheduled in job Job
Grcup Accounts group-accounts Allow to archive members of this group Yes
aGrcup Democorp group-democarp
Grcup Products group-products Seript active Mo
Graup Sales group-sales
Archive files older than 10 Days
Archive files bigger than 10.24 KB
Indude folders:
Exdude folders:
Outhox
Deleted Items
Incude message dasses:
IPM.Note™

IPM.Document™
IPM.Post™
Exdude message dasses:

ﬂ. 5 Server Role: Archive Server Loaded FullAccess Manager
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Status View

The Status view displays information about the critical components of your deployment like the
the status of the Archive Manager for Exchange services, logged on users, the Hierarchical Storage
Management (HSM) engine and the database. For more information see Status view.

Archive Manager for Exchange PERER

Session  View  Tools  Help
FRREX DR D Ye
@ Apuhﬁon Server Services

- Connections | oo

|£3] Exchange servers

FSM Name Status
Faj Datebase 4.MAM Auditing Running
@MN"I Exchange Direct Archive Running
@MM Exchange Handler Running
@MM Exchange Manager Running
@MM Exchange Notification Running
@MM‘I Exchange Scheduler Running
1% MAM MAPT RuAning
£ MAM Mornitoring Running
@MN"I Post-processing Running
% MAM PST Importer Running
@MM Search Running
£%MaM Logging Runining
£% MAM H5M Base Operations RuAning

@-M.&M HSM Asynchronous Operations Stopped

@ M Server Role: Archive Server Loaded FullAccess Status

Quest® Archive Manager for Exchange Administration Guide
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Archive View

This view is reserved for manual archiving or restoration of mailbox and public folder items.

When you restore email items, the original item and its versions are retrieved from the archive

store and copied to the Microsoft Exchange server. For more information see Archive view.

Archive Manager for Exchange PFEEFR
Session  View  Tools  Help
FRBRAaX DB ®on
Mailboxes "Archwe " PublicFolders H Public Folders Archive ]
Look for: Filter in: Filtes
| ~| | <no filter = (Blanks)
= Distrbution ists From Subject Received © Size Attachment
@] Domain Users
@I Group Accounts a juanchristie @democorp.com  Lolita 6/12/2020 1:49 PM 8.82KB
@I Group Democarp a davidwebb@democorp.com  Yes Sir I Kiled My Dad 6/12/2020 1:45 PM T.33KB
@I Group Products @i timashford@democorp.com  Warlight 6/12/2020 1:43 PM 10.82KB
E‘@I Group Sales a pabloneruda @democorp.com  The Travelers 6122020 1:45 PM 7.44KB
+--[ 2 Aman Ali [13] @l ninatanaka@democorp.com  The Lady in the Mirror £/12/2020 1:49 PM 7.31KB
+ - David Webb [14] a nikiportman@democorp.com  Rodham 6/12/2020 1:49 PM 7.5KB
=-{2 Devika Sharma [15] @i karljordan@democorp.com My Dark Vanessa 6/12/2020 1:43 PM T.73KB
[+ Calendar @i juanchriste@democorp.com  Inland 6/12/2020 1:43 PM 7.76 KB
() Contacts a ishnamohan@democorp.com  Girl, Wash Your Face 6/12/2020 1:45 PM 11.55KB
{2 Conversation Action a davidwebb @democorp.com  American Spy 6/12/2020 1:49 PM 3.B5 KB
{2 Deleted Ttems a timashford @democorp.com  About Credibility in Persuation 6122020 1:45 PM 7.75KB
-0 Drafts | (=1 juanchristie @democorp.com  Commerce £/12/2020 1:49 PM 3.28KB
% IE)(;:ema Contacts (21 davidwebb@democorp.com  Commerce 6/12/2020 1:49 PM 11.23KB Yes
= J:u‘::a\ [ timashford@democorp.com  Commerce 6/12/2020 1:49 PM 15.03 KB Yes
) Junk Email =] pabloneruda@democorp.com  Commerce 6/12/2020 1:49 PM 12.33KB
) Notes 3 ninatanaka@democorp.com  Wealth 6(12/2020 1:43 PM 8.36 KB
=) Outbox (=1 nikiportman@democorp.com  Wealth 6/12/2020 1:49 PM 10.86 KB Yes
{() Sent Items (=1 karljordan@democorp.com Wealth 6122020 1:42 PM 8.99KB
{[T) Tasks (=1 juanchristie @democorp.com  Wealth 6122020 1:49 PM 10.91KB
E-C3) Yammer Root =] ishnamohan@democorp.com  Wealth 6/12/2020 1:49 PM 9.55KB
{2 Domain Administrator [1] (1 davidwebb@democorp.com  Division of Labour 6/12/2020 1:49 PM 10,17 KB Yes
[ @ All mailboxes = amanali@democorp. com Return of Risk 6/12/2020 1:45 FM T.63KB
~#® Search results
< >
| Set Filker | | Clear Filter Page: 1) of 1 Messages: 1-220f22 First <Prav Mt =

@ a. Server Role: Archive Server

Folder contents loaded

FullAccess

Archiver/Restorer

Quest® Archive Manager for Exchange Administration Guide
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Toolbar Icons

The toolbar provides set of smart icons for standard commands and functions. Smart icons are
activated when you must invoke a specific function in a specific view (e.g. Manager view, Groups
tab, and others).

EIBERX DK P9 e

Image

B

Name

Properties

Refresh

Copy settings

Paste settings

Remove

Create new job

Schedule job

Description

If you want to check or define specific criteria for group
archiving, select the respective group on the Groups tab
and click the Properties icon to open its Properties
window. In the Properties window set your criteria on
the respective General, Scheduler, Folders, Classes and
the Script tabs. (See the section "Setting criteria for group
archiving”)

If you want to check or define specific criteria for public
folders, select the respective publicfolder on the Public
folders tab in Manager view and click on the Properties
icon to open its Properties window. In the Properties
window that is displayed set your criteria on the
respective General, Scheduler, Classes, and the Script
tabs. (See the section "Public folders tab”)

Refreshes the screen so that it is updated following the
recently completed instruction.

Copy a group or public folder settings.
Paste group or public folder copied settings to another.

Remove mailboxes or groups from keyword search on the
Settings tab in Manager view. In general, it is used for
removing objects from different tabs under the Settings
tab in Manager view, or for removing objects from the
Jobs tab.

Creates a new job simply by entering its specifications in
the Job Settings window. Accessible from the Jobs tab in
Manager view.

Reschedules a stopped job. Accessible from the Jobs tab
in Manager view.



=

"

Stop job

Archive

Restore

Advanced search

Show legend

Address Book Manager

Stops a scheduled job. Accessible from the Jobs tab in
Manager view.

Manually archive of individual emails, groups, folders,
mailboxes etc. Select the item and click on the Archive
icon on the toolbar. The Archive options window opens
and you can select the retention category under which
the chosen item will be archived. Accessible on the
Mailboxes tab as well as Public folders tab in Archive
view.

Manually restore individual emails, groups, folders,
mailboxes etc. Select the item and click on the Restore
icon on the toolbar. In the Restorer options window click
on the Accept button. Archived mail will be restored and
the respective shortcuts will be replaced with previous
icons. Accessible on the Mailboxes tab as well as Public
folders tab in Archive view.

Accessible in all three views. If you must search for some
information in the archive, simply use the Search in
archive icon on the toolbar (see further).

Accessible in the Archive view. When you click this icon,
the legend dialog pops up displaying all kinds of icons
that you can see on the tabs of Archive view and the
explanation for the icons.

Opens the Address Book Manager which synchronizes
servers, groups and mailboxes with Archive Manager for
Exchange (see the section "Address book Manager”).



Tools

This menu provides the administrative tools, options and settings to manage the application and
preferences for the AMAC. The list of menu options are summarized below. For more
information see Tools, Options and Settings.

Mailbox Rights Manager - manages user access rights for the ArchiveWeb feature. ArchiveWeb
is used for viewing and working with archived emails over the internet and includes keyword
searching. For more information see Mailbox Rights Manager.

Check Mailboxes - this command lets you check mailbox connections to the Microsoft Exchange
Server. For more information see Check Mailboxes.

Create folders - this wizard helps you create Outlook folders for your users. For more
information see Create folders

Export tasks - manages the export of items from the result set of the advanced search in the
AMAC or ArchiveWeDb, to a mailbox or PST file. For more information on how to export found
items see Advanced Search.

Statistics - helps the administrator get an overview of the number of items archived during
specific hours, days, weeks, months, or years. For more information see Statistics.

Address Book Manager - manages the synchronization of your servers, groups, mailboxes and
their permissions with the Active Directory. For more information see Address Book Manager.

Options and Settings - opens the configuration windows for configuring AMAC preferences. For
more information see Options and Settings.

Help

The Help option on the menu bar provides access to different information dialogs and assistance
features.

Archive Manager for Exchange

Session View  Tools | Help

B X 0| About

Groups | Settings | Public License Locations

| Set Filker || Clear Fil| Support * Knowledge base
Help Topics Open support ticket

The options in this menu are described below:

About — provides information about the current Archive Manager for Exchange version.

License —provides information about your license, its limit and the expiration date.

Quest® Archive Manager for Exchange Administration Guide
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e Support —provides a link to the Knowledge base articles on the Quest website. You can click
the Open support ticket which directs you to the online support portal where you can submit a
support request.

e Help Topics —opens the Archive Manager for Exchange Administration Guide.

Context Sensitive help

Click @ at the top right-hand corner to open the help topic for the current view.

Quest® Archive Manager for Exchange Administration Guide
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3

Tools, Options and Settings

This chapter describes the administration tools, options and settings to manage the application,
synchronization and preferences for the AMAC.

e Administration Tools

o Mailbox Rights Manager

o Check Mailboxes

o Create folders
o Export tasks
o Statistics

o Address Book Manager

e Options
e Settings

Mailbox Rights Manager

The Mailbox Rights Manager is a tool to manage the access rights for designated administrators of
ArchiveWeb. Privileged users can use ArchiveWeb for viewing and working with archived emails
over the internet and includes keyword searching. Archived mailboxes and folders are visible in
ArchiveWeb even if the Microsoft Exchange Server or Exchange Online is unavailable.

i | NOTE:

You must synchronize the mailboxes and folders before you use the Mailbox Rights
Manager tool. This will ensure that mailbox and folder permissions are available and
applicable to ArchiveWeb. For more information about synchronization see Synchronizing
Address Book Manager.

To manage rights with the Mailbox Rights Manager tool, the logged in user must have the
Modify Mailbox Permission role set to Allow. User roles are assigned in the Tools >
Options > User Roles tab.

About Mailbox Rights Manager

1. From the Tools menu, click Mailbox Rights Manager. The Mailbox Rights Manager window
opens.

Quest® Archive Manager for Exchange Administration Guide
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2. Click any tab to view the list of mailboxes by the preset alphabetical filter. The All tab is the
default preset filter that returns all mailboxes
or
Enter the name of a mailbox in the search field below the tabs. You can also enter one or more
letters to search for all mailboxes that contain the letters. Wildcards are not allowed.

1 | NOTE: The Mailbox Rights Manager for individual mailboxes can also be opened from
the Address Book Manager > Mailboxes tab where you right-click the mailbox from the
list view and select Permissions.

>% Mailbox Rights Manager

Mailboxes: m ABC | DEF | GHI | KL | MNO | PQRS | TUV | WXYZ
Display Name Shared Email address

[:', Aman Ali [13] Yes amanali@democom com

f:', David Webb [14] Yes davidwebb@democom.com

[’_" Devika Shama [15] Yes devikashama@democorp.com

(), Domain Administrator [12] domadmin@democorp.com

(22 Ishnz Mohan [16] Yes ishnamohan@democorp.com

(23 Juan Christie [17] Yes juanchristie@democop .com

() Karl Jordan [18] Yes karjordan@democorp.com

[’_" Niki Portman [15] Yes nikiportman@democorp.com

[’_" Nina Tanzka [20] Yes ninatanaka@democomp .com

[’_" Pablo Neruda [21] Yes pabloneuda@democorp.com

[’_" public_AMXEXCH [-101] Yes domadmin@democorp.com

f_:‘, Tim Ashford [22] Yes timashford @democom.com

< >

The list columns are described below:
a. Display Name - the display name of the synchronized mailboxes available to the tool.

b. Shared - indicates whether or not a listed mailbox is accessible to the logged in user. Yes
indicates the logged in user has been granted rights to the mailbox. A blank value indicates
the mailbox is either not shared or belongs to the logged in user. In the figure above, the
logged in useris the domain administrator. Since the logged in user cannot assign access
rights to their own mailbox, the value is blank.

c. Email address - the email address of the synchronized mailbox.

3. Click the Refresh button to reload the search result or click Close to exit the window.

To grant access rights to mailboxes:
1. Open the Mailbox Rights Manager.
2. Locate one or more mailboxes that you want to share with the users through ArchiveWeb.

3. Select asingle mailbox or press ctrl on your keypad and select multiple mailboxes that you
want to share.

4. Right-click the selection and click Properties from the context menu.
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Mailbox Rights Manager

Mailboxes: m 4BC | DEF | GHI | I | MNO |PQR5 | UV |\mz

Display Name  #

(), Aman Ali [13]

(22 David Webb [14]
(2} Devika Shama [15]
(), Domain Administrator [12]

Shared Email address

Yes amanali@democom .com

Yes davidwebb@democom com

Yes devikashama@democorp.com
domadmin@democorp.com

(2 Ishna Mohan [16]

ishnamohan@democorp.com

Juan Christie [17] Yes juz i lemocom com
(2 Karl Jordan [18] ' arfjords corp.com
ﬂ Miki Portman [147 Y ki 2 ocorp.com
ﬂ Mina Tanaka [20] inatans lemocorp.com
E’; Pablo Meruda [21] pablonenida @democorp.com
E’; public_AMXEXCH [-101] Yes domadmin@democorp.com
() Tim Ashford [22] Yes timashford@democorp.com
£ >

5. The Mailbox Rights window opens. If you selected multiple mailboxes, the Mailbox Rights

window opens and displays the the Mailbox security tab. If you selected multiple mailboxes,
you will see additional tabs that are explained later in this topic. To share the rights to
mailboxes, only the Mailbox security tab is relevant. If the mailbox was previously shared, the
list of all users who have the rights to the mailbox(es) will be listed.

§ Mailbox rights PR § Mailbox rights - Juan Christie [17] BE
Mailboxsecurity Mailbox security " Folder security "Access ]
&j.limin_‘.s::.bjﬂ_: — m‘i,h.s:;bjﬂ_: ey
User name e-mail User name e-mail

$ Domain Administrator domadmin@democorp, com % Domain Administratar domadmin @democorp.com

IOK—‘ Careel _— IOK—‘ Concel e

Figure a. Only the mailbox securitytab appears when Figure b. Additional tabs appear when a single
multiple mailboxes are selected mailboxis selected

To grant rights to additional users, click Add. The Select mailbox window opens.

Select one or more users who will be granted the rights to the mailbox(es). Then click
to add the selected user(s) to the Selected objects list. To remove users from the Selected

objects list, select one or more users from the Selected objects list and click to move
them back to the list of mailboxes. If you enter the name of a listed mailbox user directly in
the search field and click enter, the mailbox user will be directly added to the Selected
objects list.
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T Archive Manager for Exchange

Select mailbox

Type in the name or select from list:

el =

Display name Alias email address =
() Aman Ali amanali amanali @democorp. com
ﬂ David Webb davidwebb davidwebb @democorp.com
f:'; Devika Sharma devikasharma devikasharma@democorp.com
E‘; Ishna Mohan ishnamohan ishnamohan @democorp.com
f:’; Juan Christie juanchristie juanchristie @democorp. com
() Karl Jordan karljordan karljordan @democorp. com
() Niki Portman nikiportman nikiportman@democorp. com
[ Nina Tanaka ninatanaka ninatanaka @democorp. com
f:'; Pablo Neruda pabloneruda pabloneruda @democorp.com
E’; Tim Ashford timashford timashford @democorp. com %
£
Selected objects: 3
If:_’; David Webb

8. Click OKto grant the rights to the users who are listed in the Selected objects list.

9. Verify that the additional users were granted the rights to share the selected mailbox(es).

When mailboxes are shared using the Mailbox Rights Manager tool, the users that are granted

the rights appearin bold font. If a mailbox was shared through permission settings in the

Microsoft Exchange Server or Exchange Online, the users appear in normal font.

B Mailbox rights (=04
Mailboxsecurity
m&u_u:.@s- —
User name e-mail
s Domain Administrator domadmin@democorp, com
$ David Webb davidwebb@democorp.c...
Aoy

10. To revoke access rights to a mailbox, select a user from the Mailbox rights list and click

Remove.

11. Click OK to close the window.

Steps to grant access rights to mailbox folders

1. Open the Mailbox

Rights Manager.

2. Locate the mailbox that you want to share with the users through ArchiveWeb.
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3. Select a mailbox and right-click the selection. Then click Properties from the context menu.
The Mailbox Rights window opens. The window title indicates the mailbox name and the
mailbox identifier.

4. Click the Folder security tab.

5. Select the folder that you want to share with other users. Only one folder can be selected at a

time.

& Mailbox rights - Niki Portman [19] =3
Mailboxsecurity || Foldersecurity || Access
g-ibiu::.u':u ——

(-2 Calendar A
-3 Contacts

() Conversation Action Settings

i) Deleted Items

i) Drafts

-{(7) ExternalContacts

=

i) Journal

4.3 Junk Email A

Permissions on folder:

User name e-mail

IOK—‘ cance' ADDIV

6. To grant rights to additional users, click Add. The Select mailbox window opens.

7. Select one or more users who will be granted the rights to the folder and click to add
the selected user(s) to the Selected objects list. To remove users from the Selected objects

list, select one or more users from the Selected objects list and click to move them
back to the list of mailboxes. If you enter the name of a listed mailbox user directly in the
search field and click enter, the mailbox user will be directly added to the Selected objects
list.

T Archive Manager for Exchange =
Select mailbox 5],

Type in the name or select from list:

Display name Alias email address &
f’_:’; Aman Ali amanali amanali @democorp. com
David Webb davidwebb davidwebb @democorp.com
E’; Devika Sharma devikasharma devikasharma @democorp.com
f’_z’; Izhna Mohan ishnamohan ishnamohan @democorp.com
(23 Juan Christie juanchristie juanchristie@democorp. com
() Karl Jordan karljordan karljordan @democorp, com
f_z'; Miki Portman nikipor tman nikiportman@democorp. com
(2 Nina Tanaka ninatanaka ninatanaka @democorp.com
E’; Pablo Neruda pabloneruda pabloneruda @democorp. com
() Tim Ashford timashford timashford @democorp.com v
€ >
¥ Y
Selected objects: =

(2 David Webb

_

8. Click OK to grant the rights to the users who are listed in the Selected objects list.
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9. Verify that the additional users were granted the rights to share the selected folder. When a
folderis shared using the Mailbox Rights Manager tool, the users that are granted the rights
appearin bold font. If a folder was shared through permission settings in the Microsoft
Exchange Server or Exchange Online, the users appearin normal font. The shared folder is
indicated with a green foldericon.

& Mailbox rights - Niki Portman [19] =3

Mailboxsecurity | Foldersecurity || Access

Foldernights" —
-5 Calendar A
E-3) Contacts

-{[Z) Conversation Action Settings
-{7) Deleted Items

(7 Drafts

{7} ExternalContacts

~{E5r Inbox

i) Journal
47 Junk Email ha

Permissions on folder:

User name e-mail

8 David Webb davidwebb@democorp.c...

IK—‘ Conce Bopiy

10. To grant the same permission to all subfolders, right-click the folder and click Apply to
subfolders from the context menu.

& Mailbox rights - Devika Sharma [8] =0
Mailboxsecurity || Foldersecurity || Access
g-is"_i;n:.-,j,i_; e —

1) Calendar ~
g H Applyto subfolders |

: onver:

i-{2) Deleted Items

i--{3) Drafts

i-{Z) ExternalContacts

{5 Inbox

{2 Journal

407y Junk Email =

Permissions on folder:

User name e-mail

8 Administrator domadmin@democorp.c..

1'(—‘ Cancel hoply

11. Verify the result and click OK to close the window.

Steps to grant access rights to public folders
1. Openthe Mailbox Rights Manager.

2. Locate the publicfolder mailbox that contain the public folders you want to share with the
users through ArchiveWeb.
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3. Select the publicfolder mailbox and right-click the selection. Then click Properties from the
context menu. The Mailbox Rights window opens. The window title indicates the mailbox
name and the mailbox identifier.

[>£ Mailbox Rights Manager

Mailboses: n| ABC | DEF | GHI | KL | MNO |DQR5 | TV |wx'r2

Display Name ~ » Shared Email address
E:‘; Aman Al [13] Yes amanali@democomp.com
E:'; David Webb [14] Yes davidwebb@democom.cqg
E:'; Devika Shama [15] Yes devikashama@democom)
f_:’; Domain Administrator [12] domadmin @democomp col
[ Ishna Mohan [16] Yes ishnamohan@democomp.c
() Juzn Christie [17] Yes juanchristie@democorp.c
[ Karl Jordan [18] Yes karjordan@democorp.con
() Niki Portman [15] Yes nikiportman@democomp.c
[ Nina Tanaka [20] Yes ninatanaka@democorp.c
f’_:’; Pablo Neruda [21] Yes pabloneruda@democomp.
oublic_AMXEXCH [- . 'Yes  domadmin@democomp col
;ul:llc_. MXEXCH [-101] domadmin @democorp cor|
22 Tim Ashford [22] ‘es  timashford@democorp co
< >

4. Click the Folder security tab.

5. Select the publicfolder that you want to share with other users. Only one folder can be
selected at atime. A green icon indicates that a public folder has been shared.

6. To grant rights to additional users, click Add. The Select mailbox window opens.

7. Select one or more users who will be granted the rights to the mailbox(es) and click to
add the selected user(s) to the Selected objects list. To remove users from the Selected

objects list, select one or more users from the Selected objects list and click to move
them back to the list of mailboxes. If you enter the name of a listed mailbox user directly in
the search field and click enter, the mailbox user will be directly added to the Selected
objects list.

W Archive Manager for Exchange ®
Select mailbox @

Type in the name or select from list:

Display name Alias email address &
() Aman Al amanali amanali @democorp. com
ﬂ David Webb davidwebb davidwebb @democorp.com
D; Devika Sharma devikasharma devikasharma@demacorp.com
! Ishna Mohan ishnamohan ishnamohan @demacorp.com
(2 1shna Moh, hnamoh hnamohan @d
() Juan Christie juanchristie juanchristie@democorp. com
() Karl Jordan karljordan karljordan @democorp, com
() Niki Portman nikiportman nikiportman@democorp. com
! Nina Tanal ninatanal ninatanal emocorp.com
(24 Nina Tanaka inatanaka tanaka@d
D; Pablo Neruda pabloneruda pabloneruda @demacorp. com
() Tim Ashford timashford timashford @democorp.com v
L4 >
¥ ~
Selected objects: =

2 David Webb

_

8. Click OKto grant the rights to the users who are listed in the Selected objects list.
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9. Verify that the additional users were granted the rights to share the selected folder.

§ Mailbox rights - public_AMXEXCH [-101]

Mailboxsecurity || Foldersecurity || Access

Foldernghts"—

B R

~{E3) Accounts-News
~{E3) Company-ews
~{E3) Products-News
-|£2 salesNews

Permissions on folder:

User name e-mail
$ Domain Administrator
% Aman Ali

b 4 Cavid webb
% Devika Sharma

Teb Ao

amanali @democorp.com

domadmin@democorp. com

davidwebb @democorp.com

<

Apply

subfolders from the context m

& Mailbox rights - public_ AMXEXCH [-100]

enu.

PR

Mailbox security || Folder security || Access
Foldernghts™ [ ———
-~{f2) Accounts-Hews
-{E2) Company-News
-{E3) Products-News
| Apply to subfolders "

Permissions on folder:
User name e-mail G
8 Tim Ashford timashford @democorp.com
s Pablo Meruda pabloneruda @democorp.com
3 Mina Tanaka ninatanaka @democorp.com
2. Miki Portman nikiportman@democorp. com
B o Yo PSS S S —— v
< >

Aty

11. Click OK to close the window.

Steps to view the access rights of a user
1,

2.

Open the Mailbox Rights Manager.

10. To grant the same permission to all subfolders, right-click the folder and click Apply to

Locate the user and right-click the selected mailbox. Then click Properties from the context
menu. The Mailbox Rights window opens. The window title indicates the mailbox name and

the mailbox identifier.

Click the Access tab to view all the mailboxes and folders that are shared with this user.
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§ Mailbox rights - Domain Administrator [12] =3

Mailboxsecurity || Foldersecurity || Access

Lﬁ_m_i.h.: OTTONIET HECESSS ——

User name Target folder
) public_AMXEXCH [-101] Accounts-News
) public_AMXEXCH [-101] Company-MNews
) public_AMXEXCH [-101] Products-Mews
) public_AMXEXCH [-101] Sales-Mews

[ aman Al [13]

[yDavid webb [14]

[:']Devika Sharma [15]

E_’]Ishna Mohan [16]

I:’]Juan Christie [17]

[Z]Karl Jordan [18]

[ niki Portman [19]

[:jNina Tanaka [20]

EjPabIo Meruda [21]

[ Tim Ashford [22]

£ >

B Bl

4. Click OKto close the window. If you click Cancel the window closes and any changes made in
other tabs that were not saved will be rejected.

Check Mailboxes

This tool checks the connection between mailboxes available in the AMAC and the Microsoft
Exchange Server. Use this tool:

o After the first installation of Archive Manager for Exchange.

e After configuration changes on Microsoft Exchange Server, like a mailbox migration.

To use the Check Mailbox tool:

1. From the Tools menu click Check mailboxes. The Check mailbox connections window opens.
The list view displays mailboxes synchronized with Archive Manager for Exchange.

2. Select the option as described below:
¢ Include deactivated mailboxes to display the deactivated mailboxes.

3. Select the mailboxes for which you want to check the connection to Microsoft Exchange
server.
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¥ Check mailbox connections

Select mailboxes

ROM Display name e-mail &
] amanali Aman Ali amanali@democorp. com
[ davidwebb David Webb davidwebb@democorp.com
devikasharma Devika Sharma devikasharma @democorp...
[] domadmin Administrator domadmin @democorp. com
[] ishnamohan Ishna Mohan ishnamohan @democorp.con
[ juanchristie Juan Christie juanchristie @democorp, com
[ kartiordan Karl Jordan karljordan @democarp. com
nikiportman Miki Portman nikiportman @democorp, com
[ ninatanaka Mina Tanaka ninatanaka@democorp. com
[ pabloneruda Pablo Meruda pabloneruda@democorp. col o
Ml e ecamire o arecarooc P L S
L4 >
Indude deactivated mailboxes

_

4. Click Finish to start checking the mailbox connections. The Checking in progress window
opens.

¥ Check mailbox connections

Checking in progress

Progress:

L )

Processing started
Mailbax Devika Sharma opened. Falders: 25. Mailbox size: 0 MB
Mailbax Miki Portman opened. Folders: 25. Mailbox size: 0 MB
Number of checked mailboxes: 2
Total errors found: 0
Processing finished

_ FInISh

5. Verify the result and address any connection issues. Click Close to close the window.

Create Folders

The Create Folders tool helps you create custom folders in MS Outlook for one or more users that
are available in the Address Book Manager.

Steps to create a folder in MS Outlook

1. From the Tools menu click Create Folders. The Create Folder Wizard opens.
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¥ Create Folder Wizard

Define folder to create

Folder to create:

Archive

Folder type: Mail folder
Create folder in the following mailboxes:
() all maiboxes
(®) select mailboxes from the list

[] set folder home page

2. Specify the properties as described below:

a. Folder to create - specify the name of the folder to create. The default name is Archive and
is specified as an an example.

b. Folder Type - specify the type from one of the standard types: Mail, Calendar, Contact,

Task, Notes or Journal.

c. Create folder in the following mailboxes

¢ all mailboxes - choose this option to create the folderin all user mailboxes.

¢ select mailbox from the list - choose this option to select specific users from the user
mailbox list available in Address Book Manager.

d. Setfolder home page - Select the checkbox to set a home page for the created folder and
then specify the URLfor the home page. For example, the ArchiveWeb application can be

made available to users in the folder.

3. Click Next. If you have selected the select mailbox from the list option, the Select mailboxes
window opens.

#% Create Folder Wizard

Select mailboxes

3

RDM Display name
[ amanali Aman Ali
davidwebb David Webb
[[] devikasharma Devika sharma
[] domadmin Administrator
[ ishnamohan Ishna Mohan
[ juanchristie Juan Christie
[ karljordan Karl Jordan
nikiportman Miki Portman
[ ninatanaka Mina Tanaka
[ pabloneruda Pablo Neruda
[] public_amMxExCH public_ AMXEXCH
[ timashford Tim Ashford

e-mail

amanali@democorp. com
davidwebb@democorp.com
devikasharma@democorp....
domadmin @democorp.com
ishnamohan @democorp.com
juanchristie @democorp.com
karljordan @democorp, com
nikipartman @democorp. com
ninatanaka@democorp. com
pabloneruda@democorp, com
domadmin @democorp.com
timashford @democorp. com

| | Finish | | Cancel

4, Select the mailboxes where the folder will be created. Then click Finish. The Folder creation

in progress window opens.
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¥ Create Folder Wizard

Folder creation in progress

Progress:

(

Processing started

Creating folder: Archive

Folder type: Mail folder

Mumber of processed mailboxes: 2
Total errors found: 0

Processing finished

_ : - BaCk i

Finish Close

5. Verify the result and click Close to e

Export Tasks

xit the tool.

When you save a search result to an XML file using the Advanced Search feature of the AMAC, the
Export Tasks tool helps you to export the email items in the search result to another mailbox or a

PSTfile.
In this topic:

e About the export task list

Create new task

Start or stop a task

Remove atask or refresh the task list

Add documents to a task

Remove documents from a task

Change the properties of a task

About the export task list

1. From the Tools menu click Export tasks. The Export Tasks window opens.

2. The table lists all the existing tasks otherwise the table is blank.
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% Export tasks PERRFR

Mype Mame Status Messages total  Processed messages  Success Warning Error
i] Export to mailbox Export to private mailbox  Waiting 11 1] 1] 1} i}
!] Export to mailbox  Export David's emails Waiting 5 1] 1] a 1}
{] Export to mailbox  Export Devika's emails Waiting 5 1] 1] a 1}
! Export to mailbox  Export Ishna's emails Waiting 5 [v] [v] 1] 1]
i Export to PST Export to Accounts PST  Finished 5 5 5 1] 1]
i Export to PST Export to Product PST Finished 5 5 5 a a

<

>

_ CIDSB

The columns are as described below. The columns can removed or added back when you
right-click and choose Add/remove columns from the context menu. You can also click a
column title to sort the rows in alphabetical order.

a.

b.

Type - the task type. Valid values are Export to mailbox or Export to PST.
Name - name of the task
Status - the status of the task. Valid values are Waiting, Finished, Processing.

Messages total - the number of email messages in the XML file that was attached to the
task.

. Processed messages - the number of email messages that the tool attempted to export.

Success - the number of email messages that were successfully exported.

. Warning - the number of email messages that were exported with some dataissues.

Error - the number of email messages that could not be exported.

Mailbox - identifier of the mailbox where the data will be exported if the task type is
Export to mailbox.

PST File - path of the PST file where the data will be exported if the task type is Export to
PST.

Folder - folder path where the Task details are stored. For example, C: \Program Files
(x86) \Quest\MAM4Exchange\Export\<folder-identifier>

Target Folder - name of the root folder that will be created in the target mailbox or PST
file.

. Settings - Number that indicates a unique combination of settings from the Export Tasks

Properties window.

. Last Error - The most recent error that occured when the export task runs. For example, it

could be a global error that caused the export task to fail or an error specifically related to
the most recent item in the export task.
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Steps to create a new task

1.

Right-click anywhere in the Export Tasks window and select Create new task. The Select export

source window opens.

Enter a name for the task. We recommend that you use descriptive names to avoid confusion.

Click Load. The Open Search Result File window opens. Locate and select the XML file. Then

click Open.

The file is attached to the task. Verify that the number of email messages indicated by the

Number of loaded documents property is as expected.

% Export Wizard

Select export source

Task name:

|Export to Sales PST |

(®) Search result

ﬁ The document list which will be exported is defined by a search result
file.,

Number of loaded documents: 5

_

Click Next. The Select export destination window opens.

Select Export to mailbox or Export to PST.

% Export Wizard

Select export destination

() Export to mailbox

. Export messages to a maibox. The mailbox must be already
4 synchronized to be able to export.
(® Export to PST
% Export messages to a new PST file,

e

Click Next. The Export settings window opens.
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& Export Wizard PER

Export settings

EXporioldeErmerarcny’ e —

Target folder base:  [Export

() Create folder hierarchy
(®) Export all documents to one folder

Create separate folder for each distinct mailbox

() Start export immediately
(®) Create an export task, but do not start it

I e )

The properties in this window apply to both destinations: mailbox or PST, and are described
below:

Export folder hierarchy

a. Target folder base - name of the folder that will be created when email items are exported

to a mailbox or PST file. Default value is Export.

b. Create folder hierarchy - choosing this option creates a folder hierarchy as defined in the
email being exported. For example, if the email is an inbox item, the email will be
exported to the Export\Inbox folder.

_Or‘_

Export all documents to one folder - choosing this option exports the messages to the
same root folder specified in the Target folder base property.

c. Create separate folder for each distinct mailbox - Select this checkbox to create a sub-
folder for each recipient mailbox that is specified in the message.

Task start
d. Start Export immediately - starts the export task immediately afteritis created.

e. Create an export task, but do not start it - creates an export task but the task must be
started manually.

8. Click Next. The Summary window opens.

& Export Wizard PER

Summary

Summary:

Creating new export task

Type: PST export

Settings

-Target base folder: Export

- Export all messages to one folder

- Create & separate folder for each distinct mailbox

Mumber of documents to export: 5

After dicking Finish, a new export task will be created. The task needs to be started
manually.

I s
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9. Verify the settings and click Finish. The new task appears in the task list of the Export Tasks

window.

Steps to start or stop a task

1. Select atask from the task list of the Export Tasks window.

2. Right-click the selected task to open the context menu.

% Export tasks PFEEFER

Type

E;ﬂ Export to mailbox
i:;] Export to mailbox
rt] Expart to mailbox
E:;] Export to mailbox
4 Export to PST
8t Export to PST

Export to PST

€

MName

Export to private mailbox
Export David's emails
Export Devika's emails
Export Ishna's emails
Export to Accounts PST
Export to Product PST
Export to Sales2=r

REES

Status Messages total
Waiting 11

Waiting 5

Waiting 5

Waiting 5

Finished 5

Finished 5

i c

Create new task
Remove task
Refresh

Automatic refresh

Processed messages  Success

0 o

0 a
0 o
0 o
5 5
] 5

Warning

Tasks v

Add/remove columns

Start task

Qe

Stop task

Add documents to task

Clear documents

Error

oocoooo

>

Close:

3. Click Tasks and then click Start task to start a task, or click Stop task to stop a task.

Steps to remove a task or refresh the task list

1. Select atask from the task list of the Export Tasks window.

2. Right-click the selected task to open the context menu.

% Export tasks PERRFR

Type

E{] Export to mailbox
E%] Export to maibax
E:;] Export to maibox
E:;] Export to maibox
@ Export to PST
& Export to PST

[ “¥esport to PST

<

MName

Export to private mailbox
Export David's emails
Export Devika's emails
Export Ishna's emails
Export to Accounts PST
Export to Product PST

Export to Sales PST

I=e =

Status Messages total  Processed messages  Success
Waiting 11 o
Waiting 5 s} s}
Waiting 5 i} v}
Waiting 5 v} v}
Finished 3 5 5
Finished 3 5 5

]

Properties

Create new task

Remove task
Refresh

Automatic refresh

Tasks

Add/remove columns

Warning

oo oo oo

Error

oooooo

>

3. Click Remove task to remove a task from the task list. Click Yes to confirm the removal.

4. Choose between two options to refresh tasks:

a. Click Refresh to manually refresh the task list.
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b. Right-click Automatic refresh to allow the application to refresh the task list every 15
seconds which is preferred for long task lists. After it is activated, you can right-click
Automatic refresh again to deactivate it.

Steps to add documents to a task

Adding documents to tasks lets you combine more XML source files in one export task. This is
helpful when you must perform two searches with different search criteria and generate
separate XML files for each search result.

1. Select atask from the task list of the Export Tasks window.

2. Right-click the selected task to open the context menu.

3. Click Tasks and then click Add documents to task. The Open Search Result File window opens.
4. Locate and select the XML file. Then click Open.

5. The document is added to task. The Messages total column value for the task will increase.
Verify that the total is as expected.

Steps to remove documents from a task
1. Select atask from the task list of the Export Tasks window.
2. Right-click inside the window to open the context menu.

Click Tasks and then click Clear Documents.

> W

Confirm that all documents will removed from the task.

5. Verify that the Messages total column value for the task is 0.

Steps to edit task properties
1. Select atask from the task list of the Export Tasks window.

2. Right-click inside the window and select Properties from the context menu. The Properties
window opens.

a. Export task tab - allows you to view or change the name of the task and the export folder
settings as described previously in this topic.

b. Documents tab —displays task statistics.

e Documents of task - this section displays the statistics of the documents attached to the
file.

Quest® Archive Manager for Exchange Administration Guide

Tools, Options and Settings



e PSTFile Info - in this section you can check the Total PST size and set the Maximum size
of the PST file. By default size is 2 GB. You can limit the file size when exporting. If the
exported amount is exceeds this limit, a new file is created.

Statistics

Statistics helps the administrator get an overview of:
e number of items archived during a specific period (Archived messages view)

e size of individual mailboxes and their archive (Archived size view)

Archived Messages

To display the statistic overview in Archive Manager for Exchange, click Tools/Statistics on the
main menu. The Statistics window opens by default in the Archived messages view. Switch
between views in the left pane of the window.

To get statistics on the number of archived messages, select the Archived messages view in the
left pane. In the Date range section define the time period for which you want to generate the

statistics. If you have selected "Interval”, specify the time span in the From/to text boxes (either

overwrite the dates or click the down arrows to select days in the calendar).

As a next step sort the data by hours/days/weeks/months/years as you select the respective
option in the Grouping section. Finally click Apply.

* Statistics PERRR

il 1A B
Archived messages
Archived messages
Archive size [ Messages per year
S———— .
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°
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s I
0 } t !
22:00 23:00 00:00 01:00 02:00
Time

Daterange | Data

Full range From

This year 2020/03/29 00:00
This month to

Last 3 months -

This wesk 2020/06/29 23:59
Today
Last 7 days

Interval

The statistical data for the chosen time period will be represented in the form of a graph and on
the Data tab as a statistics table. To export the statistical data, click the Export button and then
select the export folder.
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TIP: Use the icons in the upper bar of the Statistics window to switch between bar graph ()
and line graph ().

Itis also possible to zoom parts of the graph. Simply click inside the graph and draw the
cursor to select the part which you want to zoom. To un-zoom, right-click inside the graph.
In the context menu select Un-Zoom. The graph context menu offers also additional
commands as Print, Save Image As etc.

Archive Size

To get an overview of individual mailboxes, the size of messages, archive, shortcuts etc. switch to
the Archive size view in the left pane. On the Mailboxes tab check the mailboxes for which you
want to generate the statistics and click Calculate.

1 | NOTE: If you check the Include Exchange size checkbox the report will contain a new
column: current size of the mailbox on Microsoft Exchange. This helps you to report the
size of the mailbox after archiving.

[T = E|

Archived messages
Archive mailbox size

Archive size = Messagesice o Archive size L Shoroatsize

Size

5 - |

Mailba

Mailboxes | Data

Administrator [1] ~
Aman Ali [2]

David Webb [3]

Devika Sharma [4]

Ishna Mohan [3]

Juan Christie [6]

Karl Jordan [7]

[ 7] Rl Nmrdree e F21 4

£
|:| Indude Exchange size

To generate statistics:
1. Click the Mailboxes tab and choose one or more mailboxes.

a. Click Calculate.

b. The statistical data for the chosen mailboxes will be represented in the form of a graph.
Colors in the graph represent the following:

e ldred—the size of all messages of the given mailbox

e mgreen —the size of the mailbox in the HSM store, i.e. archive size
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e vyellow —the shortcut size, i.e. the size of shortcuts left in the Microsoft Exchange
server

2. Click the Datatab as a statistics table. The list of mailboxes are displayed with statistics about
message size, archived size, archived size uncompressed, shortcut size, and limit of
mailboxes. Mailboxes can be sorted by clicking on the respective column headers (Object,
Message size, Archive size, Archive size uncompressed, Shortcut size, and Limit).

To create a report for the HSM store:
1. Click Export to create a report.

2. Inthe Select output format step, select the scope for the report.

Export Wizard 3
Select output Format g I

Expark quata status in the Fallowing Form:
® all maiboxes
) Fikered mailhnxes

) Distribution lists with members

3. Click Next.
4. Based on your selection you must provide additional information for the report:

a. For All mailboxes

No additional information is need. Proceed to step 5.

b. For Filtered mailboxes

i. The Define afilter window opens. Click an existing filter from the the Selected filter
list-box or click Filter to create a new filter.

ii. Tocreate anew filter:

1. Choose RDN, ALIAS, DISPLAYNAME, or EMAILADDRESS from the first dropdown
menu.

2. Choose an operator from =, STARTSWITH, ENDSWITH, or CONTAINS in the second
dropdown menu.

3. Enter atextto search inthe text box. Click Add. The resulting filter will be displayed
in the text box below.
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Filter "
Filter definition

Select user: Seleck Filker:

|Administrator v| |<new> v|
[orrLavmave | [sTarTswT ] [ |[Cadd |
L JL o e J[ orn [ wer |

DISPLAYMAME STARTEWITH 'm'

I Check Syntax I Save H Delete | | O || Cancel |

4. If you want to combine some other conditions, simply use brackets and logical
operators and confirm by clicking Add.

5. To check the syntax, click Check Syntax. Click Save and specify a name for the new
filter, or click Delete to start over. Then confirm by clicking OK.

6. The resulting filter will be displayed in the Selected filter list box.

Define a filter g I
Selected filker:
DISPLAYMAME STARTSWITH 'm'
Synka: OF
< Back | | Next = ‘ | Cancel
iii. Click Next.

c. For Distribution lists with members

The Choose distribution lists window opens.

Select one or more lists from the Available Distribution lists list box and click the left-
to-right arrow button. The lists will be moved to the Use these DLs in this order list
box.

e Toinclude all groups, click the left-to-right double-arrow button.

e To remove some of the groups and have them not included, select the respective
item in the Use these DLs in this order list box and then click the right-to-left arrow
button.

e With the Move up and Move down buttons simply organize your report to your
needs. Groups will be displayed in the report (Excel sheet) exactly in the order as
specified in the Use these DLs in this order list box.
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Export Wizard =

Choose distribution lists i I
Available Distribution lists: Use these DLs in this order:
Domnain Adrins new
Domain Users e
Managed Availability Servers -
SEA Pilote
tesk k
<
...... Up tove Do
| < Back | | Mesxt = | | Cancel |

iii. When you are satisfied with the list of groups listed in the Use these DLs in this order
list box, click Next.

5. The Choose output fields window opens. Select the item in the Available fields list box and
click the left-to-right arrow button. The item will subsequently be moved to the Use these
fields in this order list box.

e |f you want to include all the fields in the report, click the left-to-right double-arrow
button.

¢ |f you want to remove some of the fields and have them not included in the report, then
select the respective item in the Use these fields in this order list box and then click the
right-to-left arrow button.

e With the Move up and Move down buttons simply organize your report to your needs. They
will be displayed in the report (Excel sheet) exactly in the order as specified in the Use
these fields in this order list box.

e When you are satisfied with the selection of fields and their order, click Next.

Export Wizard 3
Choose output fields g I

Aevailable fields: Use these Fields in this order:

Activated

Alias

Archive size uncompressed
Deleted

e-mail

MEXID

Message size

RDM

Sharbout size

Move Up Move Down

| < Back | | Mext > | | Cancel ‘

6. The Select output file window opens. Specify the name of the exported file and the place it
must be saved to. Enter the file path and name in the Select output file text box, or click the
Browse button to select a folder.
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Export Wizard 4
Select output file g I

Select output File:

|c:\export.csv I o [

| < Back | | Finish | | Cancel |

7. Click Finish to see the full path displayed, including the file name.

@B Report was exported kot
'-\ /' c\export.caw

| Ok || Details = |

8. Click the Details button to review the details.
9. Click OK.

10. When the report is generated, open it directly from the place you saved it to (In our example
from C:\export.csv).

1 | NOTE: If the data in the report (Excel sheet) is contained in only one column, check if a
proper delimiter has been set on the Others tab.

Address Book Manager

Active Directory forest and domains store information about Microsoft Exchange servers,
mailboxes, and other Microsoft Exchange-related objects in your organization. The Address Book
Manager helps you to manage the Microsoft Exchange servers, mailboxes and groups which are
imported into Address Book Manager and keep them in synch to facilitate email archiving. You
can schedule automatic synchronization to keep the Archive Manager for Exchange database up
to date and synchronized with the Active Directory.

In this topic:

e Steps to open the Address Book Manager

About the Address Book Manager

Importing Microsoft Exchange Servers

Importing Mailboxes

Importing or Creating Groups

Synchronizing Address Book Manager
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e Managing Servers

e Managing Groups

e Managing Mailboxes

Steps to open the Address Book Manager

1. Logintothe Archive Manager for Exchange console.

2. From the Tools menu, click Address Book Manager

Archive Manager for Exchange

Session  View | Tools | Help

f‘j, Mailbox rights manager

Check mailboxes
g Createfolders
Q@  Exporttasks

Q Statistics

| W  Address book Manager

Options
Settings

or, click the Address Book Manager icon from the toolbar.

Archive Manager for Exchange

Session  View  Tools  Help

ERlRRaX DD qE

3. If no Microsoft Exchange servers, mailboxes or groups are available in the Address Book
Manager, the Address Book Setup wizard appears. Otherwise the Address Book Manager
window opens.

About the Address Book Manager

The Address Book Manager window provides two menu options:

Setup - starts the Address Book Setup wizard that provides a step-by-step guide to add Microsoft
Exchange servers, mailboxes and groups. If no Microsoft Exchange servers, mailboxes or groups
are available in the Address Book Manager, the Address Book Setup wizard appears by default
when you open the Address Book Manager.

Refresh - reloads information about Microsoft Exchange servers, mailboxes and groups based on
the available configuration settings.

The management of Microsoft Exchange servers, mailboxes, groups and synchronization settings
are organized by tabs in the Address Book Manager window.

o Synchronization —for manual or automatic synchronization of mailboxes, groups and
permissions with the Active Directory of available servers.
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e Servers —for adding, removing and managing Microsoft Exchange servers.

e Groups —forimporting groups, creating user-defined groups and managing group features.

o Mailboxes —for importing new mailboxes and managing mailboxes.

7 Address book Manager

Setup  Refresh

Address book and settings

Server name Version Access method  Username Induded Configurati
Synchromzation .
fig” AMXEXCH 2016 MAPT DEMOCORP\domadmin Yes LDAP: ffCN<
@ fiy’ Democorp.onmicrosoft.., Exchange Online EWS admin@democorp.onmi...  Yes LDAF: ffCNS
Servers

-:" ISFOTPS:

ﬁ HaboRES

/ . <
/ 2 servers

Importing Exchange Servers

In this topic:

e Options for importing Microsoft Exchange servers

e Steps to add on-premise Microsoft Exchange servers

e Steps to add Exchange Online servers

e Steps to verify the imported Microsoft Exchange servers

Options for importing Microsoft Exchange servers

Microsoft Exchange Servers can be added to the Address Book Manager in one of two ways:

e Option 1- Using the Address Book Setup Wizard.
1. Openthe Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book setup wizard appears.

3. Click the Launch server wizard to initiate the import process.
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Address book setup

Address book setup

G Import Exchange Server

In order to archive e-mails, you have to spedfy which Exchange Servers ‘Q
should be used. The wizard will help you locating the Exchange Servers in ‘.".“
your organization and you will be able to impart the Exchange Servers.

Launch server wizard

6 Import Mailboxes

‘fou have to specify which mailboxes should be allowed for archiving. Ifa X
mailbox is notimported, it is not possible to archive e-mails from it. The

mailbox import wizard will help you to locate the mailboxes and to import
them.

Launch mailbox wizard
6 Import Exchange groups
The Exchange groups {security groups or distribution lists) will help you to
easily manage the settings all over the archive system. The group impart
wizard will help you to locate the groups in Exchange Servers and

additionaly it allows you to create user defined groups.
Launch group wizard

_ CIDSE

e Option 2 - Starting a task from the Servers tab of the Address Book Manager.

1. Openthe Address Book Manager.

2. Click the Servers tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Add
Server... to initiate the import process.

™ Address book Manager

Setup  Refresh

Address book and settings

Access method  Username Induded Configuration path

Server name Version

¢ Synchroneation

[ Tesks v || AddServer
£\ iarpupe Add/Remove columns Update Servers
Refresh Purge Servers

& HEIbURES Properties

2. s 3
/ 2 servers

Whichever method you choose, the Select Exchange Server Type window opens.

Steps to add on-premise Microsoft Exchange servers

1. Inthe Select Exchange Server Type window, select Import Exchange On-Premise.
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2. Click Next. A list of Microsoft Exchange Servers appear that are accessible within your trusted
domain. Select the servers that contain the mailboxes and folders you want to archive and
then select the checkboxes to set the permissions as described below:

a. Set Exchange server permissions for service account - grants elevated rights to the
superuser on each of the selected Microsoft Exchange Servers.

b. Set Public Folder permissions for service account - grants OWNER permission to the Public
folders.

3. Click Next. If the permission options in the previous step are selected, the Exchange
Administrator window opens. The Superuser's SMTP address window opens.

e Forthe Exchange Administrator window:

a. Exchange Administrator SMTP address - enter the email address of the superuser if not
already filled in.

b. Password - enter the password.
c. Click Next.
e Forthe Superuser's SMTP address window

a. Superuser's mailbox SMTP address - enter the email address of the superuser if not
already filled in. You can change the email later from the server Properties window.

b. Click Next.

4. The Summary window opens that lists the on-premise servers that will be added. Click Finish
to start the import process. The Creating objects window opens. You can click Back to select
more servers to add or remove some of the selected servers.

5. When the import process has completed, click Close.

Steps to add Exchange Online servers

1 | NOTE: You must register your Quest Archive Manager application in Microsoft Entra ID. For
more details, see Registering Quest in Microsoft Entra ID for EWS.

1. From the Address Book Setup wizard, click the Launch server wizard to initiate the server
import process.

2. Inthe Select Exchange Server Type window, select Import Exchange Online.

3. Click Next. The Credentials for Exchange Online window opens. Specify the information as
described below:

a. Username - username of the administrator.
b. Client ID - the Application ID that you copied from Microsoft Entra ID.

c. Clientsecret - the Secret ID that you copied from Microsoft Entra ID.



d. Endpointtype - select from the following options:

o Worldwide endpoints - endpoints for worldwide Microsoft 365 subscriptions, which
include the United States Government Community Cloud (GCC).

¢ U.S. Government DoD endpoints - endpoints for United States Department of Defense

(DoD) subscriptions.

e U.S. Government GCC High endpoints - endpoints for United States Government

Community Cloud High (GCC High) subscriptions.

4. Click Next. The Available Exchange Servers window opens. Select the Office 365 instance. You
can click Back to select more servers to add or remove some of the selected servers.

5. Setthe permission as described below:

e Set Public Folder permissions for <Exchange server online superuser> - grants OWNER
permission for the Public folders to the Exchange serve online superuser.

6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that

will be added.

7. Click Finish to start the import process. The Creating object window opens.

8. When the import process has completed, click Close..

Steps to verify the imported Microsoft Exchange

servers

1. Open the Address Book Manager

2. Click the Servers tab and verify the imported serversin the list view.

7 Address book Manager

Refresh

Setup

Address book and settings

Server name Version Access method  Username

-‘; Synchronization

‘j Servers

;v:'_ ST OTIpS.

n HELGRES

o AMYEXCH 2016 MAPT DEMOCORP\domadmin
fig! Democorp.onmicrosoft...  Exchange Online EWs admin@demaocorp. onmi...

Induded Configurati

fes LDAP: /fCNS
‘Yes LDAP: [jCN4

<
/ 2 servers
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Importing Mailboxes

In this topic:

e Options forimporting mailboxes

e Steps to import mailboxes from on-premise Microsoft Exchange servers

e Steps to import mailboxes from Exchange Online

e Steps to verify the imported mailboxes

Options for importing mailboxes

Microsoft Exchange server mailboxes can be added to the Address Book Manager in one of two
ways:

e Option 1- Using the Address Book Setup Wizard.
1. Open the Address Book Manager.
2. From the Setup menu, click Setup Wizard. The Address book Setup wizard appears.

3. Click the Launch mailbox wizard to initiate the import process.

Address book setup PR

Address book setup

O Import Exchange Server

In order to archive e-mails, you have to spedfy which Exchange Servers ‘n
should be used. The wizard will help you locating the Exchange Servers in ‘ @
your organization and you will be able to impart the Exchange Servers.

O Import Mailboxes

‘fou have to specify which mailboxes should be allowed for archiving. Ifa
mailbox is notimported, it is not possible to archive e-mails from it. The
mailbox import wizard will help you to locate the mailboxes and to import
them.

Launch mailbox wizard

Import Exchange groups
The Exchange groups {security groups or distribution lists) wil help you to
easily manage the settings all over the archive system. The group impart
wizard will help you to locate the groups in Exchange Servers and

additionaly it allows you to create user defined groups.
Launch group wizard

_ o

e Option 2 - Using the Mailboxes tab of the Address Book Manager.

1. Openthe Address Book Manager.
2. Click the Mailboxes tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Import
mailbox wizard to initiate the import process.
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" Address book Manager

Setup  Refresh

Address book and settings

Display name

s Srnchromzation

= SETVETS

email address

Home server

Frulns | T

4 Import mailbox wizard

Add/Remove columns

Refresh list

@ Mailboxes

Activate mailboxes

Deactivate mailboxes

Properties

Permissions

Migrate mailbox

Purge mailboxes

Synchronize mailbox folder permissions

Update mailboxes

Mailboxes: 1-130f 13

Whichever method you choose, the Import mailbox wizard window opens.
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Steps to import mailboxes from an on-premise
Microsoft Exchange Server

1
2.

In the Select Exchange Server Type window, select Import from Exchange On-Premise.
Click Next. The Mailboxes - search and select mailboxes to import window opens.

Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter ni as the search term and click Search, the mailboxes that start with the letters ni
will be returned in the search results list.

Select one or more mailboxes that you want to import.

i | NOTE: Mailboxes that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of mailboxes will indicate how many
mailboxes that you select are new, and how many already exist. If you select pre-
exisiting mailboxes, they will be updated during the import process.

Click Next. The Summary window opens that lists the mailboxes from the on-premise
Microsoft Exchange servers that will be imported.

Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

When the import process has completed, click Close.

Steps to import mailboxes from Exchange Online

1

2.

3.

In the Select Exchange Server Type window, select Import from Exchange Online.
Click Next. The Exchange Online window opens. Select the Exchange Online instance.
Click Next. The Mailboxes - search and select mailboxes to import window opens.

Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter A as the search term and click Search, the mailboxes that start with the letter A
will be returned in the search results list.

Select one or more mailboxes that you want to import.
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NOTE: Mailboxes that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of mailboxes will indicate how many
mailboxes that you select are new, and how many already exist. If you select pre-
exisiting mailboxes, they will be updated during the import process.

6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that
will be added.

7. Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

8. When the import process has completed, click Close.

Steps to verify the imported mailboxes
1. Open the Address Book Manager

2. Click the Mailboxes tab and verify the imported mailboxes in the list view.

7 Address book Manager

Setup  Refresh
Address book and settings
- Display name Alias email address Horl
e Synchronmzation
[:’1 Administrator d dmin d dmin domadmin@democarp. com AM
= f:_’; Aman Ali amanali amanali amanali@democorp.com AM
bENYETS (2 David Webb davidwebb davidwebb davidwebb @democorp.com AM
() Devika Sharma devikasharma devikasharma devikasharma @democorp.com  AM
.v_"_ LT Oups f:’; Ishna Mohan ishnamohan ishnamohan ishnamohan @democorp.com AM
ffj Juan Christie juanchristie juanchristie juanchristie @democorp. com AM
Q Mailboxes [:’1 Karl Jordan karljordan karljordan karljordan@democorp. com AM
[:’1 Miki Portman nikiportman nikiportman nikiportman@democorp. com AM
(3 Nina Tanaka ninatanaka ninatanaka ninatanaka @democorp. com AM
() Pablo Neruda pabloneruda pabloneruda pabloneruda @democorp. com AM
2
@
[:’1 Tim Ashford timashford timashford timashford @demacorp.com AM
p € >
/ Page: of 1 Mailboxes: 1- 13 of 13 [4 < ¥ A
i | NOTE:

In the mailboxes list you will also see mailboxes names public_<name-of-Microsoft-
Exchange-server>. These mailboxes are the public folders from the respective Microsoft
Exchange server because Address Book Manager considers a public folder as a profile.
These mailboxes are always highlighted in blue M, so you can distinguish them faster.

Imported mailboxes must be added to a group in Address Book Manager to activate
automatic archiving with scheduled jobs. If you do not add mailboxes to a group you can
archive them manually. For more information about adding mailboxes to groups see
Adding members to a user defined Archive Manager group.
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Importing or Creating Groups

Groups activate you to schedule archiving jobs. There must be at least one group (either
imported from Active Directory or a user-defined group) if you plan to schedule archiving jobs.
User-defined groups are not Active Directory groups.

In this topic:

e Options forimporting groups

Steps to import groups from on-premise Microsoft Exchange servers

Steps to import groups from Exchange Online

Steps to create user-defined groups

Steps to verify the imported groups

Options for importing groups
Microsoft Exchange server groups can be added to the Address Book Manager in one of two ways:
e Option 1- Using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book Setup wizard appears.

3. Click the Launch group wizard to initiate the import process.

Address book setup PR

Address book setup

O Import Exchange Server

In order to archive e-mails, you have to spedfy which Exchange Servers 'n
should be used. The wizard wil help you locating the Exchange Servers in ‘ {:‘
yaur erganization and you will be able to impart the Exchange Servers. —

Launch server wizard

O Import Mailboxes

You have to spedify which maiboxes should be allowed for archiving. If a
mailbox is notimported, it is not possible to archive e-mails from it. The
mailbox import wizard will help you to locate the mailboxes and to import
them.
Launch mailbox wizard

O Import Exchange groups

The Exchange groups (security groups or distribution lists) will help you to
easily manage the settings all over the archive system. The group impert
wizard will help you to locate the groups in Exchange Servers and
additionaly it allows you to create user defined groups.

Launch group wizard

_ CIUSB

e Option 2 - Using the Groups tab of the Address Book Manager.

1. Open the Address Book Manager.
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2. Click the Groups tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Add
group wizard... to initiate the import process.

7 Address book Manager

Setup  Refresh

Address book and settings

Display name Alias email address Group

_‘; Synchromzation

= SETVETS:

| Tasks 4 H Add group wizard

Purge group

Add/Remove columns
Refresh

Properties

£ >

7

/ Page: of 1 Groups: 1-4of4 K 4 » A

Whichever method you choose, the Import group wizard window opens.

Steps to import groups from an on-premise
Microsoft Exchange Server

1. Inthe Import group wizard window, select Import Groups.

2. Click Next. The Exchange type selection window opens. Select Import form Exchange On-
Premise.

3. Click Next. The Groups - search and select groups to import window opens.

4. Click Search to return the list of all groups across all on-premise servers available to the
Address Book Manager. To reduce the list of groups, you can specify a search term in the Look
for Name search box. Only the initial letters of the groups Display Name can be specified, and
wildcards are not supported. The search term is case-insensitive. For example, if you enter D
as the search term and click Search, the groups that start with the letter D will be returned in
the search results list.

5. Select one or more groups that you want to import.

i | NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select preexisting groups, all
new mailboxes will also be imported.
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6. Click Next. The Group settings - default values window opens.

% Import group wizard

Group settings - defa

The groups will be imported with the following default settings:

Automatically import mailbox members

Advanced impart settings

(® Import subgroups along with its members

(O Import only mailbox members without subgroups

_ | < Back H ek > || Cancel |

7. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:

a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import
mailbox members setting.

¢. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.

8. Click Next. The Summary window opens that lists the groups that will be added.
9. Click Finish to start the import process. The Creating Object window opens.

10. When the import process has completed, click Close.

Steps to import groups from Exchange Online

1. Inthe Import group wizard window, select Import Groups.

2. Click Next. Inthe Exchange Type selection window, select Import from Exchange Online.

3. Click Next. The Exchange Online window opens. Select the online Microsoft Exchange server.

4. Click Next. The Groups - search and select groups to import window opens.
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5. Click Search to return the list of all groups across all online servers available to the Address
Book Manager. To reduce the list of groups, you can specify a search term in the Look for
Name search box. Only the initial letters of the group Display Name can be specified and
wildcards are not supported. The search term is case-insensitive.

i | NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select pre-existing groups, all
new mailboxes in those groups will also be imported.

6. Select the groups that you want to import.

7. Click Next. The Group settings - default values window opens

it Import group wizard

- default values:

The groups will be imported with the following default settings:

Automatically import mailbox members
Advanced impart settings
(®) Import subgroups along with its members

() Import only mailbox members without subgroups

_ | < Back H ek = || Cancel |

8. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:

a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import
mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.

9. Click Next. The Summary window opens that lists the groups that will be added.

10. Click Finish to start the import process. The Creating objects window opens. You can click Back
to select more groups to add or remove some of the selected groups.
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11. When the import process has completed, click Close.

Steps to create user-defined groups

1. Inthe Import group wizard window, select Create user defined group. Enter a name for the
group in the Group Name field.

{4 Import group wizard

Wizard type selectio

O Import Groups

(®) Create user defined aroup

&
@

Group Name:

|Demn Group

_ . Back

2. Click Next. The User Defined Group - Add members to group window opens. By default, the
on-premise Microsoft Exchange server is the source for the list of mailboxes and groups that
can be added to the user-defined group. To use Exchange Online servers as a source for
mailboxes and groups, select Exchange Online.

3. Click Search to return the list of all mailboxes and groups. To reduce the list of mailboxes and
groups, you can specify a search term in the Look for Name search box. Only the initial letters
of the mailbox or group Display Name can be specified and wildcards are not supported. The
search term is case-insensitive.

NOTE: If the Exchange Online checkbox is checked, only the online Microsoft Exchange
servers will be used as the source. If the Exchange Online checkbox is unchecked, only
on-premise Microsoft Exchange servers will be used as the source.

Mailboxes and groups that are highlighted indicate that they already exist in the
Address Book Manager. The list summary above the list of groups will indicate how
many mailboxes and groups are available.
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Look for Name:

i Import group wizard

User Defined Group - Add membersito group:

Search

[] Exchange Online

Display Name

[

Email Address

meta.test

] niki Portman
] 1shna Mohan
Nina Tanaka
Pablo Neruda
Aman Al

[] Juan Christie
[ pevika Sharma
[ Karl Jordan
[ Tim Ashfird

<

nikipartman @domca.meta. test
ishnamohan@domca. meta. test
ninatanaka @domca. meta. test
pabloneruda@domca.meta. test
amanali@domca. meta, test
juanchristie @domca.meta. test
devikasharma@domca. meta. test
karljordan @domeca.meta. test
timashford@domea. meta. teat

Member Type ™

Mailbox
Mailbox
Mailbox
Mailbox
Mailbox
Mailbox
Mailbox
Mailbox
Mailbox
Mailhnw

w

>

Mext > | |

Cancel

- =

4. Select one or more mailboxes and groups that want to add to the user-defined group. If you
select one or more groups, all mailboxes in that group will also be add to the user-defined
group during the import process.

5. Click Next. The Summary window opens that indicates the user-defined group that will be

created.

6. Click Finish to start the group creation process. The Creating Object window opens. You can
click Back to revise your selection of mailboxes and groups.

7. When the import process has completed, click Close.

Steps to verify the imported groups

1. Openthe Address Book Manager

2. Click the Groups tab and verify that the imported Active Directory and user-defined groups
appearin the list view as expected. User-defined groups are highlighted in green
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™ Address book Manager

Setup  Refresh

Address book and settings

- Display name RDM Alias emal address Group
¢ Synchronization

& Group Accounts Group Accounts group-accounts group-accounts@dem...  auto
s Group Democorp Group Democorp group-democarp group-democorp@dem... auto
ﬂ Group Products Group Products group-products group-products@dem...  auto
s Group Sales Group Sales group-sales group-sales @democor...  auto

= SETVETS

€ >

y Page: of 1 Groups: 1-4of4 K { b3 A

3. Select agroup and right-click to open the context menu. Click Properties. The Properties
window of the selected group appears.

4. Click the Members tab and verify that the list of mailboxes were imported as expected.

Synchronizing Address Book Manager

Synchronization with the Microsoft Exchange servers keeps groups and mailboxes up to date so
that emails can be archived without problems. With the Address Book Manager, you can set up
automatic synchronization schedules and initiate manual synchronization of various artifacts.

In this topic:

e Steps to perform a manual synchronization

e Steps to schedule automatic synchronization

Steps to perform a manual synchronization

1. Open Address Book Manager by clicking the toolbaricon W or clicking Address Book Manager
from the Tools menu.

2. The Synchronization tab opens by default.
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7 Address book Manager

Setup  Refresh

Address book and settings

E, Synchronization
Exchange Synchronization Exchange Permissions Synchronization

= SETVETS

Activate Maibox Update Activate Exchange Mailbox permission sync
)
2L

Activate Mailbox Folder permission sync
Activate Group Update

‘ HabiEES Activate Public Folder permission sync

Sync Mow Schedule Sync Mow Schedule

Select servers:

Server Name

AMXEXCH
democompany.onmicrosoft.com

v/

/ Apply

. Select the Microsoft Exchange mailboxes, groups and permissions that you want to
synchronize.

In the Select servers box, select the Microsoft Exchange servers with which you want to
synchronize the mailboxes, groups and permissions.

. Click Apply to confirm the settings.

. Click Sync Now in the Microsoft Exchange Synchronization box to manually initiate the
synchronization of the mailboxes and groups with the selected Microsoft Exchange servers.

. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that appears. You can find the results of the synchronization
processinalogfile locatedat c:\Program Files (x86)
\Quest\MAM4Exchange\Log\Synchronization <timestamp>.log

. Click Sync Now in the Microsoft Exchange Permissions Synchronization box to manually initiate
the synchronization of the mailboxes and groups with the selected Microsoft Exchange
servers.

. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that appears. You can find the results of the synchronization

processinalogfile located at c:\Program Files (x86)
\Quest\MAM4Exchange\Log\Synchronization <timestamp>.log

Steps to schedule automatic synchronization

1. Open Address Book Manager by clicking the toolbaricon W or clicking Address Book Manager

from the Tools menu.

2. The Synchronization tab opens by default.
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7 Address book Manager

Setup  Refresh

Address book and settings

., Synchronization
Exchange Synchronization Exchange Permissions Synchronization

= SELVETS)
Activate Mailbox Update Activate Exchange Mailbox permission sync
v:’_ Croiing
Activate Mailbox Folder permission sync
Activate Group Update

& pelilb=s Activate Public Folder permission sync

Sync Now Schedule Sync Now Schedule

Select servers:

Server Name

AMXEXCH
democompany. onmicrosoft.com

s

3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to
synchronize.

4. Inthe Select servers box, select the Microsoft Exchange servers with which you want to
synchronize the mailboxes, groups and permissions.

5. Click Schedule in the Exchange Synchronization box. The Exchange Synchronization Scheduler
dialog appears.

-or-

Click Schedule in the Exchange Permissions Synchronization box. The Exchange Permissions
Synchronization Scheduler dialog appears.

™ Exchange Synchronization scheduler PER ™ Exchange Permissions Synchronization scheduler ¥ 1@ &

Scheduling Scheduling

ML&;JJ.EJH: MIZd Lo =Ched e Mg&gﬂ,gu‘ Nz tioN sChed e

Use scheduled synchronization Use scheduled synchronization

[u] & 12 18 0 6 12 13

Monday Monday

Tuesday Tuesday

Wednesday Wednesday

Thursday Thursday

Friday Friday

Saturday Saturday

Sunday | Sunday |

|:| - Not scheduled I - Scheduled |:| - Mot scheduled I - Scheduled
Flease mark the hours on the weekly plan when the Please mark the hours on the weekly plan when the
synchronization should take place synchronization should take place
_ _

6. Select Use scheduled synchronization to activate the synchronization calendar. Each row
corresponds to a day of the week. Each column corresponds to an hour of the day (24-hour
clock).
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7. Toset up aschedule using the synchronization calendar, click the cell that corresponds to the
day of the week and the hour of day when you want the scheduler to initiate a
synchronization job. For example, in the figure above, the synchronization schedule is set to
start at 18:00 hrs (6 pm) every weekday. The time zone of the computer where the application
is running will be used to determine the time.

1 | NOTE: If you select consecutive cells in a single row, synchronization will start
automatically every hour on the hour. It will consume unnecessary processing time and
not recommended.

8. Click OK to save the schedule or Cancel to discard the setup.

9. You can find the results of the scheduled synchronization process in a log file located at c:
\Program Files (x86)
\Quest\MAM4Exchange\Log\Synchronization <timestamp>.log

Managing Servers

The Address Book Manager provides all the necessary tools to manage Microsoft Exchange on-
premise and online servers that are imported into the Address Book Manager.

In this topic:

e Managing the servers list view

e Managing Server Tasks

e Managing Server Properties

Managing the servers list view

The servers list view displays the on-premise and online servers that are imported into the
Address Book Manager.

Steps to view the servers list

1. Open Address Book Manager by clicking the toolbaricon W or clicking Address Book Manager
from the Tools menu.

2. Click the Servers tab. The servers list view appears with a default set of columns. You can add
or remove these columns.
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7 Address book Manager

Setup  Refresh

Address book and settings

Server name Versian Access method  Username Induded Configurati

‘JAMXEXCH 2016 MAPT DEMOCORP\domadmin ‘fes LDAP:/fCN4
fig”! Democorp.onmicrosoft... Exchange Online EWS admin@democorp.onmi...  Yes LDAP: /fCNS

1“ Synchromzation

;'_"_ Ernins

‘ IHEBUHES

o

< >
/ 2 servers

3. The columns are as follows:

. Server name - the name of the on-premise or online Microsoft Exchange server
. Version - the version of the Microsoft Exchange application installed on the server.

Access Method - How Archive Manager for Exchange connects to the Microsoft Exchange
server. The two possible values are MAPI or EWS.

. Username - the username that is used to access the server. The format for an onpremise
exchange server is <domain>\<username> and for an Exchange Online sever it is the email
address.

. Included - Yes indicates that the server will be synchronized. No indicates that the server
will not be synchronized and is also highlighted in green

Configuration path - LDAP Uniform Resource Locator (URL) that defines the server location.

. Deleted - No indicates the serveris active in Address Book Manager. Yes indicates that the
server is logically deleted from the list of servers and is will not be used. Deleted servers
are highlighted in red I

. Server DN - legacy distinguished name (DN) of the Microsoft Exchange server.
Server Id - a unique serial number allocated to each server in Address Book Manager.

Modification Date - the most recent date when the server was synchronized.

Steps to add or remove server list columns

1. Right-click to open the context menu and click Add/Remove columns...
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Available columns: Selected columns:
Deleted
Server DN Version
SERVERID Access method
Modification date Username
inuced &
Configuration path R

. ol

2. To add a column to the display:

a. Select the column from the Available columns list box.
b. Click Add to move the column to the Selected columns list box.

¢. Use the Up and Down buttons to column the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.

d. Click OKto close the dialog box and view the revised set of columns in the list view.
3. Toremove a column from the list view:

a. Select the column from the Selected columns list box.

b. Click Remove to move the column to the Available columns list box.

c. Click OKto close the dialog box and view the revised set of columns in the list view.

Steps to refresh the list view

1. Right-click to open the context menu and select Refresh. All servers in the list will be
refreshed.

Managing Server Tasks

The Servers section of the Address Book Manager provides a set of tasks to add, update, remove
and repair Microsoft Exchange servers. Each of these tasks are described below.

Adding a new on-premise or online Microsoft Exchange server

1. Right-click inside the list view and from the context menu point to Tasks and select Add
Server... to initiate the import process.
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" Address book Manager

Setup  Refresh

Address book and settings

Server name Version Access method  Username Induded Configuration path

! e Synchronieation

Tasks 4 || Add Server
:'. LsrOupE: Add/Remove columns Update Servers
Refresh Purge Servers
% H RS ——

// ' ; :
2 servers

2. Fordetailed steps about importing on-premise servers see Steps to add on-premise Microsoft
Exchange servers.

3. Fordetailed steps about importing online servers see Steps to add online Microsoft Exchange
servers.

Updating Microsoft Exchange servers
1. Select aserver from the server list view.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Update
Servers.

3. When the selected serveris updated successfully, a confirmation message is displayed.

1 | NOTE: If the superuser is changed, you must update the servers so that the superuser
information is updated.

Removing Microsoft Exchange servers from the list
1. Selectaserverfrom the server list view that you want to remove.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Purge
Servers.

Delete server

@ Are you sure you want to delete selected server?

| Yes | | Mo

Quest® Archive Manager for Exchange Administration Guide

62
Tools, Options and Settings



3. Click Yes to confirm that you want to remove the selected server from the Address Book
Manager. Click No to cancel the operation.

Repairing the MAPI profile

1. Selectaserverfrom the server list view that you want to remove.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Repair
MAPI Profile.

" Address book Manager

Setup  Refresh

Address book and settings

Access method  Username Induded Configuration path

Version

SErver name
Synchromzation

L
@ Servers
Add/Remove columns

'."- IsFOUpE Refresh Purge Server
Repair MAPI profile

2016

Tasks L4 Add Server

Update Server

Properties

% HobREs

£ >
2 servers / 1 selected

3. The MAPI profile will be updated.
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Managing Server Properties

Microsoft Exchange Servers can be either on-premise servers or online Exchange Online servers.
The properties of each Microsoft Exchange server added to the Address Book Manager can be
managed through the Properties dialog box. They are grouped by tabs and each property group is
explained in detail below.

For on-premise servers:

e General properties

e EWS properties

o MAPI properties

e Advanced properties

For Exchange Online servers:

e General properties

e Exchange Online properties

» For on-premise servers

General properties
1. Select an on-premise server from the server list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears and the Generaltab is displayed by default.

3. Click the General tab if not already selected.

Quest® Archive Manager for Exchange Administration Guide

) ) 64
Tools, Options and Settings



™ AMX16EXCH Properties

General "EWS "MAPI "Advanced ]

FR

ﬂisu’.lu.!,: SOCTPTOPCT TS

Mame: |AM=< 16EXCH

Version: Exchange 2016

Access method: MAPT

Active
Indude this server in synchronization

‘T‘ Conce —

4. This section provides genericinformation about the server. The properties are as follows:

a. Server name - Read-only. The name of the on-premise or online Microsoft Exchange

server.

b. Version - Read-only. The version of the Microsoft Exchange application installed on the

L

server.
c. Access Method - Choose how Archive Manager for Exchange connects to the Microsoft
Exchange server. The two access methods available are MAPI or EWS.
M AMXEXCH Properties PR ™ AMXEXCH Properties
General EWS MAPI Advanced General EWS MAPI Advanced
MName: - |:'«lv1;ExCH — Name: - |:'«lv|;ExCH —
Version: Exchange 2016 Version: Exchange 2016
Access method: EwWs v Access method: MAPT v
Archiving with EWS access method converts RTF
%, messages to HTML.
Active Active
Indlude this server in synchronization Include this server in synchronization
- 0K || Cancel || Apply | -T‘ Cancel Apply
d. Active - Select the checkbox to activate the Microsoft Exchange server. If the checkbox is
cleared, the serveris deactivated and it is not possible to synchronize or import groups or
mailboxes from this server.
e.

Include this server in synchronization - When this checkbox is checked, the serveris

included in the synchronization process. When this checkbox is unchecked, the server will
not be synchronized and appears in the list view highlighted in green

dialog.

5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
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EWS properties
1. Select an on-premise server from the server list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.

3. Click the EWS tab.

= AMX16EXCH Properties PR
General | EWS MAPT Advanced
li:u'_m.gz WEDSErCES: —

EWS Url:
|https:,ffAM>< 16EXCH/EWS [Exchange. asmx |

EWS Administrator:

| |
Password:

| |

Domain:

The properties are as follows:

a. EWS Url - https://<Microsoft-Exchange-server-IP-Address-or-Name>/EWS/Microsoft
Exchange.asmx

b. EWS Administrator - username of an EWS administrator who must have impersonation
permissions. This is usually the super-user.

c. Password - password of the EWS Administrator.
d. Domain - domain of the given user.

4. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

NOTE: EWS Limitations

1. EWS does not support the RTF format for email messages.
RTF messages are converted to HTML when messages are archived and retrieved.

If HTML messages are saved as .MSG files in Unicode format, Outlook will remove
embedded images and use the RTF format to display the message. As a result, images
are available as attachments and not embedded in the body.

2. Shortcuts are not created for several message types
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needed.

o |PM.Post

MAPI properties

1.

2.

Select an on-premise server from the server list.

IPM.Schedule.Meeting.Request
IPM.Schedule.Meeting.Canceled
IPM.Schedule.Meeting.Resp.Pos
IPM.Schedule.Meeting.Resp.Tent

IPM.Schedule.Meeting.Resp.Neg

The message types listed below are not replaced with a shortcut when the messages
are archived. A copy of the original message is stored in the archive and retrieved when

3. Voting summary cannot be retrieved for archived voting responses

Emails can be created in Outlook using the Voting option that allows respondents to
cast a vote. If the original email message that contains the voting poll is archived and
retrieved with EWS, the poll results are not available through the sent items message
Tracking. If the response emails from votes are archived and retrieved, the voting poll
summary is not available when you click the View voting response info button.

Right-click to open the context menu and click Properties. The Properties dialog for the

selected server appears.

Click the MAPI tab.

= AMX16EXCH Properties PR

General | EWS MAPT Advanced

H_yll';?_'

SMTP address: |spsadmin@democompany‘cnm

Username: |

Password: |

Connect to Microsoft Exchange using HTTP

Use this URL to connect to proxy server for Exchange:

‘mail .democompany.com

Connect using S5L only

Only connect to proxy servers that have this principal
name in their certificate:

|mssh:|:mail.democompanv.com

Proxy authentication settings

NTLM ~

The properties in this section are as follows:
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a. SMTP address - email address of the superuser that is automatically imported from the
Exchange server settings.

b. Username - username of the superuser for MAPI communication.
c. Password - password of the superuser for MAPI communication.

d. Connect to Microsoft Exchange using HTTP - If selected, the Exchange server connection
will use the HTTP protocol.

e. Proxy server URL - Address of the proxy server if applicable.
f. Connect using SSL only - If selected, the connection will be encrypted using SSL.

g. Only connect to proxy servers that have this principal name in their certificate - specify the
Certificate Principal Name to connect to proxy servers if certificate mappingis used in the
Active Directory.

h. Proxy authentication settings - authentication protocol for the proxy server if a proxy
serveris used.

5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

Advanced properties

This section displays properties that define the configuration path and server distinguished name
1. Select an on-premise server from the server list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.

3. Click the Advanced tab.

M AMXEXCH Properties PR

General | EWS MAPT Advanced

—ﬁ ASSoCIEHTEN ACOVE NTECLOTY OLTECE

Exchange Server Configuration path:
|LDAP:,ffCN=AM><B<cH,CN=5ervers,CN=Exd1ange Administrative c|

Server distinguished name {legacyDN)
|fo=Dem0 Corparationjou=Exchange Administrative Group [FYDIB(|

Show object properties
Reload values from Exchange Update now
Remote PowerShel credentials

B
The properties on this tab are described below:

a. Exchange Server Configuration path - LDAP address of the Exchange server.
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b. Server distinguished name - Exchange LegacyDN LDAP entry that uniquely identifies and
describes the Exchange server.

c. Show object properties - Displays information about the Exchange server. Click Show to
display more information about the Microsoft Exchange server. Click Close to exit the

dialog.

T Active Directory object property view EEER

LDAP: /fCN=AMX 16EXCH, CN=5ervers, CN=Exchange Administrative Group (FYDIBOHF 235PDLT),CH=Administrative

Property Type
objectCIass String

E"Jcn String
sEriaINumbEr Siring
disﬁnguishedName String
[@8]instanceType Int32
whenCreated DateTime
whenChanged DateTime
uSNCreabed __ComObject
uSNChanged __ ComObject
sthInAdvanced\-‘iewOnI\; Boolean
adminD\spIayNamE Siring
nTSecurit'y'Descriptc-r _ ComObject
net'a\'ork.-'-\ddress String
name String

%8 objectsuD Bytel]

<

Values

top

server

msExchExchangeServer

AMX16EXCH

Version 15.1 (Build 31713.5)

CM=AMX 16EXCH,CN=5ervers,CN=Exchange Administrative ...

4

4242018 7:21:51 PM

4/24/2019 8:24:11PM

System.__ComObject

System.__ComObject

True

AMX16EXCH

System._ ComObject

nCacn_vns_spp:AMX 16EXCH

nethios: AMX 16EXCH

ncacn_np:AMX 18EXCH

ncacn_spxAMY 16EXCH

ncacn_ip_tep:AMX 16EXCH. domea. meta. test

ncalrpc: AMY 16EXCH

AMX16EXCH

EA2CATFCT5S2F24F 4033 SECZAECE 123202
>

A

v

Close

d. Reload values from Exchange - Reloads the server property values from the Exchange
server. Click Update now to refresh server property values.

e. Remote PowerShell credentials - helps you change the credentials used by PowerShell
for remote connection to the Exchange server. Click Change to open the Remote
PowerShell Credentials window. Enter the credentials and click OK to re-connect
PowerShell with the new credentials. This property is designed for Exchange on-premise
servers only. The credentials are valid for MAPI and EWS access methods.

4. Click OKto close the Properties dialog.

» For Exchange Online servers

General properties

1. Select an on-line server from the server list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears and the Generaltab is displayed by default.
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3. Click the General tab if not already selected.

S pemocorp.onmicrosoft.com Properties PR

General || Bxchange Online

Mame: Democorp.onmicrasoft. com

Version: Exchange Online

Access method: EWS

Archiving with EWS access method converts RTF
/&% messages to HTML.

Active
Indude this server in synchronization

e

4. This section provides genericinformation about the server. The properties are as follows:

a. Server name - Read-only. The name of the on-premise or online Microsoft Exchange
server.

b. Version - Read-only. The version of the Microsoft Exchange application installed on the
server.

c. Access Method - Choose how Archive Manager for Exchange connects to the Microsoft
Exchange Online server. For EWS, all RTF messages will be converted to HTML when
messages are archived.

1 | NOTE: MAPI is not supported for Microsoft Exchange Online.

d. Active - Select the checkbox to activate the Microsoft Exchange server. If the checkbox is
cleared, the serveris deactivated and it is not possible to synchronize or import groups or
mailboxes from this server.

e. Include this server in synchronization - Select this checkbox to include the serverin the
synchronization process. When this checkbox is cleared, the server will not be
synchronized and appears in the list view highlighted in green

5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

Quest® Archive Manager for Exchange Administration Guide

) ) 70
Tools, Options and Settings



Exchange Online properties
This window displays properties that define the server name and service account.
1. Selectan online server from the server list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.

3. Click the Exchange Online tab.

S Democorp.onmicrosoft.com Properties PR

General || Bxchange Online ]
Lu;:s:'r_ii.u SELONg S . —

Username:

|admir1@Democorp.onmicrosoft.com |
Client ID:
|668be156-2b4d-43?1—bb3e-33669 14eabac |

e

4. Click Edit to change the Username and Client ID when required.

Managing Groups

The Address Book Manager provides all the necessary tools to manage groups that are imported
from Microsoft Exchange servers or created by the administrator.

In this topic:

e Managing the Groups list view

e Managing Group Tasks

Managing Group Properties

Adding members to a user-defined group

e Removing members from a user-defined group
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Managing the groups list view

The groups list view displays the groups that are imported from Microsoft Exchange servers or

created by the administrator.

Steps to view the groups list

1.

Open Address Book Manager by clicking the toolbar icon Wor clicking Address Book Manager

from the Tools menu.

Click the Groups tab. The groups list view appears with a default set of columns. You can add
or remove columns. User-defined groups are highlighted in green

™ Address book Manager

Refresh

Setup

Address book and settings

- Display name RDM Alias emal address Group
¢ S¥nChronzation
@ Group Accounts Group Accounts group-accounts group-accounts@dem...  auto
= ﬂ Group Democorp Group Democorp group-democarp group-democorp@dem...  auto
BELVETS ﬂ Group Products Group Products group-products group-products@dem...  auto

@ Group Sales Group Sales group-sales group-sales@democor...  auto

£ >

y Page: of 1 Groups: 1-4of 4 K L3 > A

The columns are described below:

a. RDN - Distinguished name of the recipient.

b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.

d. Email Address - Email address of the recipient.

e. Group Type - indicates the source of the group. Valid value are auto if the group was
imported from an on-Premise Exchange server, and manual if the group was created
manually.

f. Domain Name - the domain where the group belongs.
g. GUID- Unique identifier of this mailbox in the Microsoft Exchange server.
h. LDAP Path - Active Directory specification of the mailbox recipient.

i. Deleted - Yes indicates the mailbox is deleted. No indicates the mailbox is active.
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j. Creation Date - the date when the mailbox was imported into Address Book Manager.

k. Deleted Date - the date when a mailbox update fails to find the Active Directory object
specified by the LDAP path, and the mailbox is marked as deleted by the system.

. Modification Date - the most recent date when the mailbox was modified.

m. Reference Update - if the value is Yes, then only mailbox members without subgroups
must be imported during the next synchronization.

n. Auto create groups - if the value is Yes, then existing subgroups of the corresponding
group including its member mailboxes must be imported during the next synchronization.

0. Auto create mailboxes - if the value is Yes, then the root group must be imported along
with its root mailbox members only during the next synchronization. No subgroups or
subgroup members will be imported.

p. GID-aunique serial number allocated to each group in Address Book Manager.

Steps to add or remove groups list columns

1. Right-click to open the context menu and click Add/Remove columns...

Add/Remove columns 3

Available columns: Selected columns:

GUID RDM

LDAP path Display name

Deleted Alias

Creation date email address

Deleted date Group type Lp
Modification date Domain name

Reference update

Auto create groups

Auto create mailboxes
GID

m ol

2. Toadd a column to the display:

a. Select the column from the Available columns list box.
b. Click Add to move the column to the Selected columns list box.

c. Use the Up and Down buttons to column the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.

d. Click OK to close the dialog box and view the revised set of columns in the list view.
3. Toremove acolumn from the list view:

a. Select the column from the Selected columns list box.

b. Click Remove to move the column to the Available columns list box.

c. Click OKto close the dialog box and view the revised set of columns in the list view.
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Steps to refresh the list view

1. Right-click to open the context menu and select Refresh. All groups in the list will be
refreshed.

Managing Group Tasks

The Groups section of the Address Book Manager provides a set of tasks to add and remove
groups. Each of these tasks are described below.

Adding groups

1. Right-click inside the list view and from the context menu point to Tasks and select Add group

wizard... to initiate the import process.

" Address book Manager

Setup  Refresh

Address book and settings

Display name Alias email address Group

| s Synchronization

= SEIVEDS

| Tasks 4 Add group wizard
ﬁ 1elzllbuites Add/Remove columns Purge group

Refresh

Properties

< >

% Page: of 1 Groups: 1-4of4 K < > b

2. Fordetailed steps about importing on-premise groups see Steps to import groups from on-
premise Microsoft Exchange servers.

3. Fordetailed steps about importing online groups see Steps to add groups from online
Microsoft Exchange servers.

4. Fordetailed steps to create user-defined groups see Steps to create user-defined groups.

Managing Group Properties

The properties of each group added to the Address Book Manager can be managed through the
Properties dialog box. They are grouped by tabs and each property group is explained in detail
below.
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General properties
1. Select agroup from the groups list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears and the Generaltab is displayed by default.

i, Domain Users Properties PRR

General | Member Of || Members |Advanced

Name: |Dnmain Users

Display name: |Dnmain Users

Alias: |Dnmain Users |

E-mail: |

Folder:

|CN=Doma|n Users,CN=Users,DC=domca, DC=meta,DC=test |

GUID:
|E66ADBDCAEBA59468C2080F9C5F5356D |

This group is imported From Exchange Server

B 2ol

3. The properties in this section are read-only. Their descriptions are as follows:
a. Name - Name of the group.
b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.
d. Email - the email of the group if applicable, otherwise it is blank.
e. Folder - Distinguished name of the group in the Active Directory.

f. GUID - Unique identifier of this group in the Microsoft Exchange server.

Member Of
1. Select agroup from the groups list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.

3. Click the Member Of tab. If the selected group is a sub-group of other parent groups, a list of
the parent groups appears in the Member of list box.
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i}, Domain Users Properties PER

General | Member Of "Members HAdvancEd ]

Member of:

Alias Display Mame e-mall address

IOK—‘ cance' ADDIV

4. Toview the properties of a parent group, right click on a selected group and click Properties.
The Properties dialog of the group appears.

Members
1. Select a group from the groups list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.

3. Click the Members tab. If the selected group has mailboxes or other groups, they appearin
the List of Members list box.

. Domain Users Properties PER
General " Member Of " Members H Advanced ]
List of members:
Alias Display Mame e-mail address
% davidwebb David Webb davidwebb@de...
ishnamohan Ishna Mohan ishnamohan@d...
% nikiportman Niki Portman nikiportman@d. ..
ninatanaka Nina Tanaka ninatanaka @de. ..
% spsadmin Administrator spsadmin@dem. ..
Add, ., Remove
IK—‘ Coneel o

4. Toview the properties of a mailbox or member group, right click on a selected mailbox or
group and click Properties. The Properties dialog of the mailbox or group appears.

Advanced

1. Select agroup from the groups list.
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2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.

3. Click the Advanced tab.

. Group Accounts Properties PER

General || Member Of | Members || Advanced

Q AULOMHLCTPAELES

Automatically import mailbox members
Advanced import settings

(®) Import subgroups along with its members

() Import only mailbox members without subgroups

Update now

-

=
Extra

User defined group
[] peactivate all group members
i ﬂ ASSOCHLEN ACHVENTECLOTY DDTECT
Show Active Directory object

s

Automatic Updates

These settings will be applied when the group is updated manually or synchronized in future

with the Microsoft Exchange server automatically. The properties in this section are as
follows.

a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import

mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of the

selected group including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member

mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.

Click Update Now if you want to synchronize the group with the Microsoft Exchange server.

Extra

a. Userdefined group - read only property. When checked, it indicates that this group was
created manually and not imported from a Microsoft Exchange server.

b. Deactivate all group members - check this box to deactivate mailboxes of users in the

group. Members in sub-groups will not be deactivated. This checkbox is not available for
user-defined groups that are created in the Address Book Manager. When a group member

is deactivated the following rules apply:
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e Archive Manager will deactivate the user's mailbox even though the useris a member of
another group where the member is still active.

e Archive Manager will temporarily activate a user's mailbox if the user is a member of two
or more groups where the member was deactivated and the member is subsequently
activated in any one of those groups.

e Archive Manager will deactivate a user's mailbox when mailboxes are synchronized if the
user is a deactivated member of any group.

This property is used when users registered with an Archive Serverin one location needs
access permissions to archived content of users registered with an Archive Serverin
another location. Consider an example where Susan Bennet in location 1 needs access to
archived content of a large number of users in location 2. As a global administrator you
would create a group in the Active Directory and add the users from location 2 to this group.
Then you would import this group to the Address Book Manager in location 1. You can now
grant permissions to Susan Bennet with the Mailbox Rights Manager to access the archived
content of the group members from location 2. However, you must deactivate these group
members by selecting the Deactivate all group members checkbox so that the primary
archive server for these members remains as location 2.

Associated Active Directory Object

a. Click the Show button to display more information about the group from the Microsoft
Exchange server.

NOTE: The Show Active Directory object and the Show button are not available for a user-
defined group.

T, Active Directory object property view A=

CN=Domain Users,CM=Users,DC=domca, DC=meta, DC=test

Property Type Values
obJectCIass String top
group
cn String Domain Users
description String All domain users
disﬁnguishedName String CN=Domain Users,CN=Users,DC=domca,DC=meta,DC=test
instanceType Int32 4
whenCreatEd DateTime 4/24/2019 5:14:44 PM
whenchanged DateTime 4/24/2015 5: 14:44 PM
uSNCreated __ComObject System. __ComObject
memherOf String CN=Users,CN=Builtin,DC=domca, DC=meta, DC=test
uSNChanged __ComObject System._ComObject
nTSecur\t'y'Descriptc-r __ComObject System._ ComObject
name String Domain Users
objectGUID Byte[] E6 6A DB DC AE BA 59 40 8C 2080 F3 C5F5 356D
UbjEEiSid Byte[] 0105000000000005 15000000F59093 82 13 30 9F 67...
sAMAccountName String Domain Users
SAMACCDUntTyDE Int32 268435456
grnupType Int32 -21474836496
objactCategory' String CN=Group, CN=Schema, CN=Configuration,DC=domca,DC=m...
isCriﬁcaISysbemObject Boolean True

[@¥]dscarePropagationData  DateTime 4/24/2019 7:09:39 PM
4/24/2019 5:14:44 PM

1/1/1601 12:04:17 AM

Close

4. Click OK to save any changes. Click Cancel to discard any changes and close the properties

dialog.
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Adding members to a user-defined group

1. Select auser-defined group from the groups list. User-defined groups are highlighted in green

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.

3. Click the Members tab. If the selected group has mailboxes or other groups, they appearin

the List of Members list box.

. Demo Group Properties PER
General " Memhber Of " Members H Advanced ]
List of members:
Alias Display Mame e-mail address
% ninatanaka Nina Tanaka ninatanaka @de. ..
Add Remove
ool

4. Click Add. The Select Mailbox dialog appears.

W Archive Manager for Exchange

Select mailbox

Type in the name or select from list:

B

Display name
ﬂ Domain Admins

Alias

Domain Admins

email address

i Domain Users Domain Users
ion ion Mana...
o Administrator G dmini
il Help Desk Help Desk
ﬂ C li I t G li Manag...
ﬂ Security Administrator Security Administr...
istrator inistr.,
f:’l Mina Tanaka ninatanaka ninatanaka @democompany.com
[ David Webb davidwebb davidwebb @democompany.com v
£ >
Selected objects: E3
[ Help Desk
(2 Dawid Webb

5. Select one or more groups or mailboxes. You can hold down the Ctrl or Shift keys to select

multiple mailboxes and groups.
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Click to add the selected groups or mailboxes to the Selected objects list box. Conversely,
you can select groups or mailboxes from the Selected objects list box and click to remove
the selected groups or mailboxes from the Selected objects list box.

Click OK to add the selected members to the group or click Cancel to discard the changes.

Removing members from a user-defined group

1

Select a user-defined group from the groups list. User-defined groups are highlighted in green

Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.

Click the Members tab. If the selected group has mailboxes or other groups, they appearin
the List of Members list box.

Select one or more members to remove. You can hold down the Ctrl or Shift keys to select
multiple members.

Click Remove. A confirmation dialog appears.

Click Yes in the confirmation dialog to remove the member. Click No to retain the member.

Managing Mailboxes

The Address Book Manager provides all the necessary tools to manage Microsoft Exchange on-
premise and online mailboxes that are imported into the Address Book Manager.

In

this topic:

Managing the Mailboxes list view

Managing Mailbox Tasks

Managing Mailbox Properties

Managing Mailbox Permissions

Managing the Mailboxes list view

The servers list view displays the on-premise and online servers that are imported into the
Address Book Manager.

NOTE: In the mailboxes list there are mailboxes with names like public <name-of-
Microsoft-Exchange-server>. These mailboxes are the public folder from the respective
Microsoft Exchange server because Address Book Manager considers a public folders as a
profile. These mailboxes are always highlighted in blue B, so you can distinguish them
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faster. Some features accessible for mailboxes are not applicable for these folders.
Mailboxes which are deactivated are highlighted in light blue

Steps to view the servers list

1

Open Address Book Manager by clicking the toolbar icon Wor clicking Address Book Manager

from the Tools menu.

Click the Mailboxes tab. The mailbox list view appears with a default set of columns. You can
add or remove these columns.

T Address book Manager
Refresh

Setup

Address book and settings

Display name
() Administrator
f:’; Aman Ali

() David Webb
() Devika Sharma
[:’1 Ishna Mohan
(3 Juan Christie
() Karl Jordan
f:’; Miki Portman
() Nina Tanaka
() Pablo Neruda
=

2

() Tim Ashford

-“ SyTChromZation,
= SETVETS

v:'_ LT OUPE

& Mailboxes

<

Alias

4 A 4 drri
1 1

amanali amanali

Aoridebb davidwehh
devikasharma devikasharma
ishnamohan ishnamohan
juanchristie juanchristie
karljordan karljordan

nikiportman nikipartman
ninatanaka ninatanaka
pabloneruda pabloneruda
timashford timashford

email address

=
Q

domadmin@democorp. com
amanali@democorp.com
davidwebb@democorp.com
devikasharma @democarp.com
ishnamohan @democorp. com
juanchristie @democorp. com
karljordan@democorp.com
nikipor tman@democorp. com
ninatanaka @democorp. com
pabloneruda @demacorp. com

EEEXEEEEEEEX

z

timashford @democorp.com

/o -

Maiboxes: 1- 130f 13

The columns are as follows:

a. RDN - Distinguished name of the recipient.

b. Display Name - Display name of the recipient.

c. Alias - Alias of the recipient.

d. Email Address - Email address of the recipient.

e. Home Server - Name of the Microsoft Exchange server that contains the mailbox.

f. GUID - Unique identifier of this mailbox in the Microsoft Exchange server.

g. LDAP Path - Active Directory specification of the mailbox recipient.

h. Logon Name - Username used to access the mailbox

i. Deleted - Yes indicates the mailbox is deleted. No indicates the mailbox is active.

j. Creation Date - the date when the mailbox was imported into Address Book Manager.

k. Deleted Date - the date when a mailbox update fails to find the Active Directory object

specified by the LDAP path, and the mailbox is marked as deleted by the system.
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. Modification Date - the most recent date when the mailbox was modified.

m. Mailbox DN - Distinguished name of the mailbox.

n. Mailbox Limit - Maximum number of emails that the mailbox can receive.

0. Locked - Most recent date when the mailbox was locked.

p. Activated - Most recent date when the mailbox was activated.

g. Mailbox Type - Indicates the type of the mailbox. Possible values are Normal or Journal.

r. MBXID - a unique serial number allocated to each mailbox in Address Book Manager.

s. Legal Hold - Yes indicates there is a litigation hold on the mailbox, and modifications to
archived emails are not permitted. No indicates there is no litigation hold.

t. Addresses - Collection of email aliases of the recipient.

Steps to add or remove mailbox list columns

1. Right-click to open the context menu and click Add/Remove columns...

Add/Remove columns %

Available columns:

Logon name
Deleted
Creation date
Deleted date
Modification date
Mailbox DM
Mailbax limit
Locked
Activated
Mailbox type
MBXID

Legal hold
Addresses

Selected columns:

Display name

Alias

email address

Home server Lp

oK | | Cancel

2. To add acolumn to the display:

a. Select the column from the Available columns list box.

b. Click Add to move the column to the Selected columns list box.

¢. Use the Up and Down buttons to position the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.

d. Click OK to close the dialog box and view the revised set of columns in the list view.

3. Toremove a column from the list view:

a. Select the column from the Selected columns list box.

b. Click Remove to move the column to the Available columns list box.

c. Click OKto close the dialog box and view the revised set of columns in the list view.
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Steps to refresh the list view

1.

Right-click to open the context menu and select Refresh List.

Managing Mailbox Tasks

The Mailboxes section of the Address Book Manager provides a set of tasks to import, activate,
deactivate, migrate, remove, synchronize and update mailboxes. Each of these tasks are
described below.

Importing mailboxes

1.

Right-click inside the list view and from the context menu point to Tasks and select Import
mailbox wizard... to initiate the import process.

' Address book Manager

Setup  Refresh
Address book and settings
- Display name email address Home server
¢ Synchromezation
= SEIVEDS
] IsHONpE;
- | Tasks vl Impert mailbox wizard
Add/Remove columns Activate mailboxes
Refresh list Deactivate mailboxes
Properties Migrate mailbox
Permissions Purge mailboxes
Synchronize mailbox folder permissions
Update mailboxes
£ >
// Page: of 1 Mailboxes: 1-130f 13 K < > A

For detailed steps about importing on-premise servers see Steps to import mailboxes from
on-premise Microsoft Exchange servers.

For detailed steps about importing online servers see Steps to import mailboxes from online
Microsoft Exchange servers.

Activating a mailbox

1.

Select a mailbox from the mailboxes list view that was previously deactivated and appear
highlighted in light blue

Right-click to open the context menu. Point to Tasks to open the sub-menu and select Activate
mailbox.

The mailbox is activated, and it is no longer highlighted.
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Deactivating a mailbox

1.

2.

3.

Select a mailbox from the mailboxes list view that is not highlighted in any color.

Right-click to open the context menu. Point to Tasks to open the sub-menu and select
Deactivate mailbox.

The mailbox is deactivated and appears in the list view with a different icon and is highlighted
inlight blue

NOTE: Deactivated mailboxes cannot be archived or restored.

Migrating a mailbox

1

2.

Select a mailbox from the mailboxes list view.

Right-click to open the context menu. Point to Tasks to open the sub-menu and select Migrate
mailbox.

Search Mailboxes EFR
Search Mailboxes %
Look for Name:
| | Search
Mailbox Count: 2

Display Name Email Address
Karl Jordan karljordan@domca.meta. test

timashford @domca. meta. test

< >

_

Click Search to return the list of all mailboxes that are not in Address Book Manager but are
available in the Microsoft Exchange servers. To reduce the list of mailboxes, you can specify a
search term in the Look for Name search box. Only the initial letters of the mailbox Display
Name can be specified, and wildcards are not supported. The search term is case-insensitive.

Select the target mailbox from the result set.

Click Select. A confirmation dialog appears.

. Click Yes to continue. The source mailbox will be merged with the target mailbox and

removed from Address Book Manager. The target mailbox will be imported into Address Book
Manager, and all the archived emails that belonged to the source mailbox will now belong to
the imported mailbox. You can click No to cancel the migration.
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Removing a mailbox
1. Select a mailbox from the mailboxes list view.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Purge
mailbox.

3. The mailbox is removed from the Address Book Manager.

1 | NOTE: You cannot remove a mailbox if it contains at least one email that has been archived.
Mailboxes that are highlighted in blue M cannot be removed..

Synchronizing mailbox permissions
1. Select a mailbox from the mailboxes list view.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select
Synchronize mailbox folder permissions.

3. The mailbox folders will be synchronized, and a confirmation dialog appears that indicates the
number of folders that were successfully synchronized and the number of folders that could
not be synchronized.

1 | NOTE: Mailboxes that are highlighted in blue M cannot be synchronized.

Updating a mailbox
1. Select aserver from the serverlist view.

2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Update
mailbox.

3. When the selected mailbox is updated successfully, a confirmation message is displayed.

Managing Mailbox Properties

The properties of each mailbox added to the Address Book Manager can be managed through the
Properties dialog box. They are grouped by tabs and each property group is explained in detail
below.

General properties
1. Select a mailbox from the mailboxes list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears and the Generaltab is displayed by default.
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& Niki Portman [8] Properties PER

General | Member Of | Other | Advanced

L—J ManlboX properiess

RDN: |nikiportman

Display name: |Niki Portman

|
|
Alizs: |nikiportman |
|

E-mail: |nikiporh'nan@:democorp.com

Home server: AMXEXCH -
Addresses: |nikiporh'nan@democorp.com; |
Mailbox DM: |fn=Demn Caorporation fou=Exchange Adminish'at|
GUID: |EFC?D?CE57AA8644A9583AD 14F 178DEB |

Mailbox is activated
[ Mailbox is on legal hold

_L-g Do Ly e

Normal ~

B -

3. The properties in this section are as follows:

a.
b.

C.

k.

RDN - Distinguished name of the recipient.
Display Name - Display name of the recipient.

Alias - Alias of the recipient.

. Email Address - Email address of the recipient.

Home Server - Name of the Microsoft Exchange server that contains the mailbox. You can
click the dropdown and select another Exchange Server as the Home Server. For example,
if the user's mailbox is migrated from an on-premise Exchange server to an Exchange
Online server, you can change the Home Server to the Exchange Online server only if the
server was imported into the Address Book Manager. When you change the Home Server,
you must synchronize the Address Book Manager. For more information see Synchronizing
Address Book Manager.

Addresses - Collection of email aliases of the recipient.
Mailbox DN - Distinguished name of the mailbox.
GUID - Unique identifier of this mailbox in the Microsoft Exchange server.

Mailbox is activated - When checked the mailbox is fully operation. Uncheck this checkbox
to deactivate the mailbox. The mailbox can also be deactivated by selecting Deactivate
mailbox from the mailbox context menu Tasks.

Mailbox is on legal hold - When checked, the mailbox is on litigation hold and
modifications to archived emails are not permitted. When unchecked, the mailbox is not
on legal hold.

Mailbox type - The type of mailbox. Valid values are Normal and Journal.

4. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.
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Member Of
1. Select a mailbox from the mailboxes list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.

3. Click the Member Of tab. A list of groups appears in the Member of list box.

& David Webb [19] Properties PER

General | Member Of | Other || Advanced

Member of:

Alias Display Name e-mail address

aDnmain Users Domain Users

B = Bl

4. Toview the properties of a group, right click on a selected group and click Properties. The
Properties dialog of the group appears.

5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Other properties
1. Select a mailbox from the mailboxes list.

2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.

3. Click the Others tab.
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& Niki Portman [8] Properties PER

General | Member Of | Other || Advanced

gﬁ ATTOME LGCTPOSTESS

Lock this mailbox

sy

2] Dates’
Creation date: 7/17/2020 8:34 AM
Modification date: 7/17/2020 8:34 AM

Mailbox is deleted

Deleted date: 7/28/2020 4:00 PM

ﬁ ManiboxChmt

Mailbox size: OME

Limit defined on mailbox level:  not defined
Limit defined on store level: 2411520 kB

B
4. The properties in this section are as follows:

a. Lock this mailbox - When checked, the mailbox is set to read-only and the mailbox cannot
not be updated or synchronized.

b. Creation date - the date when the mailbox was imported into Address Book Manager.
c. Modification date - the most recent date when the mailbox was modified

d. Mailbox is deleted - if the checkbox is checked, the mailbox is marked as deleted. When
you click Apply or OK, the Deleted Date field will indicate the current date and the mailbox
is indicated with the (& icon. A mailbox can also be marked as deleted by the system when
a mailbox update cannot find the Active Directory object specified by the LDAP path but
emails in the mailbox were previously archived. When a mailbox update cannot find the
Active Directory object specified by the LDAP path and there were no emails that were
archived for this mailbox, the mailbox will be permanently deleted from the Address
Book.

e. Deleted date - the date when the system marks the mailbox as deleted.

f. Mailbox size - size of the mailbox including all its folders as defined in the Microsoft
Exchange server.

g. Limit defined on mailbox level - the limit (in KB) set on the mailbox in the Microsoft
Exchange server.

h. Limit defined on store level - the storage limit (in KB) set on the mailbox in the Microsoft
Exchange server. The Limit defined on mailbox level has a higher priority.

5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Advanced properties

1. Select a mailbox from the mailboxes list.
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2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.

3. Click the Advanced tab.

& David Webb [19] Properties PFER

General "Memherof "Other "Advanced ]

Show object properties

Container:
(CN=David Webb,CN=Users,DC=domca,DC=meta, DC=test

Update now

B —
Getmalbox and archive statistics
Luﬂ Vo e
Show mailbox permissions

IK—‘ Concel ol

4. The properties in this section are as follows:

a. Show object properties - Click the Show button to display more information about the
mailbox from the Microsoft Exchange server

"+ Active Directory object property view e e
CN=David Webb,CN=Users,DC=domca,DC=meta,DC=test
Property Type Values ~
ob]ev:U:Iass String top
person
organizationalPerson
user
[2B]en String David Webb
E"an String Webb
givenNamE Siring David
disﬁnguishedName String CM=David Webb,CN=Users,DC=domca,DC=meta,DC=test
[@8]instanceType Int32 4
whenCreated DateTime 4{24/2019 &:06: 14 FM
whenChanged DateTime 7/18/2019 10:53:24 AM
disp\ayName String David Webb
uSNCreabed __ ComObject System.__ComObject
uSNChanged __ ComObject System.__ComObject
pruxynddrassas Siring SMTP:davidwebb @democompany.com
nTSecuriWDescriptor _ ComObject System._ ComObject
garbageCcIIPErlod Int32 1209600
name String David Webb
objectGUID Byte[] 43C9B655B816AC741B0 16 JEDID3 AB ICFS
usarAccountCant'cI Int32 512
[#8 badPwdCount Int32 0
codePage Int3z2 i} v
< >
-

b. Container - displays the distinguished name of the LDAP container. Click Update now to
update the mailbox properties immediately.

c. Get mailbox and archive statistics - Click Stats to open the Mailbox statistics window where
you can check the number of archived or deleted messages in the mailbox folders
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% Archive Manager for Exchange - Mailbox statistics

Mailbox statistics

Folder Messages Deleted messages

Q Number of folders: 2 7 o
2 Inbox 5 i}
20 Sent Ttems 2 0

_ CIDSE

d. Show mailbox permissions - Click Permissions to manage the mailbox permission rights.
The same settings are accessible also from Tools > Mailbox Rights Manager. For detailed
information see the section Mailbox Rights Manager.

5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Managing Mailbox Permissions

For detailed information about managing permissions for a mailbox, see Mailbox Rights Manager.

Options

AMAC preferences set through Options and Settings apply if no specific archive settings are
selected. There are many preferences which you can configure to your needs. They include, for
instance, compressing of emails and their attachments, setting up the default retention category
depending on e.g. legal requirements, activating direct archiving, managing roles for different
users etc. Settings having been specified under Tools > Options and Tools > Settings are used as
the default for manual as well as automated archiving.

Tools/Options

Run Archive Manager for Exchange (click Start/Programs/Quest/Archive Manager for Exchange).
In the Archive Manager for Exchange click on the Tools menu, and then click on Options to open
the Options window. Here, on different tabs you can set your AMAC preferences.

Server settings

Server Role tab

Archive Manager for Exchange offers high scalability and supports various LAN solutions. Besides
the simplest solution with one Archive Manager server, more complex configurations are
possible. For example, you can deploy the following servers at the same location. For co-located
servers, Location ID =1 for all servers.
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e One archive server (server assigned Archive server role. Only one Archive server per location is
allowed)

e One or more retrieve servers (servers assigned the Retrieve serverrole)

e One or more PST import servers

For large organizations with offices around the globe, Archive Manager for Exchange offers the
possibility to configure several locations. Each location can be distinguished by a LocationID, and
you can deploy several servers at the same location. For more information about locations, see
the Locations tab topic.

The server role must be assigned to each server on the Server Role tab from the Server role
downdrop box.

Options

Server Role  Auditing

Server role
Select the server role:

Cl Server settings

Archive Server ~

Eg AT Y ESELLTYE Selecting the server role defines which tasks can be performed on the given
server, For example a retrieve server wil never run scheduled tasks or
address book synchronization. It is important to note that two archive

. el Es servers are not allowed in the same location.

7

Acply

Recommendation

e When more than 1000 mailboxes are being archived, we recommend dedicating a separate
computer as a Retrieve server besides the primary Archive server.

e Maximum 3000 mailboxes can be archived with one Archive server. For more mailboxes itis
necessary to install another Archive server with a new location identifier.

Auditing tab

If the Auditing feature is installed, you must activate it from this tab.

To activate auditing:

1. On the Tools menu, click Options.
2. Inthe Options window, click Server settings and then click the Auditing tab.

3. Select Activate Auditing.
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4. Inthe Server Name enter the name of the computer where the Auditing feature is installed
and specify the Server Port (the default port is 7783).

5. Click Apply.

1 | NOTE: For more information about Auditing see the Archive Manager for Exchange
Auditing Guide.

Options

Server Role

Auditing
Auditing Settings

Server settings
I:J Activate Auditing

Server Name:

[amxsERVER \
Server Port:

[77ss \

;',_\ ArcinyESeLlings

| | Ugesrulas

Please set connection parameters of your auditing server. If you are not sure
what setting to use check the values you have set on the auditing server.
It may take 5 minutes to reflect changes in all applications.

Agply

Archive settings

Compression tab

Specify your compression criteria. Compressing is then done "on the fly".

To specify compression criteria:

1. On the Tools menu, click Options.

2. Inthe Options window, click on the Archive settings tab.
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Options
Compression | Retention  Shortcut Links  Adwanced
Compression

W Serversethings Compress \M5G file Exduded extensions:

% [ [ ]
a Archive settings Compress attachments

Wildcards (* and ?) are supported.
C] Uzap ful=s

Sopty

3. Select Compress .MSG to compress .MSG files
4. Select Compress attachments to compress attachments.

5. To exclude some types of attachments from compression (such as .zip files etc.), you can enter
the file extension in the Excluded extensions text box and click Add to enter the file type in
the list box. The attachments wit the listed file types will not be compressed.

1 | NOTE: When specifying Excluded extensions you can use the following wild card *
which stands for any number of characters and ? stands for any single character

o

Click Apply to save your settings.

Retention tab

For legal reasons some emails must remain retrievable for many years. Our email archiving
solution uses the Hierarchical Storage Management system (HSM). HSM offers the possibility to
organize documents in a logical way, e.g. some documents must be stored for alonger period
than the others. In the HSM system define different retention categories for each type of
document (for example, one retention category for short-term documents and other retention
category for long-term documents).

From this tab, you can choose the retention category that must be used as the default for
archiving items if no specific retention category is chosen. It usually applies for manual archiving
using Archive Manager Outlook Addin.

However, every group or user can have its own default retention category assigned. This can be
configured from the Manager view > Settings > Retention assighment tab. See Retention
assignment for more details.

i | NOTE: If you are running Archive Manager for Exchange for the first time, only one
retention category is available for 3 months. It is the default retention category created by
the setup. Otherwise you can choose from all retention categories that you create in the
Retention tab of the Manager view.
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You can archive email items under different retention categories through jobs by assigning a
retention category in each job. See Creating a job for more information. You can also choose the
retention category for an individual item when it is archived manually.

Options

Shorteut Links  Advanced

Retention

Defaulk retention category

. OEIYERSELLITITE: Select the retention category which will be applied if no
spedfic retention category is selected. This applies for
example for manual archiving from Outlock addin.

g Archive settings
Default retention category:

. jgap rulazg 3months ~

4

Acply

Shortcut tab

This tab lets you configure the display of archived emails in the Outlook preview pane. The layout
and the type of shortcut are defined through templates. The template specified on this tab will
be used in cases when no other shortcut template settings apply.

1 | NOTE: Shortcut templates can be created under Manager view > Settings > Shortcut
templates. Then they can be assigned to different users or groups under Manager view >
Settings > Shortcut template assignment.

In the Default shortcut template dropdown box select a shortcut template from the available
ones. Then click Apply.

Default shortcut template can be set also under Manager view > Settings > Shortcut template
assignment. If the default shortcut template is changed there it is changed also on this tab and
vice-versa.
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Options
Shortcut | Links  Advanced
Default shortcut template

Select the shortcut template which will be applied if no
spedific shortcut template is selected. This applies for
example for manual archiving from Outlook addin.

!_ SEryetisethings:

& Archive settings

Default shortcut template:

!_ Uzzrrolas |Deﬁlult ~
\
~
) /
N N
% k
sopt

Links tab

If you plan to use attachment links in shortcuts (either Create links for attachments or Generate
an HTML shortcut from template option from the previous tab) you must configure the link
generator server on this tab.

In the Alias for attachment link URL enter the alias of your Archive Manager Archive server - the
link generator server name. The ALIAS of your Archive Manager server can be accessed both from
inside and outside the LAN.

1 | NOTE: We recommend creating an ALIAS (DNS alias) for the Archive Manager Archive
server. It will serve as a virtual name and changing the physical name of the Archive server
will not affect the attachment links.

If the https channel will be used, check the use SSL checkbox.

After modifying these settings click Apply. Then click Yes to restart the relevant service.

€% Options

Options

Shortcut  Links  Advanced

Aktachment: link.
BN Serversettings Alias for attachment link URL:
[avnsERVER

a Archive settings [ use s5L

L | Userrulas

Apely
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Advanced tab

This tab offers additional archive settings:

Activate archiving of unread messages - clear the checkbox if you do not want to archive unread
emails.

Activate archiving of pending appointments and tasks - clear the checkbox if you do not want to
archive unfinished appointments and/or tasks.

Mark restored messages as Read - select the checkbox if you want to mark restored emails as
Read.

Options

Links  Advanced

Advanced settings

B Servensettings
Activate archiving of unread messages

Activate archiving of pending appointments and tasks

EE Archive settings
[[] Mark restored messages as Read

| | Ugesrulzs

4

Anply

User Roles

As default, only the super-user, which was specified during the Archive Manager for Exchange
installation, has log on permissions to Archive Manager for Exchange. On this tab you can add
other users which will be allowed to log on to the Archive Manager for Exchange server.

To add a new on-premise Exchange user:

1. Click the Add User icon or right-click inside the User Roles tab and select Add from the context
menu. To add an Exchange Online user, click the Add Exchange Online usericon.

2. Inthe Search Active Directory pop-up dialog click Find. Locate the userin the list and click
Select.
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"> Search Active Directory

Search Active Directory ™%
Look for name: | | Find
Base container: |LDAP:HDC=democor|:|,DC=mrn | Change
Object type: |Users | Change
Search result:

Name Name Path "
! domadmin Administrator LDAP: /fCN=domadmin,CN=Users,DC =democorp,DC=,
€ Guest Guest LDAP: f{CN=Guest,CN=Users,DC=democorp,DC =com

€7 DefaultAccount  DefaultAccount LDAP: /fCN =DefaultAccount, CM =Users,DC =democorp,
ﬁ krbtgt krbtgt LDAP: f{CN =krbtgt,CN=Users, DC=democorp,DC =com

ﬂ Exchange Onli... Exchange Online-... LDAP://CN=Exchange Online-ApplicationAccount,CM=.
ﬁ Aman Al Aman Ali LDAP: /{CN=Aman Ali,CN=Users,DC=democorp,DC=co
€7 David Webb David Webb LDAP: /fCN=David Webb,CN=Users,DC =democorp,DC.
€7 Devika Sharma  Devika Sharma LDAP: /fCN=Devika Sharma,CN=Users, DC=democorp,.
ﬁ Ishna Mohan Ishna Mohan LDAP: f{CN =Ishna Mohan,CN=Users, DC=democorp,D.
ﬂ Juan Christie Juan Christie LDAP: {{CN=]uan Christie, CN=Users, DC=democorp,D. .,
£ >

—e————

3. The user will be displayed on the User Roles tab.

To grant log on permissions to a user:

1. Selectthe user.

Options

UserRoles

Adrministrative Roles

-_ Servensethings t t t

Allow Deny

8 DEMOCORP\domadmin Logon
Logon to PST Importer
Modify roles

Access mailbox browser

;',a nrchvesethngs

Q User roles

HEEEREA
ooood

Modify mailbox permissions

2. Select the checkbox under the Allow column to grant the following permissions, or select the
checkbox under the Deny column to deny the following permissions:

a. Logon - user will be able to logon to the Archive Manager for Exchange and manage Archive
Manager

b. Logon to PST Importer—user will be able to launch PST Importer
¢. Modify roles —user will be able to manage user roles on this tab

d. Access mailbox browser—user will have access to archiving/restoring, i.e. the user will be
able to enter the Archive view
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e. Modify mailbox permission —user will be able to modify permissions in Mailbox Rights
Manager.

i ‘ NOTE: If neither Allow nor Deny is checked, the role is denied.

Settings

In addition to AMAC preferences specified under the Tools/Options as described above there are
more AMAC preferences available under Tools/Settings. AMAC preferences apply if no specific
archive settings are selected.

Run Archive Manager for Exchange (click Start/Programs/Quest/Archive Manager for Exchange).
In the Archive Manager for Exchange window click on the Tools menu, and then click on Settings
to open the Settings window.

Archive/Restore tab

Choose to re-archive delayed or backup shortcuts

£3 Application settings

Settings

Archive/Restore  Visualization  Others

archive/Restore related

[} settings

[] Allow re-archiving of delayed shortouts
[ Allow re-archiving of backup shartcuts
Flease note that these options are only valid untl the

application is running and will be reset when the application is
restarted. This function is supported only with MAPT,

Anply

Usually, when archived with Archive Manager, emails are replaced with shortcuts on the
Microsoft Exchange Server. In some cases you may have decided to archive the emails and at the
same time not to create shortcuts for them or delay the shortcut creation (this is done via
retention categories, see the section Retention categories and their usage ). In such cases the
emails are copied to archive and remain unchanged also in Microsoft Exchange Server (no
shortcuts are created). In specific cases you may want to re-archive such items to save any
possible modifications made after archiving. must you wish to re-archive these items (possible
only manually), itis necessary to allow it:

Allow re-archiving of delayed shortcuts is checked —it will be possible to manually re-archive
emails which have been already archived via retention category with "Delay shortcut creation”

settings.

Quest® Archive Manager for Exchange Administration Guide

98

Tools, Options and Settings



Allow re-archiving of backup shortcuts is checked —it will be possible to manually re-archive
items which have been already archived via retention category with "Keep original email”
settings.

i | NOTE: Both above mentioned options are only valid while the Archive Manager for Exchange
is running. When the application is restarted, these options are reset. This function is
supported only with MAPI.

Visualization tab

If you select Auto in the Size units when displayed or Size units when set dropdown menus, then
the size of the files will be displayed correspondingly: in B, KB, orin MB.

£ Application settings

Settings
Visualization ~ Others
Visualization
I: Settings Size units when displayed:
Size units when set: Auto ~
b
W
Aoy
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Others tab

The following AMAC preferences can be managed from this tab:

€5 Application settings

Settings

Visualization  Others

chive/Restore

Special

[3 Settings

Service status refresh rate: 10 3 sec

Mailbox access timeout: 120

Expart/Impart

C5V column delimiter:
Paging
Activate paging

Ttems per page: 1000 =

4

Sl

Special

Service status refresh rate - The defaultis 10 seconds. This means that every 10 seconds the
status of the services will be checked and the list of services displayed in the Status view will be
refreshed.

Mailbox access timeout - The default is 120 seconds. Timeout value for all open mailboxes across
the application.

Export/Import

CSV column delimiter - The column delimiter can be set to a comma (,) or to a semicolon (;) for all
export or import processes. You must check your MS Office settings first, and then set it
accordingly.

Paging

Paging activates a faster response time when loading large sets of items in the Mailboxes,
Archives, Public Folders, Public Folders Archive lists and advanced search. You can set how many
items can be displayed on one page.

Activate paging - select this checkbox to activate paging. Clear the checkbox to deactivate paging.

Items per page - the number of items that are displayed in each set or page. The default value is
1000.
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Archive Manager for Exchange FEEFR

Session  View Tools  Help

HERRRaX DS P aan

Mailboxes "Archwe " PublicFolders " Public Folders Archive ]
Look for: Filter in
~ | =no filter= {Blanks)
B"@: Distribution ists ~ From Subject Received T Size Attachment
=-£2] Group Democorp
B ) Aman Ali [11] ﬁ David Webb Re: Sales Event 11/25/2019 6:04 PM 10.75 KB
) David Webb [10] ﬁ Aman Ali Re: Sales Event 11/25/2019 5:55 PM 10.67 KB
{2 Devia Sharma [13] w} MAM Administra...  Synchronizing Metalogix Templates 10/11/2019 3:07 PM 8.87 KB
) Calendar ﬁ Ishna Mohan Q2 Reports 1022013 12:25 AM 8.07KB
[#-{C3) Contacts ﬁ Domain Adminis...  Hello 10/1/2015 7:00 FM 8.17KB
{7 Conversation Act ﬁ Ishna Mohan Customer payment 10/1/2019 5:46 PM 8.27KB
{7 Deleted Items ﬁ Miki Portman Org Change Management 9/30/2019 5:56 PM 18.77KB
~{3) Drafts &l Karl Jordan Net Neutrality 9/27/2019 3:07PM 3.87KB
{3 ExternalContacts &l Aman Al American Mik Supplies 9/25/2019 2:25 AM 3.07KB
] ﬁ Aman Ali Re: Sales Event 9/25/2019 3:07 PM 8.17KB
{2 Journal i Ishna Mohan Social Enterprise 9/25/2019 2:25 &AM 8.27KB
A Junk Email @i Aman Al Re: Finandial Analysis /25/2019 3:07FM 3.17KB
{0 Notss & Ishna Mohan Re: Finandal Analysis 9/25/2013 2:25 AM 3.27KB
{7 Outbox
i) Sales Event
{7 Sent [tems
4 Tasks
-3 Yammer Root
[#-(2) Domain Administrator
[#-{2 Ishna Mohan [8]
({2 Juan Christie [7]
[#-{2 Karl Jordan [5)
({2, MAM Administrator [1
F#-{2 Niki Portman [5] ©
< ST T
| Set Filker | | Clear Filter | Page: 1) of 1 I Messages: 1-130of 13 I K < > A
———
@l Server Role: Archive Server Folder contents loaded FullAccess Archiver/Restorer

When paging is activated, the current page is displayed in the Page field at the bottom of the list.
The administrator can navigate the pages in one of two ways: by entering a specific page in the
Page field or by clicking the First, Prev (previous), Next or Last buttons to sequentially iterate
through the pages.

Consider the scenario where each mailbox has over 50,000 emails items. Listing all the emails at
once would require a significant amount of time. With paging activated, only a part of the list s
displayed with navigation aids at the bottom of the list. When the administrator navigates
through the pages, only a subset of the list is displayed and the time required to display the
subset is greatly reduced.

If the average set of email items per user is less that 1000, you can choose to deactivate this
feature. The navigation aids will not be displayed at the bottom of the list as shown below.
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Archive Manager for Exchange

Session  View Tools Help

FEaXDbhuoh B age

Mailboxes "Archwe " PublicFolders " Public Folders Archive ]
Look for: Filter in: Filt
| [=na fiter= “| ] (Blanks) |
B"@: Distribution ists ~ From Subject Received T Size Attachment
=-£2] Group Democorp
B Aman Al [11] @ David Webb Re: Sales Event 11/25/2019 6:04 PM 10.75 KB
David Webb [10] @ Aman Ali Re: Sales Event 11/25/2019 5:55 PM 10.67 KB
) Devika Sharma [13] @ MAM Administra...  Synchronizing Metalogix Templates 10/11/2018 3:07 PM 8.87 KB
) Calendar @ Ishna Mohan Q2 Reports 1022013 12:25 AM 8.07KB
[#-{C3) Contacts @ Domain Adminis...  Hello 10/1/2015 7:00 FM 8.17KB
{7 Conversation Act @ Ishna Mohan Customer payment 10/1/2019 5:46 PM 8.27KB
{7 Deleted Items @ Miki Portman Org Change Management 9/30/2019 5:56 PM 18.77KB
~{3) Drafts &l Karl Jordan Net Neutrality 9/27/2019 3:07PM 3.87KB
{3 ExternalContacts &l Aman Al American Mik Supplies 9/25/2019 2:25 AM 3.07KB
3 @ Aman Ali Re: Sales Event 9/25/2019 3:07 PM 8.17KB
{2 Journal i Ishna Mohan Social Enterprise 9/25/2019 2:25 &AM 8.27KB
A Junk Email @i Aman Al Re: Finandial Analysis /25/2019 3:07FM 3.17KB
{0 Notss & Ishna Mohan Re: Finandal Analysis 9/25/2013 2:25 AM 3.27KB
{7 Outbox
i) Sales Event
{7 Sent [tems
4 Tasks
-3 Yammer Root
[#-(2) Domain Administrator
[]---f_:!l Ishna Mohan [8]
[]---f_:!l Juan Christie [7]
[]---f_:!l Karl Jordan [6]
({2, MAM Administrator [1
[]---f_:!l Miki Portman [5] &
< ST T
| Set Filker | | Clear Filter | Messages: 1-130f 13
@l Server Role: Archive Server Folder contents loaded FullAccess Archiver/Restorer

Paging is activated by default and we recommend that you must keep paging activated.
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Manager view

Manager view is an important part of Archive Manager for Exchange. In this view you can define
the type of jobs used for automated archiving, set global parameters, or set automated email
archiving not only for groups but for individual users (mailboxes) as well. All such settings can be
specified on the following tabs: Groups, Settings, Public folders, Jobs, Retention and Locations.

Automated archiving is done via jobs. You must define the jobs (see Jobs tab ). With jobs,
archiving is done in the background with predefined settings. We will get to that later. Let us now
describe what the above-mentioned tabs are used for.

Groups tab

By clicking on the Groups tab a list of all synchronized groups will be displayed in the left pane.
When you only want to display some of the groups, use afilter, especially when the list of
synchronized groups is too long.

On the Groups tab you may set your own archiving criteria for each group. Double-click the group

to open its Properties window. Then, in the Properties window, set your criteria for archiving that
specific group on its General, Scheduler, Folders, Classes and Script tabs. (See the section Setting

criteria for group archiving.)

Let us first describe how to display only groups.

Setting group filter

On the Groups tab you may have alarge number of groups displayed. To display only the ones,
use filters while specifying multiple logical conditions.

To create a filter, follow these steps:

1. In Manager view on the Groups tab, click on the Set filter button. The Filter window opens.
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Archive Manager for Exchange

Session

Wiewe  Tools  Help
BXD®SE
Eroups Settings

Fublic Folders

Do Qe

Jobs

Retention

et filker ,\J | Clear filker |
|

GrouUp narne

Enew
2| 5EA Pilote

test

Doma\n Admins
Doma\n Users
Managed Availabi. ..

Alias

Domain Admins

Domain Users
Managed Avalabilit. ..

new
SEA Pilote
test

Property

2. Select any or none of the following: RDN, ALIAS, DISPLAYNAME, or EMAILADDRESS in the first
dropdown menu; then select any or none of the following: =, STARTSWITH, ENDSWITH, or
CONTAINS in the second dropdown menu; and then enter text in the text box next to the Add
button. Then click Add.

Filter
Filter definitio

Select user:

Select filter:

| Administrator

w | |<naw>

v

v

|| Add

RDM

EMAILADDRESS

Check Syntax SavE | Delete | | OF || Cancel |

EXAMPLE: If you select DISPLAYNAME in the first dropdown menu; CONTAINS in the second
dropdown menu; and if you enter ‘act’ in the third dropdown menu located next to the Add
button, then you have created the following filter: DISPLAYNAME CONTAINS ‘act’. With this
filter all groups with DISPLAYNAME containing ‘act’ will be displayed on the Groups tab.

Click Add button to display the filter in the text box below. Then click Check Syntax to verify
the syntax.

3. Click Save. For a new filter enter the name in the Name of the filter text box. Confirm by
clicking OK. A filtered list of groups will be displayed on the Groups tab. (i.e. groups whose
DISPLAYNAME contains ‘act’)

1 | NOTE: Instead of creating a filter you can use an existing filter. Click Set filter and select the
name in the Select user dropdown menu and the filter from the Select filter dropdown
menu. The selected filter will be displayed in the text box below. Confirm by clicking OKin
the Filter window.
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Removing group filter

On the Groups tab in Manager view you have an option to set a filter to display only groups
meeting the criteria.

Archive Manager for Exchange

Session Wiew  Tools  Help
FRB®XD B

Groups | Settings | Public Folders || Jobs

| Set filker || Clear filter:
]

Group name Alias
Dumain Admins Domain Admins
Epomain Users Domain Users

To remove a previously set filter, click Clear filter . The list of all synchronized groups will be
displayed again and the Set filter button turns black.

Setting criteria for group archiving

When deciding to archive a group, specify the criteria according to which emails of that group’s
members will be archived. You will do that through properties of the respective group.

So, first switch to Manager view, and then click on the Groups tab. In the left pane choose a
group, whose members’ emails you plan to archive.

There are three ways of opening the Properties window:
e Double-click the group to open its Properties window,

e Right-click the group and then, in the context menu, select Properties to open its Properties
window,

e Select the group and then click on the Properties icon on the toolbar to open its Properties
window.

In the displayed Properties window of the group you may set your criteria on the General,
Scheduler, Folders, Classes, and the Script tabs.

On the following figure you will see alist of groups displayed in the left pane. If you select a
group, its properties will be displayed in the right pane.
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Archive Manager for Exchange PERFR

Session  Miew  Tools  Help

FRREXDSS U2 Qe
Groups | Settings | Public Folders || Jobs Retention | Locations
| Set filker | | Clear filter |
Group name Alias Property Yalue
Domain Admins Domain Admins Scheduled in job Jobi
Domaln Users Domain Users Allow to archive members of thi.. Yes
Managed Availabi... Managed Availabilit...
new (ol Retention category 3 months
ER]<En Pilate SEA Pilate
Script active Mo
Archive files older than 10 Days
Archive files bigger than 10,24 KB
Include folders:
Exclude Folders:
Outhox
Deleted Thems
Supported message dasses:
TP Noke™®
IPM. Document™®
IPM. Post®
Excluded message classes:
G| B ™ ServerRole: Archive Senver Loaded Full&ccess Manager

] ‘ NOTE: The icons of groups activated for archiving are displayed in green.

General tab

On this tab you have an option to activate archiving for a group. Here you may specify a period
following which messages will be archived by using a pre-defined job. You can also specify a
limit-value for the files so that files exceeding that limit-value are archived.

To activate archiving for a group:

1. In Manager view click on the Groups tab. In the left pane double-click the group. The
Properties window opens.

2. Inthe Properties window, click on the General tab.

3. To activate archiving for this group, select the Allow to archive checkbox. In the Retention
category dropdown box you can select a retention category which will be used for the group
archiving. This retention category can be different from the one assigned to a job that will be
in charge of the group. (The relevant job is specified on the scheduler tab.) This allows you to
have several groups archived via the same job and at the same time each group being archived
with specific retention category. must you select the Use job settings option, the retention
category of the job will be used.

4. In the Archive files older than (days) text box you can enter a period following which
messages will be archived.

5. In the Archive files bigger than text box you can enter the size of the messages to be archived;
please do not forget to select the properitem from the dropdown list in order to specify their
size eitherin B, KB, or MB.

EXAMPLE: On the following figure we set archiving of messages older than 10 days and exceeding
0.01 MB.
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Properties PER

General || Scheduler ||Folders | Classes || Script

a Group Accounts-11254375660

Allow to archive members of this group

Retention category: <Use job settings> ~
Archive criteria
Archive files older than (days):
Archive fles bigger than: 0,01 MB e

e

6. Finish by clicking Apply and then OK.

Upon activating a group you must assign it a job that will do the archiving in the background (see
the section "Jobs tab”).

Scheduler tab

On this tab you must specify the job for archiving. Automated archiving is done via jobs. Jobs,
however, must be specified up-front on the Jobs tab. Therefore, if no jobs have been defined
yet, do so first (see "How to create ajob”).

Once jobs are defined on the Jobs tab, you may select one.

To assign a job to the group:

1. Inthe Selected job dropdown list select a job for archiving, for instance Job1.

i | NOTE: If no jobs are created, the dropdown list is empty.

Quest® Archive Manager for Exchange Administration Guide

) 107
Managerview



Properties PER

General || Scheduler ”Fulders "CIasses "Script ]

Select the job, which will archive this object:
Scheduled job

Selected job: Job1 b
<no job=

Schedule interval: Job

Scheduling starts at: 10.02.2021 20:00:00

Job status: Scheduled

 Emeae

2. When ajobis selected, the Scheduling starts at, the Schedule interval (in days), and Job status
are automatically filled in with the settings of the selected job.

EXAMPLE: In the following figure, Job1 has been selected. Groups scheduled for archiving

with this job will be archived every day at 8 PM starting on October 02, 2021. The status of that

jobis Scheduled, which means that the job is currently active.

i | NOTE: When the status of a job is Stopped, the job is put on hold and needs to be
"turned on” (Scheduled) to run at the predefined time. A job’s status (Stopped,
Scheduled) can be changed on the Jobs tab.

Properties PER

General || Scheduler ”Fulders "CIasses "Script ]

Select the job, which will archive this object:

Scheduled job

Selected job: |Jnh1

v]
Schedule interval:
Scheduling starts at:
Job status:

T

3. Click Apply and then OK.

1 | NOTE: If agroup is indicated by a green icon with an exclamation mark (!) it indicates
that this group is marked for archiving even though no job is assigned to it.
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Exclude tab

You may have activated and scheduled a group for automated archiving, yet you might want to
exclude some of the folders and their content from being archived or define folders to be
processed. That can be specified on the Folders tab in the Properties window of the respective
group. Use regular expressions to exclude custom folders based on folder name or path.

To exclude folders from automated archiving:

1. In Manager view click on the Groups tab. In the left pane double-click the group. The
Properties window opens.

2. Click on the Folders tab. Here you can either:

¢ include certain folders in automated archiving

Be aware that if some folder(s) are listed in Include folders section, NO OTHER folders will
be archived. All other folders will be automatically excluded from archiving. When adding

folders, wildcards can be used —see further.

or

o exclude certain folders from automated archiving

Itis possible to check folders in the list (Inbox, Outbox, Sent Items and Deleted Items) or

define custom folders. When defining custom folders, also wildcards can be used —see

further.

1 | NOTE: If you exclude a folder from automated archiving, then its subfolders will NOT
be archived either.

Properties

General | Scheduler || Folders

Classes

Script

FER

By default all maibox folders are processed. Here you can define folders
to be processed or excduded from processing. Use regular expressions
to exclude custom folders based on folder name or path.

Include folders

Exclude folders
[ 1nbox Outbox

I:‘ Sent [tems

Add

Deleted Items

Quthox
Deleted Items

Add

OK

H Cancel H

Apply

3. When adding folders eitherin Include or Exclude section, click on the Add button. In the

Folder window that opens, enter the folder name or path.
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1 | NOTE: Use a slash "/" as a path separator.

Folder

Enter Folder name:

|Inbox,|’prwate| |

Wildcards

Asterisk (*) has a specific function in the Include section. Three basic scenarios apply:

a) <folder>

If only folder is specified (e.g. Inbox, Export/marketing...), it will be archived, but its
subfolder will not be archived.

b) <folder>/*

If folderis followed by a slash with asterisk ,,/*" (e.g. Inbox/*, Export/marketing/*...), only
subfolders will be archived, NOT the given folder.

c) <folder>*

If folderis directly followed by the asterisk ,*" (e.g. Inbox*, Export/marketing*...), both folder
and it subfolders will be archived.

EXAMPLE: In the example on the figure below, the configuration is the following:
Include folders: Inbox*
Exclude folders: Inbox/private

This means that Inbox and all its subfolders will be archived, except the private subfolder.

Properties PER

General | Scheduler | Folders || Classes | Script

By default all mailbox folders are processed. Here you can define folders
to be processed or exduded from processing. Use regular expressions
to exdude custom folders based on folder name or path.

Include folders

Exdude folders
[ tnbox OQutbox [ ] Sent Items Deleted Items

Quthox Add
Deleted Items |—|

I

4. Click Apply and finish by clicking OK. The respective folders will be excluded from automated
archiving.
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You may of course review your decision. In that case deselect the respective check-box, or simply
select the respective folders in the Custom folders list-box and then click on the Remove button.
Do not forget to click Apply and OK.

Classes tab

On this tab you may specify which types of email items will be automatically archived/excluded
in mailboxes of a given group.

To retain default setting:
1. Select the option as described below:

Use default settings - select this option to retain default message classes settings. All other
classes will be deactivated.

Properties PER

General | Scheduler | Folders | Classes | Script

Use default settings

IPM.MNote Remove
IPM.Document
IPM.Post

Remaye

Add

- s

To select message classes:
1. Clearthe Use default settings checkbox.

2. There are three items selected by default for archiving: IPM.Note (email), IPM.Post (Note in
Outlook), IPM.Document (OLE-documents). Message classes specified in the Supported
message classes list box will be archived only if they are allowed to be archived at the global
level. For more information see Message Classes. To select additional classes, click on the
down arrow next to the Add button to open the dropdown menu.
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Properties FER

General "Schedu\er "Fulders HCIESSS HScript }

[[] use default settings
Supported message dasses

IPM.Document
IPM.Post

Mote: subdasses of the given message dass will be archived too

Exduded message dasses

Mote: subclasses of the given message dass will be exduded too

IPM.Mote F.EmoveE

~ Add

Remove

| v | [ add

 Emeaew

3. Select the item from the help-list or type in the message class you wish to include.

1 | NOTE: You can enter any message class on this tab. However, only those message
classes which are allowed to be archived on the global level will be actually archived.

For more information see Message Classes.

Properties PEER

General "Scheduler " Folders "CIasss "Script ]

[ use default settings
Supported message classes

IPM.Mote Remove
IPM.Document o
IPM.Post

[ [v] [ add
IPM.Mote H too
IPM.Post

IPM.Document

IPM.Fax

IPM.ﬁmtment e
IPM.Task

| | [_add

Mote: subdasses of the given message dass will be exduded too

T

4. Click Add. The item will be added to the list in the Supported message classes box.

5.

Click Apply and then OK.

Similarly, you can also define message classes that will be excluded from archiving.

NOTE: If you want to remove any of the message classes listed under in the Supported
message classes or Excluded message classes box, select them and then click Remove.
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Script tab

You might want to modify the script to define additional conditions you may have wanted to
apply to a group. This can be done on the Script tab of the respective group.

1 | NOTE: Forinstance, scriptis used when a particular feature of Archive Manager is deployed
(e.g. live email indexing feature which allows Keyword search of live/non-archived emails
in the ArchiveWeb interface).

To generate a script for the group:

1. In Manager view click on the Groups tab.

2. Selectthe group in the left pane. Right-click it and in the context menu select Properties.
3. Inthe Properties window click on the Script tab.

4. Click on the Generate button. Then in the Generate script window click Yes to generate a new
script.

5. The new script will be displayed in the text box, as shown below. You can modify it to your
needs. Click Check to verify the syntax. When you are done, click Apply and then OK to
confirm.

Properties PRER

General | Scheduler || Faolders | Classes | Script

| Generate || Clear |

import System; ~
import System.Convert;

import System.Collections;

import ExchangePAMScriptEngine;

class Script
1
public static function Main(MAILLIST : MailEw,
{
war i : int;
var m;
war msgclassarray : Arraylist;

msyclassarray = new Arravlhisti);

msgolassarray. Add{"ipm.note");

msgelassarray. Add{"ipn. document ") ;

nesgclassarray. Add ("ipm_ post");

SCRIPTENGINE.Debugllessage ( "Script =NAME:> st

for (i = 0; i < MATLLIST.Count; i++) v
< m >

_ | OK || Cancel || Apply |
»

1 | NOTE: When the script is modified, certain fields on the General and Classes tabs become
inaccessible, meaning that they cannot be modified. Click Clear to delete a generated
script. Then the fields on the General and Classes tabs will become accessible again.
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Activating group archiving

Automated archiving of emails via jobs is only possible for groups that activated for archiving. If a
job has been assigned to a group that has not been activated for archiving, the job will fail.

To activate a group for archiving:

1
2.
3.

In Manager view click on the Groups tab.
In the left pane double-click the group to open its Properties window.

In the Properties window on the General tab select the Allow to archive members of this
group checkbox.

Click Apply and then click OK. The group is now allowed to archive, and you are ready to assign
ajob that would do the archiving.

Deactivating group archiving

> 0w

In Manager view click on the Groups tab.
In the left pane double-click the group to open its Properties window.
Open the General tab and clear the Allow to archive members of this group checkbox.

Click OK. The group cannot be archived even if ajob is assigned to it.

Copying group settings

In the Manager view on the Groups tab there are two ways of copying a group’s settings:

Method |

1.

To copy a group's settings, select the group in the list in the left pane and then click Copy
settings (E2) on the toolbar.

Then select the target group and click on the activated Paste settings (&) icon next to the
Copy settings icon on the toolbar. Settings of the original group will be copied onto the target
group.
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Archive Manager for Exchange

Session Wiew  Tools  Help
FREEX DS DT Qe
il Settings || Public Folders | Jobs Retention | Locations
=
I - et filker | | Clear filter |
Group name Alias Property Yalue
Doma\n Admins Domain Admins scheduled in job <no job>
Doma\n Users Domain sers Allow ko archive members of this group Mo

Managed Availabi... Managed Availal

bilie. ..

Properties

Script active

Copy settings
Paste settings

Show rembers

Include folders:
Exclude Folders:

Method Il

1. To copy a group's settings, select the group in the left pane.

2. Right-clickit and then, in the context menu, select Copy settings.

Archive files older than
Archive files bigger than

Mo
10 Days

10KE

Outhao
Deleted Ttems

3. Then select the target group, right-click it and in the context menu select Paste settings. The

settings of the original group will be copied onto the target group.

Scheduling group archiving

The group which you want to be archived automatically has to be allowed to archive and a job
must be assigned to it (see the section "How to archive emails of a group via a job”). Without

activating it and having assigned a job to it, a group will not be allowed to archive automatically.

It can, however, be archived manually (see the chapter Archive view).

1 | NOTE: Groups allowed to archive are displayed green. Anicon of a group for which the

archiving option has been activated, yet with no job assigned to it, is displayed green with

an exclamation mark (!), to notify the administrator (see below).

Archive Manager for Exchange

5 B@e X

Session View  Tools  Help

OH o [ =]
el \m |

e

Include Folders:

Groups | Settings | Public Folders || Jobs Retention | Locations
Set filker | | Clear Filker |
Group name Alias Property Yalue
Dnmain Adrins Domain Adrins Scheduled in job <no job>
Dnmain Users Domain Users Allow to archive members of thi.. Yes
Managed Availabi... Managed Availabilit...
= = Retention category 3 months
54 Filote SEA Pilote
SEript active No
Archive files older than 10 Days
Archive files bigger than 10,24 KB
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Automating folder archiving

Let’s say you have set the automated archiving for a group, yet you want to exclude/include some
of the folders for automated archiving. To do so, follow these steps:

1.

2.

In Manager view click on the Groups tab.

In the left pane select the group and double-click it to open its Properties window.

In the Properties window, click on the General tab to make sure that the Allow to archive
checkbox is selected. Then click on the Scheduler tab to verify whether a job was assigned.
Then click on the Folders tab.

On this tab configure your settings in two sections:

Include folders —only the added folder will be archived. All its subfolders and other folders
will be excluded from automated archiving. To include subfolders, use asterisk:

<folder>* - Folder and all its subfolders will be archived
<folder>/* - Only subfolders will be archived.

Exclude folders —added folder nor its subfolders will be archived

1 | NOTE: Use aslash "/" as a path separator in both sections.

Click OK.

Propetties PER

General | Scheduler | Folders | Classes | Scripk

By default all mailbox folders are processed. Here you can define folders
to be processed ar excluded from processing. Use regular expressions
to exclude custom folders based on Folder name or path.

Include Folders

Exclude Folders
[ tnbax Cuthox [] sent Ttems Deleted Items

Inbox/private

- | QK H Cancel H Apply ‘

EXAMPLE: If you define for example the Inbox as an exclude folder, neither of its subfolders is
processed. Provided that you want to exclude Inbox but archive its subfolders, add the Inbox as:

Inbox/*. Click Apply and then OK. The respective folders will be excluded from automated
archiving.
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Displaying group members

To check group members:
1. In Manager view, click on the Groups tab.

2. Inthe left pane, right-click a group and, in its context menu, click Show members.

Archive Manager for Exchange PERRR

Session Wiew  Tools  Help
FRERREX 0SS Do ae

Groups | Settings | Public Folders | Jobs Retention || Locations

et filker | | Clear filker |
Group name Alias Property Value
Doma\n Admins Domain Admins Scheduled in job <no job>
Duma\n Users Domain Users Allow to archive members of this group Mo

Managed Availabi... Managed Availabilit, ..

SCHpk ackive Mo
ER)5EA Pilate Properties

test

Archive Files older than 10 Days
Archive Files bigger than 10KE
Include Folders:

Copy settings
Paste settings

Show members I
3. Alist of group members will be displayed.

Exclude Folders:

Settings tab

On the Settings tab in Manager view you may specify additional useful settings. We will describe
what the upper and lower limit values are used for, etc.

e Threshold settings

e Clients Permissions

e Retention assignment

e Shortcut templates

e Shortcut template assignment

e Message Classes

e Notification settings

Threshold settings

Onthistabitis possible to define mailboxes for which the Threshold job must run (see
"Threshold job”). The threshold functionality allows the administrator to control the size of the
mailboxes in the Microsoft Exchange Server and to prevent them from overflowing. (The limit
defined for a mailbox in MS Microsoft Exchange Server can be processed by Archive Manager as
well).
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The administrator can set the Lower and Upper limit. Upper and Lower values are percentages
from the total mailbox limit allocated to a mailbox/group on the MS Microsoft Exchange Server.
These two values are closely associated with Threshold job, which actually does the "cleaning up”
of the Microsoft Exchange message store. When the Upper value is reached for a specific
mailbox/group, then archiving via Threshold job can "free up” some space on the MS Microsoft
Exchange Server until the Lower value is reached for the respective mailbox/group.

Example: The mailbox has a limit of 100 MB (defined in MS Microsoft Exchange Server). The
administrator defines the threshold values 50/90. If the mailbox size reaches 90% of the limit (90
MB), the Threshold job will archive the mailbox until the size of the mailbox drops under 50% of
the limit (50 MB). The threshold job archives the oldest messages first (default settings). The
order of the messages can be modified using the scheduler service config key
("ThresholdSortBy”) in <installdir>\ Quest\MAMA4Exchange\ Services\ PamExSchedulerSv\
PamSchedulerSv.exe.config. The following values can be used:

e Order by last modification date (ascending, i.e. oldest first) [value ="0"]
e Order by received date (ascending) [value ="1"]

e Order by size (descending, i.e. biggest first) [value ="2"]

1 | NOTE: After config file modification services must be restarted.

Further, it is possible to exclude specific messages from threshold processing. The Threshold job
will archive the mailboxes but it will filter out specific messages based on your configuration.
Available filtering for Threshold job:

o Filtering by message size
e Filtering by age

e Filtering by folder

o Filtering by message class

This filtering can be also configured using the scheduler service config keys in <installdir>\
Quest\MAMA4Exchange\ Services\ PamExSchedulerSv\ PamSchedulerSv.exe.config. For more
information see the following table:

Filtering Config key Default value Description

By message size ThresholdMinimumSize 4 Minimum size
(in KB) of the
email which can
be included in
the threshold
processing. All
emails smaller
than the
defined size are
not archived.



By age ThresholdMinDate 0 If value >0,
messages which
are younger
than x days are
excluded from
processing.

By folder ThresholdExcludeFolders - Semicolon
separated list of
exclude folders
defined for
threshold job;
the syntax is the
same asin case
of group
exclude folders.

By message class ThresholdMessageClasses - Semicolon
separated list of
include
message classes
for the
threshold job.

The mailbox limit in Microsoft Exchange Server can be defined on two levels: on the mailbox
level and on the Information Store level. For Archive Manager the mailbox limit has a higher
priority than the Information Store limit. These limits are read from Microsoft Exchange Server
and can be checked in Address Book Manager (Tools > Address Book Manager > click the Mailbox
node > double-click the mailbox >in Properties window switch to the Others tab).

Adding a group/mailbox onto the Threshold tab

To add a group/mailbox to the Threshold tab:
1. In Manager view, click the Settings tab.
2. Click Threshold settings.

3. Right-click inside the right pane and then select Add group or Add mailbox from the context
menu.
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Archive Manager for Exchange PERRR

Session  View Teeols Help

FRRERX DeS Do e
Groups | Settings | Public Folders || Jobs Retention | Locations
q_\.\ Settings Marme Lirnit Lower Upper  Recursive

J@ Threshold settings
; @ Clients permissions
<4 Retention assignment Add rmailbox
3 Shortcut templates

Add group
4 Shortcut template assignment
i+ Message dasses K Remouve object
‘ Notification setti
E ouniEatan setings Properties

4. Inthe Select mailbox or group window enter the name of the group/mailbox in the text box or
select the group/mailbox from the list. Then click OK.

5. The respective group/mailbox will now appear on the Threshold tab.

As a next step you must set the mailbox size limit as well as Upper and Lower values to that
group/mailbox.

Setting the mailbox size limit

By setting size limitations for a group/mailbox you actually allocate space on the MS Microsoft
Exchange message store for the group/mailbox.

Upon adding a group/mailbox onto the Threshold settings tab you must specify their maximal
size limit, as well as Upper and Lower values. Whenever the Threshold job (see the section
"Threshold job”) starts running it looks for mailboxes and groups having been specified on the
Threshold settings tab, and starts archiving the content of those which have reached their Upper
value, and keeps archiving until the Lower value has been reached.

To set size limitations for a group or mailbox:
1. In Manager view, click the Settings tab
2. Click on the Threshold settings tab.

3. Right-click the group/mailbox in the list and then, in the context menu, select Properties. The
Properties window opens.

4. Inthe Properties window enter your specifications for Manually defined limit. This will be the
maximal space that every mailbox of the group (or the given mailbox) will occupy in the
Microsoft Exchange Server. must you want to use a value different from the limit defined in
Active Directory, check the Always use the manually set limit instead of the mailbox limit
checkbox. If this checkbox is not checked, the Active Directory limit will be used instead of the
here defined value.

Enter your specifications for Lower limit and Upper limit as well.

i | NOTE: Make use of the Find mailbox limit link to display the limit set in the Active
Directory for the selected mailbox.
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If you want those settings to be applied to any subgroup of a group, select the Apply the settings
recursively for group member checkbox. In that case your settings will be applied to its

subgroups.

In the Retention category dropdown box you can select the retention category to be used for
archiving. Otherwise the retention category of the Threshold job (see the section "Threshold

job”) will be used as default.

Click Apply and then OK.

" Threshold properties PFE® “" Threshold properties PFER
Threshald Threshold
1}].::}1'"4."4 PropeErtes: E— 1}1'4:}]";."4 PTOPETIIES: ey
Group Sales {Group)

The archiving of the mailbox is triggered when the mailbox size
reaches the upper limit and is finished when the mailbox size
drops under the lower limit.

Laower limit: 50 2 g
Upper limit: 90 2 g
[] Apply these settings recursively for group members

Retention category: <Use job settings > v

[ aways use the manually setlimit instead of the mailbox limit

MB v

Manually defined limit:

Aman Ali [2] (Mailbox)
The archiving of the mailbox is triggered when the mailbox size

reaches the upper limit and is finished when the mailbox size
drops under the lower limit.

Lawer limit: 50 2o
Upper limit: an 2o
Apply these settings recursively for group members

<Jse job settings > w

<Use job settings >

[E4d OT UiE Mma W I

Retention category:

[ always use the manually set limi

Manually defined limit:

Find mailbox limit

‘T‘ Conce Ay

‘T‘ Conce Ay

Group Properties window

Mailbox Properties window

5. Click OK and verify the settings in the Threshold tab.

Session  View Tools  Help

FEREXDasBe R

47 Retention assignment
Shortcut templates

Shortcut template assignment
Mezsage dasses

[ MNotification settings

Client Permissions

| Groups " Settings H Public Folders " Jobs " Retention " Locations
c_\‘ Settings Marne Lirit Lower Upper  Recursive
% Threshold settings 5 userooz [3] 100 MB 60 0
3 Clients permissions test 100 MB 50 E Mo

Global settings are applied automatically to every client computer where the Archive Manager
Outlook Addin and Archive Manager OWA Extension client applications are installed. Depending

on your company security and access control plans, you may want to modify the global settings to
grant or revoke additional rights for some mailboxes or groups.

The Clients permissions node in the Settings tab is used to set global client permissions as well as
group or user client permissions that override the global permissions.
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grant the global client permissions and setup individual permissions as needed.

In this topic:

e Configuring global client permissions

e Configuring group or user client permissions

To configure global client permissions:

1. In Manager view, click the Settings tab.

2. Click the Clients permissions in the left pane.

Archive Manager for Exchange

Session  View Tools Help

FRlReaxXDas e e

Clients permissions
<4 Retention assignment
4 Shortcut templates

4 Message dasses
i, Notification settings

hortcut template assignment

Groups " Settings " Public Folders "Jubs " Retention H Locations
. Settings Object Inherit... Recursive
Threshald settings @ [Global settings] on

1 | IMPORTANT: No client permissions are granted when either the Archive Manager Outlook
AddIn or Archive Manager OWA Extension clients are installed. The administrator must

3. Double-click the [Global settings] icon in the right-hand pane to open the Properties window.
For every option listed here, you can choose whether you want to allow or deny the
permission to use the feature.

% Clients permissions

User permissions

PFER

ﬁ-&lﬂ;&;;umb;m-_;

Global Settings

Apply these permissions for group members recursively

Use global settings and ignore inherited permissions

Allow Al Deny Al

Permissions

z
g
=
o
i
|
=

Deleting

Restoring

Fultext search

Archiving

Offline support

Diglog Download

Dizlog Create new version
Diglog Get versions

Version view

jooooooood

e

[
i tmmmmEREER

[ apply |

4. When you are finished, click Apply and then OK. Options that are allowed will be available to

all users.
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The table below describes what a user can do for each client option that is permitted:

Feature

Deleting

Restoring

Keyword search

Archiving

Offline support

Dialog Download

Dialog Create new
version

Dialog Get versions

Versions view

Dialog Get Keyword
results

Dialog Identifying
user

AddIn Options

Create version

Select retention

Description

User will be able to mark items in the archive for deletion. This means
that items marked for deletion will be deleted from the archive upon the
expiration of their retention period by using the Delete Files job, if
specified (see the section "Delete Files job”).

User will be able to restore items from the archive himself.

User will be able to conduct keyword search within the user's archived
items.

User will be able to archive items.

User will be able to work offline with archived items.

User will see a message box displayed when downloading.

User will see a message box displayed when creating a new version.
User will see a message box displayed when retrieving one of the
archived versions.

User will be able to view different versions of archived items.

User will see a message box displayed when getting keyword search
results.

User will see a message box displayed when identifying the user at the
beginning (when opening MS Outlook).

User will be able to set some options, such as whether to auto-
synchronize when Outlook starts or exits, and the format to save archived
messages.

User will be able to create versions.

User will be able to choose which retention category to use during
archiving.



To set up clients permissions for a group or user:
1. In Manager view, click the Settings tab.
2. Click Clients permissions in the left pane.

3. Right-click inside the right-hand pane and select select Add group or Add mailbox from the
context menu.

Archive Manager for Exchange

Session  View  Tools  Help
FRBRX DS R En

Groups I[Settmgs "PubllcFoIders "Jobs "Retentlon ][Locatlons

 Settings Object Inherit... Recursive
i Threshold settings
] g 0 Admiristrator [1] on

Clients permissions @ _
) Retention assignment [Global settings]

3 Shortcut templates Add mailbox
4 Shortcut template assignment

@ Message dasses |
g Notification settings < Remove object

Add group

Properties

4. Inthe Select group (or Select mailbox) window enter the name of group or mailbox in the
search box or select from the list. Then click[¥_Ito add the group or user ot the Selected
objects list. You can remove a selected group or user from the Selected objects list by clicking
[= ],

T Archive Manager for Exchange

3
Select Group @

Type in the name or select from list:
Display name Alias email address
8 Group Democorp group-democorp group-d p@d PuCone
8 Group Sales group-sales group-sales@democorp.com
% Group Accounts group: group: P.CO....
aGmupPrududs group-product: group-products@d pco—
< >

¥ x
Selected objects: =
@ Group Sales

_

5. Click OK. The groups or mailboxes in the Selected objects list will be added to the Clients
Permissions pane. Double-click any user or group to open its Properties window.

6. Configure the client permissions by selecting either the Allow or Deny checkboxes. These
settings will override the global settings for the group or user.

7. Configure the following settings as needed:

a. Apply these permissions for group members recursively - (available for groups only) select
this option to apply the client permissions to sub-groups.
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b. Use global settings and ignore inherited permissions - (available for user mailboxes only)
select this option to apply the global settings and ignore any client permissions set for this
user.

8. When you have finished, click Apply and then OK.

Retention assignment

Archive Manager for Exchange has a global default retention category that is used if no specific
retention category is chosen during archiving. The global default retention category is set in the
Tools > Options > Archive settings > Retention tab. For more information see Archive settings.

The Retention assignment setting gives you the opportunity to customize retention categories
for different groups or users. It is especially useful in case of Archive Manager Outlook Addin. For
each group or user you can specify the default retention category to use when archiving from
Outlook.

To set a default retention category for groups or users:

These steps describe how to override the global default retention category and set a specific
default retention category for a group or user mailbox:

1. In Manager view, click on the Settings tab.
2. Click Retention assignment in the left pane.

3. Right-click inside the right pane and select Add group or Add mailbox from the context menu.

Archive Manager for Exchange PEREERR

Session  View  Tools  Help

FRRaxX DhagEo e
Groups | Settings || Public Folders | Jobs Retention || Locations
‘-_K‘ Settings CObject Cateqo...  Recursive

L-IGQ Threshold settings
5 Clients permissions
L?) Retention assignment
i Shortcut templates | Add group ‘
Shortcut template assignment ¥ Rernove obje@

73 Message dasses
B} Motification settings Properties

Add mailbox

4. Inthe Select mailbox or group window enter the name of the mailbox or group name in the
text box or select from the list. The click OK.

5. The respective mailbox or group will be added onto the Retention tab. Right-click it and select
Properties from the context menu.

6. Inits Default retention window select the retention category in the dropdown box.

For group: You may want to assign that retention category to subgroups as well. In that case
select the Apply recursively for group members checkbox.
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Archive Manager for Exchange

Session  View Tools Help
FRRBXDes R e

Groups | Settings || Public Folders || Jobs Retention | Locations
., Settings Object

Cakego...

-1 Threshold settings (% Domain Lisers reene_ | % Default retention
-5 Clients permissions Add mailbox
i i Retention

) Retention assignment Add group

{23 Shortcut templates

{23 Shortcut template assignment
{{) Message dasses
[l Motification settings

Rernowve object

@-Dafﬂult FELE TG T -

The default retention category applies for a mailbox or & group iF
nao explicit retention category is selected either by the job or
ather source,

Properties

Selected retention category:
|keep shorteut For 3 years h W |

[ apply recursivel For group members

7. Click Apply, then OK.

1 | NOTE: The default retention category assigned to the mailbox has higher priority than the
default retention category assigned to the group.

Shortcut templates

When an email is archived, usually (depending on settings) a shortcut is left behind in the
Microsoft Exchange server. Administrator can configure shortcuts according to the company
needs and define how the shortcuts must be displayed in the user’s Outlook preview.

Shortcut layout and type is specified through shortcut templates. There can be various shortcut
templates defined for different users/groups. For instance, Mac users may need specific
shortcuts.

This node is reserved for shortcut template creation. Different types of templates can be created.
Itis possible to configure maximal shortcut size, the format of the message body and create
attachment links reachable from the preview pane of Outlook/OWA.

Shortcut templates created on this tab can then be assigned to groups or users on the Shortcut
template assignment node, e.i. the user/group’s archived emails will have the defined
configuration.

1 | NOTE: One of the shortcut templates can be selected as a global template in the Shortcut
tab from Tools/Options/Archive Settings. This template will then be used in cases when no
other template settings are applied. As default it is the Default template.

To create a new shortcut template select the Shortcut templates node. Then right-click inside the
main pane and from the context menu select Create new shortcut template.
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Archive Manager for Exchange FPFEEFR

Session  View Tools Help

FRREBXDRS B

Groups " Settings H Public Folders " Jobs " Retention " Locations
‘B Settings Mame Attachment link  Html shorbcut Herml termnplate REf Truncate
Jﬁa Threshold settings A Default fes o Wes Mo

.15 Clients permissions

%) Retention assignment
Shortcut templates | Create new shortcut ternplate %J
Shortcut template assignment ¥ Remove object

[ Message dasses
fud Motification settings Properties

Before specifying settings for shortcuts it is important to think over how the shortcut (archived
email) must look like. Consider your priorities and intentions as well as expectations of the users.
Forinstance, if it is vital to keep the shortcuts small, you will want to truncate the body text and
not to keep formatted body text. On the other hand, you may want users to be able to read the
emails in the preview pane (no body-text truncating) and also to access attachments from the
preview pane (e.g. Create links for attachments option) etc. - read further about possible
options.

B Shortcut customization properties L=l

General H Attachment Options ]

-

Mame: |DEfﬁu|t

OrECUC COSTOMZad troTT e

Create links for attachments
[] Generate an HTML shortout from template
Default
Keep formatted body text (RTF)
Truncate body text

5000 = | Bytes

,—.-J_A z.JJJLI_f-_:J'J CIENCOPLIoNS: L —

Open email in EML format

-

As default (i.e. when no settings are specified on this tab) the Archive Manager archiving
processes replace the email on MS Microsoft Exchange with the shortcut that includes the header
and the body of the archived email. Therefore, the Outlook Preview is able to display the
archived items while the Attachments field is left empty. The attachmentis included in the
message when the email is retrieved from the archive by double-click.

You can set the format of the shortcut as well. Check the Generate an HTML shortcut from
template checkbox to create shortcuts in HTML format. The HTML shortcut includes also links for
attachments, so there is no must activate Generate an HTML shortcut from template and Create
links for attachments at the same time.
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< Administrator@40dernoz.local userQo1 -
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user1 b g
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He was singing In passionate tones, gazing with his 5., 8/2672013 If there are prablems with how this messags is disalayed, dlick here ta view i a web
Deleted ltems "It's impossible,” replied another. "Will you bet? The .
i:”‘;Ema” userd01 ] Message ﬂ SampleSearches b html (1 KB)
uthox believe it, | have literally not a penny and don't knowe .., B/26/2013
RSS Feeds old prince died the Marshal went away, promising to <
Search Folders j i
user001 3 This message was archived
perishing, but could not stop, any more than the Russ...  $/26/2013 SampleSearches i Open emall
A yserQl satin an armchair in her dressing jacket and nightcap
(i (0 user001 !
Drafts aregimental but a Cossack horse. A judge of horses a... 812612013
Sent ltems and industrious artisans, return ko your work, your
21l to blame that my face has the misforcuns to
Deleted ltems user001 ? displesse you. However,"
Junk Ernail preoccupied that only in bed was he able to be by hi... 872672013 he added rising, "you know my name and where to find
Outhox “Hows do you do, cousin?” said Pierre, Vou don't we, but don't
forget that I do not regard either myself or you as
-
RSS Feeds user0g1 bv@ d arrine heen Ar A1l ad
Search Folders Princess Mary roused him from his abstraction by dra.. 82612013
allto blame that my face has the misfartune to £B, Some People Pane features are turned off because Windows D, D ~
PIEET O eh] -
Mail Calendar People Tasks <

ITEMS: 10 UNREAD: 6

ORLINE O

Fig. Default HTML shortcut in the Outlook preview pane

Choose your HTML shortcut template from the dropdown box under the Generate an HTML
shortcut from template. If you have not created any template yet, a Default template is available.
You can create your own templates to customize the HTML shortcuts design. For more
information see How to create a customized HTML shortcut template .

B2 Shortcut customization properties =3
General
E—;hy;s:u: SO ZHL DT S

Mame: | |

Create links for attachments

Generate an HTML shortcut from template

%

Keep formatted body bext (RTF)
When the message is archived, its header and body are kept in the MS Microsoft Exchange Server
as default, no matter what size they are. Only attachments are removed. To allocate a fixed size
for every archived email to save more space on the Microsoft Exchange Server, select the
Truncate body text checkbox. In the Bytes text field enter the MAXIMAL size of the shortcut left
on the MS Microsoft Exchange Server. The message body will be truncated, if itis bigger than the
specified size.

1 | NOTE: Remember that in the Preview pane of Qutlook user can see only the shortcut left
on the MS Microsoft Exchange Server and the Outlook Find feature can search also only in
this shortcut

If you check the Keep formatted body text (RTF) checkbox, the formatted text of shortcut will not
be altered.
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If the Keep formatted body text (RTF) is not checked, only the plain text message body will be

kept.

The settings under Entourage options apply for Entourage users as well as other email clients
(e.g. mobile clients). Check the Open email in EML format so that users will be able to open
archived emails from the preview pane.

Attachments

To make the attachment accessible from the Preview pane, check either the Create links for
attachments or Generate an HTML shortcut from template checkbox and configure links creating

on the Attachment Options tab as described further. The HTML link available in the Outlook/OWA
Preview will be created. It will bear the name of the attachment with an .html extension as

shown below.

NOTE: The Keep formatted body text (RTF) and the Truncate body text options are mutually
exclusive. So are Keep formatted body text (RTF) and Generate an HTML shortcut from
template. After changing settings on this tab, you may want to apply them not only to new
shortcuts which will be created from now on, but also to shortcuts which were created
previously. To do so, you have to run the Repair shortcut command on a group, mailbox or
folder where these new settings must apply to previously created shortcuts.
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& X
@
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ey Delete
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FOLDER WIEY
_ (’;, ;,‘ B2 v bowe tar 7 ¥ Mave +
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Respond Quick Steps ] Move
Search Current Mailbiox (Ctrl+E) yel Current Mailbox -
Al Unread By Date ~  Mewest
user001 '@
wihiich lie the ashies of your ancestars! | shall follow the.., Gf26/2013

user0l - Inbox - userd0 - Outlook

In reply to an inguiry about the convicks in the prison,

user0n1 b e
He was singing in passionate tones, gazing with his 5. 8/26/2013
“It's impossible,” replied another, Wil you bet? The

user0o !
believe it, | hawe literally not a penny and don't know ., 8/26/2013
old prince died the Marshal went away, promising to

user0p1 4
perishing, but could not stop, any more than the Russ... 842672013

sat in an armchair in her dressing jacket and nightcap

51 Unready Read | Search People

I Categorize - E= Address Book
> Follows Up
Tags Find
2 Reply [E2 Reply Al £ Forward
Mon B/26/2013 317 PM
user001
He was singing in
passionate tones, gazing
To  user0nl

OThis rressage veas sentwith High irportance,
We rernoved extra line breaks frorm this rmessage.

Message ﬂ0212‘d0c‘htm\[1 KE]

"It's impassible," replied another,

When clicked, the following info panel may be displayed. Click the link to download the
attachment from the Archive Manager server.
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o B ATTACHMENTTOOLS  userDD - Inbo - userDD1 - Outlnak 7 H - O X%
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If you plan to use attachment links in shortcuts you must configure the settings on the next tab
(Attachment Options tab).

B Shortcut customization properties =03

General || Attachment Options ]

[] Do not create attachment links for all embedded files
Create attachment links only for the following file types

#dd

Remove

Do not create attachment links only for the following file types

Remaove

e

The settings are as follows:

e Do not create attachment links for all embedded files - Links will not be created on the shortcut
forembedded files.

o Create attachment links only for the following file types: Click the Add button to add any file
types to display its link on the shortcut.

¢ Do not create attachment links only for the following file types: Click the Add button to exclude
file types from being displayed as links on the shortcut

NOTE: The Create links for attachments option must be selected in the General tab. You
can use only one of the two options: Create attachment links only for the following file
types or Do not create attachment links only for the following file types. If you use either
one, the other option will be deactivated.
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Message Classes

Session  View Tools  Help
FRRBEX DO Do s
Groups " Settings H Public Falders ”Jobs H Retention "Locations ]
‘\‘ Settings
Q Threshold settings Supported message dasses % f ‘ﬁ[ Exduded message dasses % Ve '@
Clients permissions Shortcut message dass Message dass
Retention assignment MESSBQE dass based on
3 Shortcut templates
@ shortcut template assignment
+-{13 Message dasses IPM.Contact
E Motification settings IPM. Appaintment
IPM.Fax
IPM.Document
IFM.Mote
IPM.Post
| Apply | | Unda |
W ™ ServerRole: Archive Server Loaded FullAccess Manager
Supported message classes
Microsoft Exchange stores emails and other objects in its database. We are referring to these
objects as items. Each item has its own message class, which defines the type of the item:
message, post, appointment, etc. Since the handling of these items is different, different
shortcuts are created for each item type. By default only some message classes are archived
(IPM.Note, IPM.Post, IPM.Document etc.). Additional item types to be archived can be defined
on this tab.
Message Class Description
IPM.Note message
IPM.Post message posted to a folder
IPM.Fax afax message
IPM.Document afile added to the folder (the base class never
appears, it always contains the file type, e.g.
IPM.Note.Document.Word.8)
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IPM.Appointment calendar item; a recurring calendar item

IPM.Task an Outlook task
IPM.Contact an Outlook contact
IPM.Activity an Outlook journal message
IPM.StickyNote an Outlook sticky note
REPORT.IPM.Schedule.Meeting.Request a meeting request

For a complete list of message classes, see http://msdn.microsoft.com/en-
us/library/aa204771.aspx

The following message classes and its subclasses are supported message classes by default, i.e.
they can be archived by Archive Manager for Exchange:

e |[PM.Note,

IPM.Post,

IPM.Document,

IPM.Fax

IPM.Appointment

IPM.Task

o |PM.Contact

1 | NOTE: Make sure they are not deactivated from the Deactivated message classes list, if you
want to archive them.

To add additional message classes that must be archived:
1. From the View menu click Manager.
2. Click the Settings tab and then click Message classes in the Settings pane.

3. Inthe Supported message classes list click = to open the Message classes window.
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Message classes -

Message classes

Select one or more message dasses from the list:

Message dass 2
IPM. Activity

IPM.Distlist

IPM.Note, IMC.Notification

IPM.MNote.Rules.Oof . Template. Microsoft

IPM. StickyNote
IPM.Recal.Report
IPM. Outlook.Recall
IPM.Remote
IPM.Report
IPM.Resend
IPM.Schedule.Meeting.Canceled ]
or specfy a different dass:
Shortcut message dass based on:
~
B

4. Select one or more message classes to archive or manually enter a message class in the text
box below the list.

5. Leave the Shortcut message class based on field blank or choose an option from the dropdown
list to define which type of shortcut will be created when the selected message class is
archived. Specifying a new shortcut message class can have uneffects. To get more
information about this option contact Quest Technical Support.

6. Click OK and verify tha the selected message classes are listed in the Supported message
classes list.

Archiving calendar items (IPM.Appointment), contact items (IPM.Contact) and task items
(IPM.Task) is supported with some limitations. When a shortcut is created from such an item, it
becomes read-only and prevents further modification of the item. It can only be modified
through the Archive Manager Outlook Addin. If these items change constantly, we recommend
archiving these items with the Keep the original email or Delay shortcut creation options
described in the Retention tab topic. Recurring appointments and tasks are not archived.

If you plan to archive appointments and tasks, you must deactivate archiving appointments or
tasks which are unfinished.

To deactivate unfinished appointments and tasks:

1. Open Tools > Options > Archive settings > Advanced tab

2. Select Deactivate not finished appointment and task archivation option.

Excluded message classes

Message classes listed here will not be archived.
i | NOTE: If a message class is present in the Supported message classes list as well as on the
Excluded message classes list, it will not be archived.
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To add message classes to the excluded message classes list:

1. From the View menu click Manager.
2. Click the Settings tab and then click Message classes in the Settings pane.

3. Inthe Excluded message classes list click = to open the Message classes window.

Message classes )
Select one or more message dasses from the list:
Message class &

{PM,Note

IPM.Post

IPM.Document

IPM.Fax

IPM. Appointment

IPM.Contact

IPM.Task

IPM. Activity

IPM.Distlist

IPM.Note, IMC. Notification
IPM.MNote.Rules. Oof Template. Microsoft
IPM, StickyMote

IPM.Recall.Report

1PM. Qutlook. Recall

IPM.Remote

IPM.Report v

or spedify a different dass:

| |
B

4. Select one or more message classes to archive or manually enter a message class in the text
box below the list.

5. Click OK and verify that the selected message classes are listed in the Excluded message
classes list.

Shortcut template assignment

When an email is archived, usually (depending on settings) a shortcut is left behind in the
Microsoft Exchange server. Administrator can configure shortcuts according to the company
needs and define how the shortcuts must be displayed in the user’s Outlook preview.

Shortcut layout and type is specified through shortcut templates. These templates are created
under Shortcut templates node (see the previous section).

Different users/groups can have different shortcut templates assigned on this tab.

1 | NOTE: Default shortcut template can be specified also on the Tools/Options/Archive
settings/Shortcut tab. If the default shortcut template is changed here it is changed also on
that tab and vice versa.

To assign a group/user specific shortcut template:

1. Right-click inside the main pain. From the context menu select Add group/Add mailbox.
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Archive Manager for Exchange PEREFR

Session  View Tools Help

FRREXDEGDs ve

GEroups HSettlngs "Publlc Folders }[Jobs "Retentlon "Locatlnns

.. Settings Object
J@ Threshold settings

@ Clients permissions

“ Retention assignment

3 Shortcut templates

3 Shortcut template assignment
-1 Message dasses

[ Motification settings

Add mailbox
Add group
7 PRernove objec

Properties

Shortcut name

Recursive

2. Inthe pop-up dialog select the group/userin the listview and click OK.

3. The group/user will be displayed in the listview with default settings specified. To adjust the
settings right-click the group/user and from the context menu select Properties.

Archive Manager for Exchange

158 Threshold settings
T Clients permissions Add mailbox
{3 Retention assignment Add group

3 Shortcut templates

Shortcut template assignment
Message dasses

-], Motification settings

75 PRernove ohject

Session  View  Tools  Help

D BXIDa® ._J 3 @l ] B Default shorbcut =3
Groups HSettings "Public Folders "Jobs HRetention "Location ] Sharkcut

‘N Settings Object Shaorbog

R ———

!iﬂul'&;hurtzu[ Eapulais

The default shortcut template applies for a mailbox or a group F
nio explicit shartcut template is selected either by the job or other
source.

Selected sharteout kemplate:

| Default v

Apply recursively For group members

‘T‘ Conce Ay

4. Inthe pop-up window select the template from the downdrop box. If applicable you can

check the Apply recursively for group members checkbox to apply it also for possible

subgroups. Then click Apply.

Notification settings

This feature has been designed to notify the users, preferably administrators, about
circumstances leading in some cases to critical situations. Depending on the type of confidence
level, alert messages (notification) will be sent to recipients added onto the Notification settings

tab.

You may specify which user will be sending notifications. Simply right-click the Notification
settings node in the left pane and in the context menu click Notification settings.
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Session  View  Tools  Help

FlEReX D Bean

Sharteut templates
Shartcut template assignment
{03 Message classes

4.y hotiFication settings

Sender Email

Add Notification Task

MNetification settings

Groups " Settings H Public Folders " Jobs " Retention " Locations
‘\‘ Settings Property Yalue
Q Threshold settings SMTP Server Address
i @ Clients petmissions SMTP Server Port 25
Retention assignment SMTP Server Use 551 Mo

In the Notification Settings window specify the SMTP server (Port and use of SSL as appropriate)
and the Sender (User and password are optional). When you are done, click Apply and then OK.
The sender you have specified will be sending alert notifications. These settings will be

displayed in the right pane.

i Notification settings

Settings
al-uh'ﬂ.hs'u GO SETLNG S’ R

Define a mailbox which will send the alert mails:

SMTP Server Address |AM>{5ERVER |

Port [ |
UsessL [
Sender |adm\n\sh’atnr@demncnrp.mm |
Username |adm\n\sh'amr |

Password |"----u"-- |

1(:«—‘ Concel eely

Once the sender is defined,
several notification tasks:

1. Right-click the Notification settings

follow the steps below to configure

node and select Add Notification Task.

2. Inthe Task Settings window define the Task name and Recipients e-mail. Several recipients

must be separated by semicolon (;).

Itis possible to Send test mail by cli

cking the link.
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Task Settings B

General "Scheduler "RepurtTypes }

Task name:
[Task-0838

Recipients:

|administrabor @democorp.com

Send test mail

3. Then click the Scheduler tab where sending notification can be scheduled.

Task Settings 3
General | Scheduler "ReportTypes }

e Time parameters for the task

Scheduling starts at: I%.03.2021 20:00:00 %

Schedule interval:

4. Onthe Reports Types tab specify the reports:

Task Settings

General | Scheduler || ReportTypes ]—

License Usage

]

Usage Statistics
Exdude deleted/deactivated user accounts
Archive Statistics

O statistics for the last haurs

®) statistics for the last EI days

Quest® Archive Manager for Exchange Administration Guide

) 137
Managerview



a) License Usage
The Report contains the licensed mailboxes, mailboxes in use and the maintenance
information. If the customer is over the license limit or the maintenance is expired, this
information will be displayed in red font in the email.

b) Usage Statistics
If you activate the checkbox Exclude deleted/deactivated user accounts then deactivated
user accounts will be excluded from the report.

c) Archive Statistics
For example:

a. The schedulerisset up to 8 PM, and the interval is one day. You intend to have a
statistic for the last 24 hours. So you will generate the statistic for the last 24 hours
beginning at 8 PM

b. The scheduleris setup up to 8 PM, and the interval is 4 hours. You intend to have a
statistic for the last 4 hours. So you will generate the statistic for the last 4 hours
(statistic between 4 PM until 8 PM). The next job runis at 12 PM. So you will generate
the statistic for the last 4 hours (statistic between 8 PM until 12 PM)

c. The scheduleris setup for 6 PM, and the interval is one week. You intend to have a
statistic for the last 7 days. So you will generate the statistic for the last 7 days by hours.
The next job runis at 6 PMone week later.

5. Individual tasks can be Deactivated, Deleted or Changed by right-clicking the task name under
the Notification settings node.

Archive Manager for Exchange FPFEER

Session  View Teeols Help
FRBR2RX DK Roes

Groups || Settings || PublicFolders | Jobs Retention || Locations

\\\ Settings Property Value
158 Threshald settings Task N Tack-0898
@ Clients permissions ask Name as
% Group level retention Recipients administrator @democorp. com
= Shortaut templates Status Activated
Shortecut template assignment
3| Message classes Scheduling starts 3/15/2021 8:00 PM
B Motification settings Schedule interval 1days

Change settings
O Deactivate

License Usage
€ Deletetask Usage Statistics (exdudes deleted or deactivated user accounts)
Archive Statistics for the last 5 days

@/ @ ™ Server Role: Archive Server Loaded FullAccess Manager
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Public folders tab

From the Public folders tab you can set your the criteria for automated archiving of emails in the
publicfolders. Public folders are archived in the same way as groups are archived.

1 | NOTE: For more information about archiving public folders manually, see Public Folders tab
in the Archive View chapter.

To display publicfolders, click on the Public folders tab in Manager view. Then expand the tree
structure in the left pane.

Archive Manager for Exchange

Session  View Tools Help
FRBEX DGO U2 Qe

Groups || Settings || PublicFolders || Jobs Retention | Locations

B--ﬁ_r pfmbx-democorp [AMXEXCH] Property Value
=) AccountsNews
| B3 Conference
: Vendors
i-{3) Company-MNews

Scheduled in job <no job>
Allow to archive this public folder Yes

@ Products-Mews Recursive Yes
i-{[3) Sales-News
Script active Mo
Archive files older than 10
Archive files bigger than 10.24 KB

Supported message classes:
IPM.Note™
IPM.Document™
IPM.Post™

1 | NOTE: The icons of public folders that are activated for archiving are displayed in green.
Public folders that are setup for archiving but don't have an associated job are are indicated
with a green icon with an exclamation mark. If sub-folders are included, the icon will also
display an arrow to indicate recursive selection.

Select any public folder to view the properties in the right-hand pane.

Setting criteria for archiving a public folder

When you have decided to archive the content of a public folder, you must specify the criteria
according to which emails of that folder will be archived. You may do that through the properties
of the folderin question.

There are two ways of setting the criteria for archiving a public folder:

e Right-click the folder and select Properties in the context menu to open the Properties
window, or

e Select the folder and then click the Properties icon on the toolbar. The Properties window for
the folder opens.
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General tab

Lets you You can also specify the period after which messages will be archived and a limit-value
for the files.

To activate archiving for a public folder:

1. Allow to archive this public folder - select this option to activate archiving for public folders.
This option must be activated to allow public folders to be archived with jobs.

2. Retention category - select a retention category which will be used for archiving the public
folder. It allows you to archive the public folder with a specific retention category. This
retention category can be different from the one assigned to a job that will be in charge of the
publicfolder. (The relevant job is specified on the scheduler tab.) must you select the Use job
settings option, the retention category of the job will be used.

3. Archive files older than (days) - enter a number, specifying after how many days you want
messages to be archived.

4. Archive files bigger than - specify the minimum size of the messages to be archived. You must
also select the size type from the dropdown list to qualify size eitherin B (Bytes), KB
(Kilobytes), or MB (Megabytes).

5. Apply these settings recursively - select thi option If you want the subfolders to be archived as
well, select thelf you want the subfolders to be archived as well.

EXAMPLE: On the figure below we want to archive all messages older than 10 days and
exceeding 100KB (also applied to subfolders). Further, the retention category of the job will
be used and all settings will be applied recursively to subgroups.

Properties PER

General | Scheduler | Classes | Script

—

:l Accounts-Mews/Conference Vendors

Allow to archive this public folder

Retention category: <Use job settings > ~
Archive criteria
Archive files older than {days):
Archive files bigger than: 0,01 MB w

Apply these settings recursively for subfolders

- | OK H Cancel H Apply ‘

6. Click Apply, the respective public folders are now activated for archiving. In the next step you
must specify a job that would be used for automated archiving. You will do that on the
Scheduler tab.
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1 | NOTE: If sub-folders are included, the green icon will also display an arrow to indicate

recursive selection. Public folders that are setup for archiving but don't have an
associated job are are indicated with a green icon with an exclamation mark.

Scheduler tab

Automated archiving is done via jobs that must be specified beforehand on the Archive Manager

for Exchange/Jobs tab. So if no jobs have been defined yet, do so first (See "How to create a

job”). Once jobs have been defined on the Jobs tab, you may select the relevant one.

To assign a job to the public folder:

1. Inthe Selected job dropdown list and select a job, for instance 9 pm archiving. As soon as you

select a job, the Schedule interval (in days), Scheduling starts at, as well as Job status text
boxes are automatically filled in with that job’s settings.

EXAMPLE: In the following figure we have selected a job called 9 pm archiving. Messages will

be archived daily at 21:00 as of October 23, 2021. The status of that job is Scheduled, which

means that the job has not been put on hold and will run at the specified time.

Properties PFE®
General || Scheduler | Classes | Script
Select the job, which will archive this object:
Scheduled job
Selected job: |g pm archiving " |
Schedule interval:
Scheduling starts at: 23.10,2021 21:00:00
Job skatus: Scheduled

- [s]4 H Cancel H Apply

2. Click Apply.

Classes tab

Here you can specify the types of email items contained in the respective public folder to be
archived/excluded from archiving by default.

To retain default setting:

1. Select the option as described below:
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Use default settings - select this option to retain default message classes settings. All other

classes will be deactivated.

To select message classes:

1. Clear the Use default settings checkbox.

2. Click the dropdown next to the Add button to open the dropdown menu. Select the item and
then click Add. Message classes archived by default are listed in the Message classes list box.
They include IPM.Note (email), IPM.Post (Note in Outlook), IPM.Document (OLE-documents).
You can remove any of them from that box and thus exclude them from archiving. Similarly,
you can add additional classes and have them archived. The respective item will be added to

the list in the Message classes list-box.

Properties PER
General | Scheduler | Classes | Script
[1 use default settings
Supparted message classes
IPM.Mote Remove

IPM.Documnent
IPM.Post

v

Mote: subclasses of the given message class will be archived too

B

Add

Apply

3. Click Apply to confirm.

Script tab

You may want to modify the script for a public folder, simply to define further conditions.

To display the first script, click Generate. It will be subsequently displayed in the text box below.

Now you may modify it to your needs. When you are done, click Apply and then OK to confirm.

Properties PER
General || Scheduler | Classes | Script
= e

import System;

import System.Convert;

import System.Collections:
import ExchangePAMScriptEngine;

class Seript

{
{

var i : int;
var m;
var msgelassarray : Arraylist;

public static function Main(MAILLIST : MailEw,

~
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Activating public folder archiving

To activate the archiving option for a public folder:

1
2.

In Manager view click on the Public folders tab.

In the left pane select the public folder, right-click it and then, in the context menu, click
Properties to open its Properties window.

In the Properties window on the General tab select the Allow to archive this public folder
checkbox.

Click Apply and then OK to confirm. The archiving option is now activated for the folder. Now
you are ready to assign a job that would do the archiving.

Propetrties Ll =

General || Scheduler | Classes | Script
E, Test public folderfSubfalder 01

Allow ta archive this public Folder

Retention category: | <Ise job settings = W |
Archive criteria
archive files older than {days):
archive files bigger than: ME v

Advanced criteria

[] apply these settings recursively For subfolders

T

Deactivating public folder archiving

Steps to deactivate the archiving option for a public folder:

1
2.

In Manager view click on the Public folders tab.

In the left pane select the publicfolder, right-click it and then, in the context menu, click
Properties.

In the Properties window, open the General tab and clear the Allow to archive this public
folder checkbox.

Click Apply and then OK to confirm. It is no longer possible to archive this publicfolder via job.
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Copying public folder settings

In Manager view, click on the Public folders tab.

To copy a public folder’s settings, choose one of the following
options:
Method |

1. To copy the settings of a publicfolder, select a folder in the left pane and then click on the
Copy settings icon on the toolbar.

2. Then select the target public folder to copy those settings onto and click the Paste settings
icon on the toolbar. Those settings will be copied onto the target folder.

Method Il

1. To copy the settings of a publicfolder, select a publicfolderin the left pane, right-click it and
then, in the context menu, click Copy settings.

2. Thenselect the target public folder to copy those settings onto. Right-click it and, in the
context menu, select Paste settings. Those settings will be copied onto the target folder.

Scheduling public folder archiving

Verify that the public folder has had the archiving option activated (see Activating public folder
archiving ). Folders activated for archiving are displayed in green. You can now schedule archiving
by assighing a job (see Creating ajob ).

Jobs tab

On this tab you can define jobs for automated archiving. Archiving with jobs is done in the
background —with predefined settings.

1 | NOTE: On the Jobs tab, at the bottom of the right pane, you must specify the backup time
which is the period during which jobs are not supposed to run in order to activate database
backup. Itis not possible to archive until itis set. Enter the time in the Backup start time
and Backup stop time fields and then click Update.

You may for instance schedule your database backup overnight.
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1 | NOTE: Do not schedule your jobs during the backup interval, as they are paused until the
backup period is over and no mails would be archived during that period. After that the job
is resumed

At first there may not be jobs defined, as seen below. You must create them.

Archive Manager for Exchange PFEREFR

Session View  Tools  Help
HERRRa X DK B En
Groups " Settings H Public Folders " Jabs " Retention "Locations
Existing jobs: Job settings:
Marne Skatus Mext Run Property Value
By Schedule &y  Stop Change. ..
— Backup time
Backup start time: Backup stop time:
[e3:00:00 :] [ezmmon 2 Update
| Jab reparting |
M ™ Server Role: Archive Server Folder contents loaded Fullfccess Manager

Creating a job

As mentioned previously, automated archiving is done via jobs which must be specified up front.

1 ‘ NOTE: Before creating new job, click the Refresh icon to update the Jobs tab.

To define a new job:
1. In Manager view click on the Jobs tab.

2. Right-click in the left pane and in the context menu select New job. You can also click on the
Create new job icon on the toolbar to define a job.
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Archive Manager for Exchange

Session Wiew  Tools  Help

FlmReXxDee Bz e

Groups "Settings "PublicFoIders "Jobs

"Retention ” Locations

Existing jobs: Job settings:
Marme Skakus Mexk Run Property Walue
|5 Newjob
@ Delete job
@  Schedule
Q Stop
@  Start now!
Change settings
Refresh list
83 Schedule Sa  Stop Change...
— [+/] Backup time
Backup start bime: Biackup stop time:
[23:00:00 5] o Update
| Job reparting ‘
ﬂ. ™ Server Role: Archive Server Falder contents [oaded Full&ccess Manager

In the Job Settings window that is displayed and select the type of job. Each job type is

explained in the following topics.

Job Settings

General "Retant\un "Scheduler "CUmDI’ESSiUI‘I ]

Job name:
|J0b1-n0rmal| |

Type

D ® normal
8 O Threshold
[ O Delete Files

53 O shorteut Sync

PR

Click the Retention tab. On this tab you must specify the retention category which defines the
retention time for the items archived via this job. By the means of these categories you can
adjust shortcut behavior and set various retention times for archived items. You can choose
from available categories or you can create your own categories on the Retention tab of

Manager view.
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Job Settings PR

General | Retention | Scheduler | Compression

@ Document retention options

Retention category : <Default= w

1: 3months

B ree

5. Click the Scheduler tab. On this tab you must specify the time when scheduling begins: in the
Scheduling starts at field enter the date (by clicking on the upward or downward arrows, or by
overwriting it) and time (directly by overwriting the time).

In the Schedule interval box you may specify a period following which the job restarts itself.
Click on the upward and downward arrows. The period may be set in minutes or days.

must you select the Allowed time [hours] box, then you may enter your archiving period
simply by clicking on the upward or downward arrows.

Job Settings PR

General | Retention || Scheduler | Compression
5 ’ Time parameters for the job

Scheduling starts at: 14.05,2018 20:00:00 =
[ scheduling ends on: Mever

schedule interval: 1 2
Allowed time [hours]: 3 2

[ ecmwTw

If you select the Scheduling ends on checkbox you may specify a time when the scheduling
ends. The period is set to Never by default, i.e. when the checkbox is not selected. Click on
the downward arrow to open the calendar where you can select the appropriate month (by
clicking on the left and right arrows) and time (by selecting the appropriate day).
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Job Settings

General "Retentiun "Scheduler "CUmprEssiUn }

8 Time parameters for the job
Scheduling starts at: 14.05.2018 20:00:00 o

Scheduling ends on: 15.05.2019 G-
. May 2019 3
schedule interval: 1 Sun Mon Tue Wed Thu Fri Sat

28 29 30 1 2 3 4
5 ] 7 8 9 1w N

Allawed time [hours]: 3 o3 s % 17 s
19 20 21 23 24 25

2% 27T 28 29 330 N 1

2 3 4 5 6 7 8

[ Today: 5/14/2018

==

6. Click the Compression tab. On this tab you may specify which of the files will be compressed,

simply by selecting the appropriate checkboxes: Compress .msg file, and Compress
attachments.
Compression-related settings having been defined under Tools/Options/Archive settings

relate to manual archiving only; they are not automatically used by jobs. Therefore,
compression-related settings must be specified individually for each job.

Job Settings PR
General "Ratention "Schedular "Compression

@ Compression settings for archived messages

Compress .msq file
Compress attachments

I

Normal job

A Normal job is used for archiving emails of a specific group. You can create multiple normal jobs
and assign each job to one or more groups.

To define a Normal job:

1.

In Manager view, click on the Jobs tab.
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2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.

3. Inthe Job Settings window that appears, select Normal on the General tab. Enter aname in
the Job name text box.

4. Then specify your scheduling criteria on the Scheduler tab.
5. Configure settings in the Retention and Compression tabs.
6. Finish by clicking OK.

1 | NOTE: To archive emails of a specific group, the job has to be assigned to that group
(see the following section How to archive emails of a group via a job).

Job Settings PR
General | Scheduler | Compression | Retention

Job niamme:
|Normal job 1

Type
D @ normal
u Threshold
8 O Delete Fies
53 Shortout Sync

- meeTe

Jobs that you create will be displayed in the left pane on the Jobs tab (in Manager view). Under
the Status field you may check their current status.

e Scheduled (displayed green) means that the job is scheduled and currently archiving emails or
in a stand-by mode until it restarts again;

e Stopped (displayed red) means that the job, although might be scheduled, is currently not
active.

In the right pane you will see the respective job’s settings displayed.

Change the status to Scheduled simply by clicking on the Schedule button or by right-clicking the
respective job and selecting Schedule in the context menu. You may stop an already scheduled
job by clicking on the Stop button or by right-clicking the respective job and selecting Stop in the
context menu.

At the bottom of the right pane you must specify the backup time, in other words the period
during which jobs are not supposed to run, in order to activate database backup. If it is not set, no
archiving is possible. Enter the time in the Backup start time and Backup stop time fields and then
press Update. You may for instance schedule your database backup over night. Pay attention to
this backup period, as no jobs must be running at that time.
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Archive Manager for Exchange PERRR

Session  View  Tools  Help

FRREXDELILUD g
Groups | Settings | Public Folders || Jobs Retention | Post Processing || Locations
Existing jobs: Job settings:
Marne Skabus Mext Run Property Value
aThershold job Stopped 14.05.2018 20:... Jab name Sharteut Sync
3 1Shorteut Sync - Jab type Shorteut Syne
Vb Scheduled 14.05.2018 20:... Skatus Stopped
BJobl Scheduled 14.05.2018 20:...
0 Mormal job 1 Stopped 14.05.2018 20:... Scheduling starts 14.05.2018 20:00:00
Scheduling end Mewver
Schedule inkerval 1 davys
Maximum allowed time not defined
st ] [ _5os
+| Backup time
Backup start: time: Backup stop time:
[zz:00:00 s oo = Update
| Job reporting
[ 5] ™ Server Role: Archive Server Folder contents loaded Fulldccess Manager

1 | NOTE: Jobs which are running at the moment are highlighted in green in the Existing jobs
pane of the Jobs tab.

Threshold job

Companies usually define within their IT department rules regarding storage space mailboxes or
groups may occupy on the MS Microsoft Exchange server, to avoid mail server overloading. The
Threshold job is used specifically for that purpose.

By defining the maximal size of a mailbox on the Threshold tab (see the section "Threshold tab”)
you may actually specify space having been reserved for it on the MS Microsoft Exchange server.
Other specifications (Upper and Lower values) are defined there as well.

When the Threshold job starts running, all mailboxes listed on the Threshold tab whose size has
reached their respective Upper value will be archived until their respective Lower value has been
reached (for each mailbox there can be assigned different threshold values). This way you can
easily arrange enough space on your MS Microsoft Exchange server, so that CPU efficiency is
preserved at a desirable level.

Example: The mailbox has a limit of 100 MB (defined in MS Microsoft Exchange Server). The
administrator defines the threshold values 50/90. If the mailbox size reaches 90% of the limit (90
MB), the Threshold job will archive the mailbox until the size of the mailbox drops under 50% of
the limit (50 MB). The threshold job archives the oldest messages first (default settings). The
order of the messages can be modified using the scheduler service config keys (ThresholdSortBy)
in <installdir>\ Quest\MAMA4Exchange\ Services\ PamExSchedulerSv\
PamSchedulerSv.exe.config. The following values can be used:

e Order by last modification date (ascending, i.e. oldest first) [0]
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e Order by received date (ascending) [1]

e Order by size (descending, i.e. biggest first) [2]

1 | NOTE: After config file modification the services must be restarted.

Further, it is possible to exclude specific messages from threshold processing. The Threshold job
will archive the mailboxes but it will filter out specific messages based on your configuration.
Available filtering for Threshold job:

Filtering by age

Filtering by folder

Filtering by message size

o Filtering by message class

This filtering can be also configured using the scheduler service config keys in <installdir>\
Quest\MAMA4Exchange\ Services\ PamExSchedulerSv\ PamSchedulerSv.exe.config. For more
information see the following table:

Filtering

By message size

By age

By folder

Config key

ThresholdMinimumSize

ThresholdMinDate

ThresholdExcludeFolders

Value/default

Description

Minimum size
(in KB) of the
email which can
be includedin
the threshold
processing. All
emails smaller
than the
defined size are
not archived.

If value >0,
messages which
are younger
than x days are
excluded from
processing.

Semicolon
separated list of
exclude folders
defined for the
threshold job.
The syntax is
the same asin



case of group
exclude folders.

By message class ThresholdMessageClasses - Semicolon
separated list of
include
message classes
for the
threshold job.

The Threshold job runs in the background with pre-defined settings. Archived emails are
replaced with a shortcut and the space is released for further usage.

To define a Threshold job:

1. In Manager view, click on the Jobs tab.

2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.

3. Inthe Job Settings window that appears, select Threshold on the General tab. Enter a name in
the Job name text box. Then specify your scheduling criteria on the Scheduler tab and other
settings on the remaining tabs.

Job Settings PR

General | Retention || Scheduler || Compression

Job name:
|Thereshold job|

Type
BV O narmal
T @ Threshold
8 O Delete Files

53 O shorteut Sync

- EcEmRETe

i ‘ NOTE: There can be only one Threshold job defined..
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Delete Files job

The purpose of the Delete Files job is to purge the following items from the archive:
e |tems marked for deletion upon expiration of their Retention + Keep alive time

e |tems whose Delete time (the maximum time that the items can reside in the archive), if such
was defined, has elapsed.

There can be only one Delete Files job defined. As with other scheduled jobs, the Delete Files
job runs in the background with predefined settings.

This job permanently deletes files from the archive.

TIP: Undelete feature of Archive Manager for Exchange allows users to list archived items
that are marked for deletion in Outlook folder. If the Undelete feature is implemented,
user can perform Undelete operation on such items marked for deletion. After the
undelete operation the item(s) will have the same status as regular archived items. Upon
expiration of their retention time they will still reside in the archive.

To define a Delete Files job:
1. In Manager view, click on the Jobs tab.

2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.

3. Inthe Job Settings window that appears, select Delete Files on the General tab.

4. Enteraname in the Job name text box.
Job Settings PR
General || Scheduler | Mailboxes | PublicFolders

Job name:
|De|ete old files ‘

Type
O O normal
8 O Threshold
a (® Delete Files

&a () shortout Sync

B (e

5. Click the Scheduler tab and set the scheduler properties as described below:
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. Scheduling starts at - enter the date manually or by clicking the upward or downward

arrows, and time (directly by overwriting the time).

. Scheduling ends on - select this option to specify a date when the scheduling ends. Click

the date pickericon to open the calendar and select the month and date. The default is
Never when the option is not selected.

Schedule interval - specify a period following which the job restarts itself. Click the upward
or downward arrow. The period can be set in minutes or days.

. Allowed time [hours] - enter the archiving period by clicking the upward or downward

arrow. The minimum allowed time is 1 hour.

6. Click the Mailboxes tab and select the mailboxes as described below:

a.

b.

C.

Include all mailboxes - select this option to include all mailboxes for the Delete Files job.
When this option is selected the List of Members and the Add and Remove buttons are
deactivated.

To add members:
i. Click Add. The Select Mailbox dialog appears.

ii. Select one or more groups or mailboxes. You can hold down the Ctrl or Shift keys to
select multiple mailboxes and groups.

iii. Click[ ¥ Jto add the selected groups or mailboxes to the Selected objects list box.
Conversely, you can select groups or mailboxes from the Selected objects list box and
click L2 Jto remove the selected groups or mailboxes from the Selected objects list box.

iv. Click OK to add the selected members to the group or click Cancel to discard the
changes.

To remove members:

i. Select one or more members to remove. You can hold down the Ctrl or Shift keys to
select multiple members.

ii. Click Remove. A confirmation dialog appears.

iii. Click Yes in the confirmation dialog to remove the member. Click No to retain the
member.

2. Click the Public Folders tab and select the public folders as described below:

a.

Include all Public Folder mailboxes - select this option to include all Public Folder
mailboxes for the Delete Files job. When this option is selected the List of Members and
the Add and Remove buttons are deactivated.

To add Public Folders:
v. Click Add. The Select Mailbox dialog appears.

vi. Select one or more Public Folder mailboxes. You can hold down the Ctrl or Shift keys to
select multiple mailboxes.



vii.Click to add the selected Public Folder(s) to the Selected objects list box.
Conversely, you can select Public Folder(s) from the Selected objects list box and click
to remove the Public Folder(s) from the Selected objects list box.

viii.Click OK to add the selected Public Folder mailboxes or click Cancel to discard the
changes.

c. Toremove Public Folders:

iv. Select one or more Public Folder(s) to remove. You can hold down the Ctrl or Shift keys
to select multiple folders.

v. Click Remove. A confirmation dialog appears.

vi. Click Yes in the confirmation dialog to remove the folder(s). Click No to retain the
folder(s).

3. Click OK to save the job setting and close the window.

Shortcut Sync job

The Shortcut Sync job keeps the shortcut information in the Archive Manager database consistent
with the shortcuts in the Microsoft Exchange Server. The Shortcut Sync job searches through
synchronized mailboxes for shortcuts to items that are archived in the HSM store. Archived items
in the HSM store without shortcuts in the Microsoft Exchange server are marked for deletion or
purged if their retention time has expired. The retention category used for archiving these items
must be configured to allow the Shortcut Sync job to operate.

To define a Shortcut Sync job:
1. From the Manager view, click the Jobs tab.

2. Right-click inside the left pane. Select New job from the context menu. The Job Settings
window opens.

3. From the General tab select Shortcut Sync. Enter a name in the Job name text box.
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Job Settings PR
General [Scheduler ][Options "Mailboxm "PublicFolders]

Job name:
|Shortcut Sync Job |

Type
EJ () Mormal
8 O Threshold
Q () Delete Files

5} (® shortout Sync

B

4. Click the Scheduler tab and set the scheduler properties as described below:

a. Scheduling starts at - enter the date manually or by clicking the upward or downward
arrows, and time (directly by overwriting the time).

b. Scheduling ends on - select this option to specify a date when the scheduling ends. Click
the date pickericon to open the calendar and select the month and date. The default is
Never when the option is not selected.

¢. Schedule interval - specify a period following which the job restarts itself. Click the upward
or downward arrow. The period can be set in minutes or days.

d. Allowed time [hours] - enter the archiving period by clicking the upward or downward
arrow. The minimum allowed time is 1 hour.

5. Click the Options tab and select the options as described below:

Job Settings P e
General ][S-:heduler ]Options [Mailboxes " PublicFoIders]

Actions

[ synchronization

[ promaote delayed shartouts

[ recover documents with shortcuts

[] pelete shortcuts for removed documents
[ pelete expired shortouts

[ pelete archived items without shortcuts

-
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. Synchronization - select this option to perform a standard shortcut synchronization of
mailboxes or public folders. If mail items are moved to another mailbox or location, then
duplicate mail items are archived.

1 | NOTE: Standard shortcut synchronization is included in all the other options even if
this option is not selected.

. Promote delayed shortcuts - select this option to create a normal shortcut for email items
that are bound to a retention category configured to delay shortcut creation for a specified
period. If the Shortcut Sync job discovers email items for which the shortcut creation delay
period has expired, a normal shortcut will be created for the archived email item.

Recover documents with shortcuts - select this option to recover documents marked for
deletion. If the Shortcut Syncjob discovers a shortcut which has an archived document
marked for deletion, then the document is recovered.

. Delete shortcuts for removed documents - select this option to allow the Shortcut Sync job
to delete shortcuts from the Microsoft Exchange Server when the job discovers archived
documents that are purged by the Delete Files job.

A user could have decided to delete a shortcut to an archived item from Microsoft Outlook
if itis no loner required or could have moved the shortcut from one folder to another. If
the user clicks the Delete archived messages icon on the toolbar or Delete selected
messages from the Archive Manager for Exchange menu of the Archive Manager Outlook
AddIn, then such items are marked for deletion in the HSM store. These items are keptin
the HSM store during their retention period. When the retention period and keep-alive
time expires for items marked for deletion, they can be purged by a scheduled Delete Files
job. If the job is not scheduled, emails remain in the archive.

If the user selects archived items and clicks the Delete icon on the Outlook toolbar or clicks
SHIFT + Delete on the keyboard then the corresponding shortcut is deleted since these are
Microsoft Outlook commands and not Archive Manager Outlook AddIin commands.
Shortcuts that are deleted with Microsoft Outlook commands will lose their reference to
the corresponding archived item in the HSM store and will not be marked for deletion in
the Archive Manager database. These are considered as lost items.

Any lost item can be restored by the administrator during its retention period until you run
the Shortcut Sync job. When the job runs, all lost items are marked for deletion. They
cannot be restored from the Archive tab in the Archive Manager for Exchange
Administration Center. Use this job when you are sure that no more lost items must be
restored and that the space they occupy could eventually be released for use when the
retention period expires. Even though items marked for deletion cannot be easily restored
they can still be discovered during their retention period using the advanced search
because they are retained in the HSM store. To find the documents marked for deletion,
use the Advanced Search icon on the toolbar ( 4 ) or the Archive Manager Outlook AddIn
in Outlook. In the Archive Manager Advanced Search window, the items that are marked
for deletion will be displayed with a blue icon.



+  Advanced archive search PERFR

Messages | Settings
Find items that match these criteria:

AndfOr  Field Operator Value
+ X O Subject ~ ‘ |Cnntains ~ ‘ |Divisinn

= Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size  Retention Version GUID
Karl Jordan [7] davidwebb... Divisionof ... Inbox 9/11/2020 2:33 AM 11.79KB 3 1 AC4D
B  Ishna Mohan [5] davidwebb... Divisionof ... Inbox 9/11/2020 2:33 AM 8.79KB 3 1 47FX
B4 David webb [3] devikashar... Divisionof ... Inbox 9/11/2020 2:33 aM 6.34KB 3 1 548D
BA  1shna Mohan [5] devikashar... Divisionof ... Inbox 9/11/2020 2:33 AM 9.17KB 3 1 9B2F
< >
Page: | 1| of 1 Messages: 1-4o0f4 4 L4 » A

Clear |

| Search |

e. Delete expired shortcuts - select this option to delete shortcuts for email items that are
bound to a retention category configured to delete a shortcut after a specified time. If the
Shortcut Syncjob discovers shortcuts with expired time, then the shortcut is removed from
the Microsoft Exchange server.

f. Delete archived items without shortcuts - select this option to mark archived documents
for deletion when the corresponding shortcut is removed from the Microsoft Exchange
server.

1 | IMPORTANT: You must select all mailboxes and public folders when you select this
option. Shortcuts can be inadvertently moved to another mailbox or location
manually. Without synchronizing all mailboxes and publicfolders, the Shortcut Sync
job may not find the shortcut for an archived item and could remove the item.

6. Click the Mailboxes tab and select the mailboxes as described below:
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Job Settings FR

General | Scheduler | Options | Mailboxes || PublicFolders
[ synchronize all maiboxes

List of members:

Display Name Alias Email Address
ﬁﬁmup Accounts group-accou... group-accounts@den
I:’_'F David Webb davidwebb davidwebb@democorp.o
I:’_'F Devika Sharma devikasharma devikasharma@democorg
< >

| Add | | Remove |

T

a. Synchronize all mailboxes - select this option to include all mailboxes for the Shortcut Sync
job. When this option is selected the List of Members and the Add and Remove buttons are

deactivated. You must select this option if you select the Delete archived items without

shortcuts option from the Options tab.
b. To add members:

i. Click Add. The Select Mailbox dialog appears.

ii. Select one or more groups or mailboxes. You can hold down the Ctrl or Shift keys to

select multiple mailboxes and groups.

iii. Click[.¥_Ito add the selected groups or mailboxes to the Selected objects list box.

Conversely, you can select groups or mailboxes from the Selected objects list box and

click L2 Jto remove the selected groups or mailboxes from the Selected objects list box.

iv. Click OK to add the selected members to the group or click Cancel to discard the
changes.

c. Toremove members:

i. Select one or more members to remove. You can hold down the Ctrl or Shift keys to

select multiple members.
ii. Click Remove. A confirmation dialog appears.

iii. Click Yes in the confirmation dialog to remove the member. Click No to retain the
member.

7. Click the Public Folders tab and select the public folders as described below:
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Job Settings FR

General | Scheduler | Options | Mailboxes || PublicFolders
Synchronize all Public Folder mailboxes

List of members:

Display Name Alias Email Address

Add (| Femove

T

a. Synchronize all Public Folder mailboxes - select this option to include all Public Folder
mailboxes for the Shortcut Syncjob. When this option is selected the List of Members and
the Add and Remove buttons are deactivated. You must select this option if you select the
Delete archived items without shortcuts option from the Options tab.

b. To add Public Folders:
v. Click Add. The Select Mailbox dialog appears.

vi. Select one or more Public Folder mailboxes. You can hold down the Ctrl or Shift keys to
select multiple mailboxes.

vii.Click[*_to add the selected Public Folder mailboxes to the Selected objects list box.
Conversely, you can select Public Folder mailboxes from the Selected objects list box
and click L2 ] to remove the Public Folder mailboxes from the Selected objects list box.

viii.Click OK to add the selected Public Folder mailboxes or click Cancel to discard the
changes.

c. Toremove Public Folders:

iv. Select one or more Public Folder mailboxes to remove. You can hold down the Ctrl or
Shift keys to select multiple folder mailboxes.

v. Click Remove. A confirmation dialog appears.

vi. Click Yes in the confirmation dialog to remove the mailboxes. Click No to retain the
mailboxes.

8. Click OK to save the job setting and close the window.
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Changing job settings

Job settings cannot be changed while the job is scheduled or running. You must stop it first.

To change job settings:

1

2. Select the job. Then click on the Stop button in the right pane. (Or you may right-click the

4.

In Manager view, click on the Jobs tab.

respective job and in its context menu click Stop.)

Archive Manager for Exchange PEERR

Session Miew  Tools  Help

Groups Settings

FRERaX Do o ae
Public Folders | Jobs Retention

Post Processing Locations

Existing jobs: Job settings:

Marne Status Mexk Run Property Walue

aThershold job Stopped 14.05.2018 20:... Job name Marrnal job 1

535hortcut Sync Stopped 14.05.2018 20:... Job type Marrnal

Db Scheduled 14,05,2018 20:... Status Scheduled

) 30bt Scheduled 14.05,2018 20:...

Maormal job 1 Scheduled G20 Scheduling starts 14.05.2018 20:00:00

Scheduling end Mever
Schedule inkerval 1 days
Maximum allowed time not defined
Compress MSG files Yes
Compress attachments Yes
Retention categary default

[ B3 schedule 5. Stop ] Change...

+| Backup time
Backup start time: Backup stap time:
[z3:00:00 5 [ Update
| Job reporting
@/ M ™ Server Role: Archive Server Folder contents loaded Full&ccess Manager

3. Then click on the Change button ([_c=me=.. ]) next to the Stop button (or right-click the
respective job and, in its context menu, click Change settings).

In the Job Settings window specify your new settings on the respective tabs.

schedule the job again (or right-click it and, in its context menu, click Schedule).

Starting a job immediately

1. Go to the Jobs tab in Manager view.

Steps to start a job running immediately:

select Start now! The respective job will start running immediately.

2. Selectthe job —either stopped or a scheduled one. Right-click it and in the context menu
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Archive Manager for Exchange PEERR

Session Miew  Tools  Help
gRREXDRule e
Groups | Settings || Public Folders | Jobs | Retention || Post Processing || Locations
Existing jobs: Job settings:
Marne Skatus Mext Run Property Yalue
QThershDId job Stopped 14,05,2018 20:... Jab name Jab
5‘3 Shartcut Synec Stopped 14.05.2018 Jaob type Marral
(31 Stopped ‘-" tai=ials 8 =k Stopped
© 10bt schedule | B¢ Mewjob Stopped
e Mormal job 1 Schedule |3 Deletejob ling starts 23.01.2018 20:00:00
0 Schedule ling end Mewver
le interval 1 days
Q Stop um allowed time not defined
@  Startnow!
- h N ess MSG files Yes
Change — ess attachments Yes
Refresh list
ion category Default
Ea Schedule &  stop Change...
+| Backup time
Backup start time: Backup stop time:
2z00:00 s] e = Update
| Job reporting
[=] ﬂ ™ Server Role: Archive Server Folder contents loaded Fullfccess Manager

1 | NOTE: Jobs which are running are highlighted in green in the Existing jobs pane of the Jobs
tab.

Stopping a scheduled job

Steps to stop a scheduled job:

1. Go to the Jobs tab in the Manager view.

2. Select the scheduled job. Right-click it and in the context menu select Stop. The respective job
will stop running and its status will be changed to Stopped (displayed red)

1 | NOTE: You always must stop a job if you want to change its settings. Settings of a scheduled
or running job cannot be changed..

Archiving group emails with a job

On the figure below you can see the Group tab of the Manager view. List in the left pane displays
groups of users synchronized with Archive Manager. Some group icons are displayed in green, the
others not. Green indicates that the group has been activated for archiving.
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Archive Manager for Exchange PERRR

Session View

Groups Setkings

Tools  Help

FR®EX DS

Fublic Folders

Do ge

Jobs Retention

Post Processing

Locations

Set filker | |

Clear Filker |

GEroup name
Dnmain Adrins
Dnmain Users
Managed Availabi...
FErew

Alias
Daomain Admins
Domain Users

Managed Availabilit...

Property
Scheduled in job
Allow to archive members of thi...

Script active
Archive files older than
Archive files bigger than

Include folders:
Exclude Folders:

Include message classes:

Exclude message classes:

Yalue
Maormal job 1
Yes

Mo

10 Days
10,24 KB
Outhiox
Deleted Ttems
IPM. Moke®

IPM. Document*
IPM. Post*

G| B ™ Server Role: Archive Senver

Folder contents loaded

Full&ccess

When you select a group on the Groups tab its properties are subsequently displayed in the right

pane.

The right pane is useful as there you can see some of the group’s properties. For example on the
previous figure you can see that SEA Pilote is activated for archiving (Activated: Yes), scheduling

will be done with 9pm-archiving (Scheduled in job: 9pm-archiving), Outbox and Deleted items

folders are excluded from automated archiving (Exclude folders: Outbox, Deleted items), all files
bigger than 10.24 MB will be archived (Archive files bigger than: 10.24 MB), message classes that

will be archived include IPM.Note, IPM.Post, IPM.Document (Included message classes:
IPM.Note, IPM.Post, IPM.Document).

To archive emails of a group with a job:
1. In Manager view click on the Groups tab.

2. Right-click a group and, in its context menu, click Properties to open its Properties window.

3. Onthe General tab check if that group has been activated for archiving (the Allow to archive
checkbox must be selected). Then click Apply.
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Properties PER

General "Schedular "Fulders Hclasses HScript }

a SEA Filote

l archive members of this group

Retention categary: | <Use job settings = W |
Archive crieria
Archive files older than (days):
Archive files bigger than: 0,01 ME w

4. On the Scheduler tab select the job in the Selected job dropdown menu. Click Apply and OK to
confirm all.

Properties PREE

General || Scheduler "Fnlders ”CIasses ”Script }

Select the job, which will archive this object:
Scheduled job

Selected job: Mormal job 1

7

Schedule interval:

Scheduling starts at: 14.05.2018 20:00:00

Job status: Stopped

o

o
=3

i

T

Job reporting

Job reporting lets the administrator to see how many messages are scheduled for archiving, i.e.
how many messages were given to the asynchronous archiving service (DirectArchive service).

The messages are collected from different sources as scheduled jobs. When a "source” decides to
archive messages, it simply puts them into a database table. The asynchronous service
periodically reads this table and processes messages, depending on job settings.

The job reporting feature displays the content of that database table. It displays only those

messages that are queued for processing. The content is automatically categorized by the start
time of the job.
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Steps to see the status or how many messages are queued for
archiving:

1. In Manager view, click on the Jobs tab. All jobs you have defined so far are displayed in the
left pane. At the bottom of that pane, click on the Job reporting tab to open the Pool monitor

window.
Archive Manager for Exchange PFERFER
Session Wiew  Tools  Help
FRBEEREXDLDQ LU R
Groups H Settings " Public Folders H Jobs " Retention " Post Processing " Locations
Existing jobs: Job settings:
Name Status Next Run Property Yalue
QThErshnId job Stopped 14.05.2018 20:... Job name Mormal job 1
535hnrtcut Sync Stopped 14.05.2018 20:... Job bype Marrnal
Db Stopped 14.05.2018 20:... Status Scheduled
) 3abt Scheduled :
k3 Inormal job 1 Scheduled Scheduling starts 14.05.2018 20:00:00
Scheduling end Mewver
Schedule inkerval 1 days
Maximum allowed time not defined
Compress MSG files Yes
Compress attachments Yes
Retention category default
B3 schedule | | B Stop Change...
— EBackup time
Backup start time: Backup stap time:
[z3:00:00 5 [ Update
| C Job reporting :’
a % Server Role: Archive Server Faolder contents loaded Full&ccess banager

2. The Pool monitor window displays all your jobs. The number next to the job indicates how
many emails assigned to the job are waiting to be processed.

4 Pool monitor PERER

Q2
&) archive [0] Sequence | Thread | Ciner | Status | LRL | Creation date
) gpm -archiving [11]
&) Sent Ttems job [0]
4 »
9 records v

3. Select any job to get more details about the job. Items to be processed by that job appearin
the right pane of the window. The number of items in the job is also displayed at the bottom
left corner. Click the Refresh icon to update the list.
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4 Pool monitor PEER

ol@
Sequence | Thread | Owner | Status | LRL | Creation date
B4z i 9 PAUSED  http:fWMXDEMOfexch.,.  7/17/2007 4:...
- B 43 i 9 PAUSED  http:fWMXDEMOfexch.,.  7/L7/2007 4:...
) Threshold job [0] o= EX) 0 3 PALSED  http:/WMXDEMOjexch...  7i17/2007 4:...
8D Sent Ttems job [0] 45 i} 9 PALSED  httpe/WMXDEMOjexch...  7/17/2007 4:...
= i 9 PAUSED  httpyfMMXDEMOfexch...  7/L7/2007 4:...
i 47 i 7 PAUSED  httpyfMMXDEMOfexch...  7/L7/2007 4:...
i 4a i 7 PAUSED  httpyfMMXDEMOfexch...  F/L7/2007 4i...
449 i 7 PAUSED  httpyfMMXDEMOfexch...  7/L7/2007 4:...
B0 i 7 PAUSED  http:fMMXDEMOfexch...  F/L7/2007 4:...
=] i 7 PAUSED  hitp:fMKDEMOfexch...  7/L7/2007 4:...
sz i 7 PAUSED  http:fWMXDEMOfexch.,.  7/17/2007 4:...
1| »
11 records —

NOTE: A lot of useful information can be found in the list view, e.g. the sequence
number of the item (Sequence), ID of the owner (Owner), Status (WAIT - waiting to be
processed or PAUSED —the respective job is stopped), location of the mailbox item
(URL), the date of creation (Creation date), number of unsuccessful attempts to process
the item (Error count), ID of the job in charge of the item (Job) etc.

4. Click the View switchericon ( f.l) next to the Refresh icon to display the Mailboxes pane. In
this pane you can see mailboxes from which the selected job is archiving items. The first
number in square brackets next to the mailbox is the mailbox ID, the second number is the
number of emails waiting to be archived in that mailbox.

Click on the mailbox node (in our example user004) to display the waiting items of that
mailbox.

4 Pool monitor PERFR

o
) archive [0] Mailbaxes | Sequence | Thread | Qwiner | Status | LRL
s_) (5, usernnd [3] 5] Bl 42 0 9 PAUSED  hitp:f¥MDI
- test[0] B 43 ] 9 PAUSED  http://¥MxDi
S:-) Thrashald job [0] () user003 [71[6] B4 0 E PAUSED  hep:f¥MADI
-~ sert teems job [0] B4 45 il 9 PAUSED  http:/f¥MuDI
B 45 0 9 PAUSED  hitp:f¥M=DI
4 »
11 records vy

5. If anitem could not be archived after several attempts, it is displayed in red. You can try to
archive it again. Right-click the item and select Resume from the context menu.
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% Pool monitor PFEREFR

o la

&) archive [0]

B 9pm -archiving [11]
) test [0]

) Threshold job [0]
) Senk Ttems job [0]

Mailboxes

(3 Al Pacino [5] [8]
(% Sandra Bullock [S][1]

9 records

Sequence | Thread | Cwner | Status | LRL
= -1 alPacin.,,  WALT it D
=1 -1 Al Pacin,, . WAIT http:
A r—ree g
=T Add/remove columns [ ——"
B9 |G e [t T
B 91 P b A
o= ] @ Pause tp WM
93 @ Delete Itk P
Deactivate

@ Info

'a Archive
«| | ¥

A

There are other options in the context menu for any item as well:

e Pause —archiving of that item will be paused, i.e. will not be process in that cycle, however,
it will be processed in the subsequent cycle.

e Deactivate - the respective item will never be processed by the job in question.

e Delete —the item will be deleted from the list.

¢ Info — Message information window opens displaying location, mailbox, subject, receive

date, message class and size of the selected message

B8  Archive Manager for Exchange - Message information

Message information

Property Yalue

@ Message

r_] Mailbo: userinz [3]
[] Subject

I Received date 26,08,2013 15:39:32
[] Message class IPM. Mote
2] size 8355 B

http:/ 40ADDCE fexchange/user0DZ Inbox/00000000Z0E405E .,

occupy a position he had not himself chasen, because the pop...

Close

Select Add/Remove columns option to customize the order and selection of columns in the

list view of the Pool monitor.
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Add/Remove columns ®

Available columns: Selected columns:
Thread |

Last error
Errar count
e

.

Retention tab

On the Retention tab of the Manager view different retention categories for email archiving can
be set (e.g. retention category for short-term documents, retention category for long-term
documents etc.). In other words, various types of emails require different ways of archiving and
the time for which they must be stored and retrievable can differ as well. Further we discuss the
usage of retention categories, their description and management from the end-user point of
view.

Various features of retention categories enhance the adaptability of Archive Manager for
Exchange forindividual users together with the email life-cycle management. Emails can now be
archived with two-tier delete and manipulation protection. Tier one defines the retention time
in which archived emails can be neither deleted nor moved to different storage media —these
policies vary according to company or state regulations. Tier two allows the administrator to
transfer emails to long term storage media or delete them.

The shortcut creation time known simply as "shortcut delay” can be defined allowing Blackberry
users’ access to mails and attachments that have already been archived. The "Delete shortcut
after atime” feature can be used to reduce the number of "redundant” shortcuts left in the
Microsoft Exchange Store after a specific number of days, months or years.

The retention categories which are created here can be assigned to jobs on the Jobs tab.

1 | NOTE: The default retention category needs to be specified on the Tools > Options >
Archive settings > Retention tab. For more information see Archive settings. This category
will be applied if no specific category is selected, e.g. for direct archiving and manual
archiving using AddIn.
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Retention categories

The following types of settings are available:

Settings related to emails in the HSM Store:

Retention time —the archived email is not delete-able from the HSM Store for the defined time
period. Retention time is thus the MOST CRUCIAL feature of Archive Manager for Exchange
related to law regulations. Emails ‘deleted’ using functionalities of Archive Manager for
Exchange or Outlook Addin are actually only marked for deletion and they reside in the archive
until this retention time expires.

Delete time —the email, although not marked for deletion, is automatically deleted (by the
Delete Files job) from the archive after the expiration of the defined time period. Itis the
MAXIMAL time for which the emails reside in the HSM Store. This time period cannot be
smaller than the retention time.

Keep-alive time —it is the time period after email deletion, during which the deleted email can
be turned back to the store. However, this is possible only if the Delete time has not elapsed
yet.

Settings related to emails on the MS Microsoft Exchange Server:

Keep the original email —email is archived but it is not modified in any way (noicon, no
shortcut, keep residing on the MS Microsoft Exchange Server). This option is used for backup.

Delete original email —the email is removed from the MS Microsoft Exchange Server
immediately after archiving, no shortcut is created thus it is not reachable from the user’s
mailbox and it is displayed as "lost” in the Archive view.

Create shortcut —the email is archived and it is replaced with a shortcut. This type of archiving
saves the space on the MS Microsoft Exchange Server and at the same time activates the user to
work with the archived email as with non-archived one. Email can be replaced with the
shortcut immediately or it is kept without changes for the defined time period and after its
expiration shortcut is created ("Delay shortcut creation by” option ).

o Delete shortcut after a time —the shortcut of the email is automatically removed
from the MS Microsoft Exchange Server after the expiration of the defined time
period (email cannot be reached from the user’s mailbox any longer and is displayed
as ‘lost’ in the Archive view). However the email still resides in HSM Store.

The starting point of all the above mentioned times (except the Keep-alive time) is either the
moment of archiving or the moment of receipt. The starting point can be set when the retention
category is created.

Please consider carefully the retention settings, especially when setting receive
time as the starting point. If a message has been received e.g. 6 months ago and your
retention time/delete time is 3 months, the message will be archived. However, it can be
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deleted from the archive immediately, as 3 months have already passed since the
beginning of its retention time.

KEFP- ALTVE TIHE
START I
: |
. RETENTION TIME TIME
ARCHIVED 1 DELETESHCRTCUT TIHE
ot DELAY SHORT CUT CRETION TIME
RECEIVED

In addition to the default retention category created during installation the administrator can
create multiple retention categories satisfying specific criteria of the enterprise. The retention
category consists of a name, a description, the above mentioned retention times and of the HSM
scheme. Itis fully manageable from Archive Manager for Exchange.

Creating a new retention category

Steps to create a new retention category
1. Onthe View menu click Manager.
2. Click on the Retention tab.

3. Right-click inside the list view, select New category from the context menu and navigate
through the wizard as follows:

Archive Manager for Exchange FRERR

Session View Tools Help
FRRRXDRG Ee e
Groups | Settings | PublicFolders | Jobs Retention | Locations
Retention categories

ID  MName Description H5M scheme 1D Retention time Delete retention tme  Delayed shortcuter...  Shortcut delete retention time KeepAlive
1 3 manths Autogenerated on Sep 13 202... 1 FilesSchema 3months Mot defined a Mot defined 1]

| iy Mew category

. Delete category

Add/Remove columns

Properties
£ >
@ ﬂ ™ Server Role: Archive Server Loaded FullAccess Manager
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Basic settings window pops-up. Enter the name for your retention category in the Category
name text box (e.g. Keep shortcut for 3 years).

& Set retention category parameters PERR

Basic setting @

Category name: |KEED shorteut for 3 years |
Target HSM scheme: 1: FilesSchema ~
Lifetime calculated from: Archive time ~
Category description:

In the Target HSM scheme dropdown box choose the target scheme which will be used for
archiving. In the HSM system you may define different HSM Schemas, which are virtual
categories for documents. (One HSM Schema has been created at installation of Archive
Manager for Exchange and you may have created more HSM Schemas during the setup of
Archive Manager for Exchange, each with a particular number assigned to it.)

In the Lifetime calculated from dropdown box you can choose from two options —Archive
time and Receive time; i.e. you can define here the starting point from which the all the
retention related times must be calculated. Either it will be the time when the item gets
archived (Archive time) or it will be the item’s Received time.

In the Category description text box fill in a short description of the new category.

. Click Next.

In the Document lifetime window specify your settings.

Itis strongly recommended paying very much attention to these settings as they define the
time period for which the emails are archived.

Set the Retention time. During this period none of the emails in the HSM store archived via
this retention category can be removed from the archive. It is possible to select:

e Fixed period (set the period)
¢ Indefinite period (the retention time is not set specifically but can be defined later)
¢ Infinite period (retention is everlasting)

Select Activate automatic document deletion checkbox and specify Delete time if you want to
COMPLETELY DELETE an archived emails whose retention time has elapsed from the HSM
Store after a defined time.

1 | NOTE: Activate automatic document deletion option applies to emails which are not
marked for deletion.
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By specifying the Keep alive time you set the time period for which the email, deleted after
its retention time has elapsed, will be still keptin the HSM Store. Use the arrows to set the
time or directly overwrite it. Delete and Keep alive time can be set in days, months or years.

& Set retention category parameters

Advanced settings - document lifetime’

Retention time: (@) Fixed 60 % monthis)
() Indefinite
O Infirite

Activate aukomatic document deletion

Delete time: |4 | | days ~
Keep alive time: 12 | |days

— ermees

1 | NOTE: The Delete time cannot be smaller than the Retention time. These settings set
the time for which emails exist in the archive.

10. Click Next.
11. In the Shortcut lifetime window you can choose from three options:

a. Keep the original e-mail —select this option, must you wish to archive email and not to
modify it in any way. In this case no shortcut will be created and the whole email will
reside in the MS Microsoft Exchange Server. In the Archive view on the Mailbox tab such

item will be displayed with the followingicon: BQ

& Set retention category parameters

Advanced settings - shortcut lifetime:

®) Keep the original e-mail

() Delete original e-mail

O Create shortout
Create shortcuts immediately
Dielay shorbout creation bey:

1 3| |days

Keep sharteut Forewver
Delete shorbouk after a time:

1 3| |days

I

b. Delete original e-mail —select this option, must you wish to delete all original email from
the MS Microsoft Exchange Server immediately after its archiving. No shortcut is created
and the email is not accessible from the user’s mailbox. In the Archive view such item is

displayed as lost.

c. Create shortcut —select this option, must you wish to replace the original email with a
shortcut after archiving and thus make it accessible for the user and save the space on MS

Microsoft Exchange Server at the same time.
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& Set retention category parameters

Advanced settings - shortcutlifetime!

O Keep the original e-mail

O Delete original e-mail

® Create shorteut
® Create shortcuts immediately
) Delay shorteut creation by:

1 o |days

® Kesp shortcut forever
) Delete shortcut after a time:

1 o |days

H Cancel |

e

In case you have selected the Create shortcut option, further settings become available
and you can adjust shortcut behavior to meet your needs. You can choose if the shortcut
creation will follow immediately after archiving of the email (Create shortcut immediately
radio button) or will be delayed for the specified period of time (Delay shortcut creation
by radio button) when e.g. Blackberry users will be able to view their attachments. While
no shortcut is created, the email is displayed in the Archive view with the following icon:

B¢

Moreover, you can decide whether you want to keep the shortcut in the user’s mailbox
until the user deletes it (Keep shortcut for ever option) or the shortcut will be deleted
automatically after the defined time (Delete shortcut after a time option).

12. Click Next.

13. Extra settings window opens. If the Allow automatic deletion of unreferenced emails
checkbox is selected, emails archived via this category will be marked for deletion whenever
the Shortcut Sync job cannot find the reference to the emails in any of the users’ mailboxes. If
the check-box is not selected, Shortcut Sync job will not marked eventual "lost items” for
deletion (see the section "Shortcut Syncjob”).

€ Set retention category parameters

Advanced settings - extra

[[] allow automatic deletion of unreferenced emails (by Shortcut synchronization job)

PER

@

=

Cancel

Example:

I. Emails are archived by a retention category with Allow automatic deletion of unreferenced
emails checked and shortcuts are left in the Microsoft Exchange Server
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Il. You delete shortcuts from Microsoft Exchange (either by removing the shortcuts manually in a

mailbox, or by deleting a folder in Outlook that contains shortcuts etc.) - emails become "lost
items”

[Il. You run the Shortcut Synchronization Job = lost items are marked for deletion

If the items were archived with O retention time and with Allow automatic
deletion of unreferenced emails allowed, the Shortcut Synch Job deletes them
COMPLETELY.

IV. Items marked for deletion are deleted from archive when their Retention (and Keep alive)
time elapses and you run the Delete Files job.

1 | NOTE: Items marked for deletion still reside in the HSM Store but cannot be restored
using Archive Manager for Exchange, e.g. on the Archive tab.

14. Click Next to finish the creation of the new retention category.

Changing retention category settings

To change the settings of an existing retention category:

1. Double-click the selected retention category to open the Retention category properties
window or right-click and select Properties from the context menu.

2. Onthe respective tabs specify your new settings for the retention category. On the General
tab you can change the name, HSM Scheme, retention time, keep alive time as well as allow
automatic deletion of old documents and modify related Delete retention time. Click Apply
and OK.

€ Retention category properties PER
General | Shortcut | Additional
@ RELENLOTSELLNG = ]
Mame: Keep shortcut for 3 years
HSM Scheme: 1: FilesSchema ~
Retention time: | fixed ~ | |60 +{ months

Lifetime calculated from: Archiving time

@ DEIELE FELEN LI LNTES" »

Allow automatic deletion of old documents

Delete retention time: 5 >| | years w
Keep alive time: 12 % | |days 4
Description:
created by Administrator.
B

3. Shortcut settings can be modified on the Shortcut tab. Click Apply and OK to apply the new
settings.
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€ Retention category properties PER
|General | Shortcut | Additional
&jhu;::u: (IFEGTIE

) Keep the original e-mail

() Delete original e-mail

® Create shortcut

Shorteut settings
(®) Create shorteuts immediately
() Delay shortcut creation by

0 5 days

() Keep shorteut forever

®) Delete shortout after

A
3 v |years W

| mmeETm

4. On the Additional tab set the shortcut synchronization behavior —if the Activate document
clean-up by Shortcut synchronization job checkbox is selected, emails archived via this
category will be marked for deletion (or completely deleted if their retention time is 0)
whenever the Shortcut synchronization job cannot find the reference to the emails in any of

the users’ mailboxes. If the checkbox is not selected, Shortcut synchronization job will not
mark them.

& Retention category properties PER

General || Shortcut || Additional

ﬁ-,mimn dLICCIEGID®

[ Activate document deanup by Shorteut synchronization job

]

If the deanup is not allowed, only the user (or administrator) is
able to mark the documents as deleted. If the document is not
marked as deleted, it will never be purged from the archive
({unless the maximum retention time is defined).

B e

5. Click Apply and OK to apply your settings.

How to customize the retention categories list view
1. Right-clicking any retention category on the Retention tab
2. From the the context menu select the following:

e Add/Remove columns —to add or remove columns from the list view.

o To add or remove a column, select the column from the Available columns or Selected
columns list. Then click on the Add/Remove button.
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o To change the order of the selected columns click the one you want to move and use the
Up and Down buttons. Click OK.

Add/Remove columns ®

Available columns: Selected columns:
io j(v]

Name

Drescription

H3M scheme ID

Retention time

Dielete retention time

Dl ﬁ d shorteuk ticn ki
<<nve elayved shortcut creation time

Aukodelete
Lifetime begin

_

e Delete category —a retention category can be deleted only if nothing was archived via this
retention category.

Locations tab

For better performance and secure load balancing, you can install several archive or retrieve
servers in several locations like Geneva, Amsterdam, Paris etc. Each server location uses its own
database but they could point to the same Exchange Server. When you create locations, Archive
Manager knows which location to use for archiving and retrieving emails for end users.

After you have:

1. installed your Archive Manager servers

2. assigned the servers their server roles in the Tools > Options > Server settings tab
You must:

3. register the servers as Archive or Retrieve severs in the Locations tab.

1 ‘ NOTE: If you have only one Archive Manager server installed, you need not register it.

Steps to add a new location

1. In Manager view click on the Locations tab.

2. Expand the All locations node in the left pane of the window to see the all locations and its
servers.

3. Right-click the All locations and select the Add new location option.

Archive Manager for Exchange

Session  Miew  Tools  Help

FRREXDes Do as

Groups H Settings " Public Falders " Jobs " Retention " Lacations
Locations
=@ 1 Display name
;...% Add new location,., N |th Default
| "
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4. Inthe New location properties window provide the information as described below:
a. Location id - identifier of the location. You can change the value if needed.

b. Name - name of the location.

c. Display name - name of the location that appears to users who are are using Outlook
Addin. It could be the same as the Name property.

d. Currentlocation - select Yes to set the location where the Archive server is installed.

,_5,_ New location properties =R

Location

= Moo

Location ID: 2 e

Name: ‘ ‘

Display name: ‘ ‘

Current location: | No ~

The location is a callection of Archive, Retrieve or PST Import
Servers connected to the same database.

5. Click Apply, then OK.

i | NOTE:
To edit a location, right-click the location and select Properties from the context menu.

To delete alocation, right-click the location and select Delete location from the context
menu. Then click Yes in the confirmation dialog.

To set another location as the current location, right-click the location and select Set as
current location from the context menu. This option is deactivated if there is only one
location defined.

Steps to add a sever to a location

1. In Manager view open the Locations tab.
2. Expand the All locations node in the left pane of the window.

3. Select the location where you want to add the new server. Then right-click and select Add
server to location from the context menu.
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4.

Archive Manager for Exchange FPFEER

Session  View Tools Help

FRmRX DS Do

Groups | Settings || PublicFolders | Jobs Retention || Locations
Be Alllocations LocationID Name Server type Server ID Secure connection (https) Alias
s Defauit Ba AMXSERVER.  Arch 1 i
5 AmxsERVER ¢ TEWE 2
4 Geneva
§ amxceneva
Amsterdam
Ij AMXAMSTERDA Add/Remove columns

Pari
e | Add server

we
[ amxparIs

) Delete server

Properties

In the New location server properties window enter the information as described below:

E New location server properties =3

Location Server

Jj—u.suibu SErvEr —

Name: |AMXREI'RIEVE

Type: Retrieve v

Alias: |

[] Use secure connection (https)

A Location Server is one server name or alias,

-

a. Name - Name of the server.

b. Type - Choose from the following server types: Archive, Retrieve or PST Importer.

Alias - Enter the FQDN name of the server. Required if you use https for communication.

User secure connection (https) - Select this option if you use https for communication.

NOTE: If users are using Outlook Addin make sure that they can access the new location
server. If users are using a proxy server, make sure that the location server is accessible
through the proxy. If your environment uses https for communication and ArchiveWeb
or OWA to access archived items, the following settings must be configured:

e The site bindings and SSL Settings for the location server certificate must be
configured.

e The AM for Exchange service URL property for ArchiveWeb must be configured to use
https. See the ArchiveWeb Guide for more information.

e The Archive ManagerExchangePamWS URL property for OWA must be configured to
use https. See the OWA Guide for more information.
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5. Click Apply, then OK. The new server will appear in the right pane of the Locations tab.

¢ In the Location server properties window, the Alias must be specified and the Use

secure connection (https) checkbox must be selected.

FERBRRX DS Ee es

Groups H Settings "PublicFuIders "Jubs

" Retention " Locations ]

=@ Al locations

oh

AMYSERVER
AMYRETRIEVE
4, Geneva
5 amxceENEVA
., Amsterdam
[ AMxaMSTERDA
g% Paris

[ AMxPARIS

Location ID

g1
g1

Name Server type
AMXSERVER Archive
AMXRETRIEVE Refrieve

Server ID
1
3

Secure connection (https)
Mo
Mo

Alias

Archive Manager for Exchange FEREFR
Session  View Tools  Help

Locations

NOTE: To delete the server from the list, right-click the serverin the left pane and select
Delete server from the location from the context menu.
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5

Status view

Status view is displayed by clicking Status on the View menu. By clicking on different nodes in the
left pane of the Status view you will display information on current version of Archive Manager
for Exchange, logged-on users, status of services, database, HSM Store etc.

By clicking on the Application Server node in the left pane you will display some detailed
information about the current version, as shown below:

Archive Manager for Exchange PEER

Session  View Tools  Help
FERBXDYSBe QN
@ Application Server _
¥ services
- Connections Server version: 8.2.0.275

4| Exchange servers

; Service versions:
MAM Exchange Manager service: 8.2.0.275
MAM Exchange Direct Archive: 8.2.0.275
MAM Exchange Scheduler service: 8.2.0.275
MAM MAPI service: 8.2.0.275
MAM Exchange Handler: 8.2.0.275
MAM Auditing service: 8.2.0.275
MAM Monitoring service: 8.2.0.275
MAM SMTP service: notinstalled
MAM Ws File Processor service: not installed
MAM IMAP Server service: not installed
MAM IMAP Wef service: notinstalled
MAM Exchange Motification service: 8.2.0.275
MAM Post-processing service: 8.2.0.275
MAM PST Importer service: 8.2.0.275
MAM Search: 8.2.0.275
MAM Logging: 8.2.0.275
MAM H5M Base Operations: 8.2.0.275
MAM HSM Asynchronous Operations: 8.2.0.275

@ B Server Role: Archive Server Loaded FullAccess Status

By clicking on the Services node in the left pane you will see all Archive Manager for Exchange
services and their status.
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Archive Manager for Exchange FEREERFR

Session  View Tools Help
FRREREX DD e
= @ Applicah’o Server Services

5

& Connections | LI 4

23| Exchange servers Name Status

e HEM

] Database maM Auditing Running
"e MAM Exchange Direct Archive Running
":MAM Exchange Handler Running
rél""\.ﬂl"ﬂ Exchange Manager Running
@MAM Exchange Notification Running
@MAM Exchange Scheduler Running
A4 MAM MAPT Running
A% MAM Monitoring Running
":MAM Post-processing Running
4% MAM PST Importer Running
@MAM Search Running
@-MAM Logging Stopped
A% MAM HSM Base Operations RuAning
"e MAM HSM Asynchronous Operations Stopped

@ |m ™ Server Role: Archive Server Loaded FullAccess Status

Services can be restarted by clicking on the Restart button. You can use the Stop button (L]) to
stop the selected service and then the Start button ( * |) to start it again.

By clicking on the Connections node in the left pane you will display current connections and
logins. Here you can find out access rights etc.

Archive Manager for Exchange PEREERR

Session  View Tools Help
FERBEXDRS BT QN
é ;Eplicahnn Server D Computer User Access Client path
Services
:f 1 AMXSERVER-X domadmin Scheduler tep: //AMXSERVER.-¥: 9904/ /CommunicationClient/Client.rem
a Exchnge carvers 2 AMXSERVER-X domadmin ReadMode tep: //AMXSERVER.-X: 9977 [CommunicationClient/Client.rem
3 AMXSERVER-X domadmin FullAccess tep://AMXSERVER.-X: 30255 /CommunicationClient/Client.rem
4 AMXSERVER-X SYSTEM PSTImporter tep: /{AMXSERVER.-X: 99 11/CommunicationClient/Client.rem
5 AMXSERVER-X domadmin WebService top: /{AMXSERVER.-X: 9905 /CommunicationClient/Client.rem
& AMXSERVER-X domadmin DirectArchiveM...  tcp:/fAMXSERVER-X:9950/CommunicationClient/Client.rem
7 AMYSERVER-X domadmin DirectArchiveM...  tcp:/fAMXSERVER-X:9950/CommunicationClient/Client.rem
;] AMYSERVER-X domadmin DirectArchiveM...  tcp:/fAMXSERVER-X:9950/CommunicationClient/Client.rem
@ |m ™ Server Role: Archive Server Loaded FullAccess Status

Archive Manager for Exchange can run on several computers in parallel and can communicate
with several MS Microsoft Exchange servers.

By clicking on the Microsoft Exchange servers node a list of synchronized MS Microsoft Exchange
servers will be displayed, including the number of threads.
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Archive Manager for Exchange PERR

Session  View Tools Help
FhlRaX Do bzean
é Application Server || seryer Version Archiver threads
Q Services AMXEXCH 2016 1
& Connections
B Exchange servers
—_—
E’ Datzbase
@ [H1™ Server Role: Archive Server Loaded FullAccess Status

To change the number of threads, double-click a Microsoft Exchange server. In the Threads
window simply set the number of threads to be processed in one cycle. The higher the number,
the less number of cycles you have —it however slows down the system. An optimal number is
from 15to 20.

Archive Manager for Exchange

Number of threads for automaticprocessing

Thread count (AMXEXCH):

| (04 || Cancel |

If you, for instance, set the number of threads to 4 and click OK.

Archive Manager for Exchange L3

DirectArchive service needs to be restarted

Restart now?

| Yes | | Mo |

Click Yes to restart the service. Then by clicking on the Connections node, 4 entries will be
displayed (see the following figure).
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Archive Manager for Exchange

Session  View  Tools

Help

HERRaX Do ean

E: W‘Gﬁf’” Server jin] Computer User Access Client path
) 1 AMXSERVER-X domadmin Scheduler tep: ffAMXSERVER -X: 9904/CommunicationClient/Client.rem
Exchange servers 2 AMXSERVER-X domadmin ReadMode tep: ffAMXSERVER -X: 9977 /CommunicationClient/Client.rem
HEM 3 AMXSERVER-X domadmin FullAccess top: ffAMXSERVER -X: 30255/CommunicationClient/Client.rem
l‘ﬂ’ Datsbase 4 AMKSERVER-X SYSTEM PSTImporter tope fAMXSERVER -X:9911/CommunicationClient/Client.rem
] [m@ Server Role: Archive Server Loaded FullAccess Status

By clicking on the HSM node you will retrieve some information on your HSM store type,
HSM/Archive Manager Server and the ID of the default Retention Category. This is for
informative purposes only.

Session

Archive Manager for Exchange FEERFER
View Tools  Help
FRlRaXDhagaibe as
B@ Application Server Praperty Value
2 Services HSM 5 : AMXSERVER
- g Connections EIVer:
153 Exchange servers Store type: HsM
Default Retention Category: 3 months

= [T
puf Database

@ B Server Role: Archive Server

Loaded

FullAccess Status

By clicking on the Database node some information about the database in use will be displayed.
This information is taken from the DB Config tool.
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Archive Manager for Exchange

Session  View  Tools

SBRB XD

Help

ez Ean

=] & Application Server

Services
Connections
3| Exchange servers

Property

Database Type:

Data Source:

Initial Catalog:
DataTypeCompatibility:
Integrated Security:
Schema:

Value

M5 50L
AMXSERVER.-X
MAMEXCH

a0

S5PI

dbo

@ [J]™ server Role: Archive Server

Loaded

Fulla
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6

Archive view

Archive view has been designed for shortcut repairing, for manual archiving/restoring (Mailboxes
and Public folders tabs) and for browsing purposes. Even restoring of lost items is possible in this
view (Archive and Mailboxes tabs).

In this chapter
e Mailboxes tab
e Archive tab

e Public Folders tab

e Public Folders Archive tab

Before you start archiving

All mailboxes that you plan to archive must be synchronized with Archive Manager for Exchange
Server. Emails received by mailboxes that were not synchronized cannot be archived.

Synchronization can be automated with the Address Book Manager and can run in the
background. For more information see Synchronizing Address Book Manager. When mailboxes
are synchronized you can start archiving mailboxes.

1 | NOTE: The archiving services are configured to run automatically (service type set to
"Automatic" in Start > Settings > Control panel > Administrative tools > Services) and some
of them run with the super-user account credentials. If some services are not started, itis
necessary to start them manually using the Start.bat file. The default location is
C:Program Files (x86)\ Quest\MAM4Exchange\Tools. Ifitdoes nothelp, review
the event log entries in Start > Control panel > Administrative tools > Event viewer. The
most common problem of not starting services is the incorrectly configured identity. Run
an update or repair using the the Archive Manager for Exchange setup file, or correct the
service identities manually using Start > Programs > Administrative Tools > Computer
Management.

Mailboxes tab

This tab is used for:
e Manual archiving/restoring of an item/folder/mailbox

e Repairing shortcuts
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e Archiving only certain type of messages or mailbox folders(via Archive wizard)
e Restoring only certain type of messages (via Restore wizard)
e Lostitems restoring on a mailbox level (via Restore wizard)

e Manual creating of shortcuts for archived items with "delay shortcut” settings

Archive Manager for Exchange FEERR

Session  View Tools  Help
FRRBRX0D0G B 0.
Mailboxes | Archive || PublicFolders | Public Folders Archive
Look for: Filter in: Filter text:
| | <no fiter> v| O (lanks) |
@ Distribution lists Display name Alias Rdn e-mal address
53] Group Accounts
Group Democorp [ Karl Jordan karljordan karljordan karljordan@democorp. com
Group Products [ Juan Christie juanchristie juanchristie juanchristie @democorp,com
[+-E2] Group Sales (2 1shna Mohan ishnamohan  ishnamohan  ishnamohan@democorp. com
@ Al mailboxes E’_“ Administrator domadmin domadmin domadmin@democorp. com
- #fR Search results
< >
| Set filker | | Clear Filker Maiboxes: 4 of 4
@ ﬂ ™| Server Role: Archive Server Loaded FullAccess Archiver/Restorer

The Mailboxes tab has a navigation pane on the left and the detail pane on the right.
The navigation pane displays the following nodes:

o Distribution lists - this node displays the groups and the mailboxes contained in the groups.
Expand the node to view the groups and mailboxes.

o All mailboxes - this node displays only active mailboxes from Address Book Manager. Expand
the node to view the mailboxes.

e Search result - this node displays the result of a search using the Look for field above the
navigation pane.

To locate a mailbox:

1. Enter a mailbox name in the Look for field. The names you enter are added to the dropdown
and available through the duration of the Archive Manager session. You can enter an asterisk
(*) to retrieve all mailboxes.

2. Click Enter on your keyboard. The results are displayed under the Search results node.

1 | NOTE: Mailboxes have a unique identity number which is displayed in square brackets to
distinguish mailboxes in the case where two mailboxes have the same display name. The
unique identity helps the administrator to identify the correct mailbox.
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Archive Manager for Exchange FEERR

Session  View  Tools

Mailboxes || Archive
Look for:

Help

FRR@X D86

PublicFolders

Boaow

Public Folders Archive

Filter in:

[tm

<no filter>

Filter text:

v| O (lanks) |

B@ Distribution lists
] Group Accounts
Group Democorp
@I Group Products
@I Group Sales
@ All mailboxes
=R Search results

[EREN Tim Ashford [11]

goooorooooooooooooo

| Set filker | |

Clear Filker

Folder

Calendar

Contacts
Conversation Action Settings
Deleted Ttems
Crafts
ExternalContacts
Inbox

Journal

Junk Email

MNotes

QOuthox

PST

Quick Step Settings
RSS Feeds

Sent Ttems

Sync Issues

Tasks

‘Yammer Root

Folders: 18 of 18

@ ﬂ ™| Server Role: Archive Server

Loaded

FullAccess Archiver/Restorer

The detail pane displays the contents of the group or mailbox selected in the navigation pane.

You can filter the contents of the detail pane using the filter fields:

o Filterin - the dropdown presents predefined properties that you can use to search the contents
of the detail pane. The dropdown is contextual to the selection made in the navigation pane.

For example, if you select a group from the distribution list, the dropdown options available

are <no filter> and each of the columns available in the list such as Display name, Alias, Rdn and
e-mail address. If you select a mailbox in the navigation pane, then the options available in the
dropdown are <no filter>and Folder.

e Blanks - select this checkbox to filter all results where a blank value is present for the selected
dropdown in the Filterin field. The Filter text field is deactivated.

o Filter text - enter a text in this field to refine the filter based on text that is presentin the
property selected in the Filterinfield.
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Archive Manager for Exchange 7=

Session  View Tools Help
FREEX DS B 2 ow
Mailboxes "Archwe " PublicFolders " Public Folders Archive ]
Look for: Filter in: Filter text:
Ni | | Alias v| O (Elanks) [d
E @ Distribution lists Display name Alias Rdn + e-mal address
Group Accounts
@‘ Group Democorp [} Tim Ashford timashford timashford timashford @democorp, com
@‘ Group Products [ Pablo Neruda pabloneruda  pabloneruda  pabloneruda@demacorp.com
2] Group Sales [ Karl Jordan karljordan karljordan kartjordan@democorp.com
f’:_'; Administrator domadmin domadmin d | lemocorp. com
E’_'j Devika sharma devikasharma devikasharma devikasharma@democorp.com
E:'; David Webb davidwebb davidwebb davidwebb @d Corp.com
") Mina Tanaka [9]
< >
| Set filker | | Clear Filker Mailboxes: 6 of 11
@ ﬂ Server Role: Archive Server Folder contents loaded FullAccess Archiver/Restorer

Filters are not allowed for contents of mailboxes displayed in the detail pane. The filter fields are
deactivated.

Archive Manager for Exchange FEERFER

Session  View Tools Help

FmexDeg il aee
Mailboxes "Archwe "Publ\cFaIders " Public FoldersArchive]

Look for: 1 ct:
karl ~ | <nofiter= (Blanks) | i

B"@ Distribution lists From Subject Received © Size: [Nl

Group Accounts
@I Group Democarp juanchristie@d...  Midnight?s Children 9/11/2020 2:34 AM 9.09 KB
@I Group Products davidwebb@de... An American Tragedy 9112020 2:33 AM 8.5KB
2] Group Sales timashford@de...  Whiskey in a Teacup 9/11/2020 2:33 AM 10.71KB
@ All mailboxes pabloneruda@d... The Water Dancer 9/11/2020 2:33 AM 8.64KB
E-#® Search results ninatanaka@de... The Memory Police 9112020 2:33 AM 8.65KB
E|If_] Karl Jordan [7] nkiportman@d...  She Said 9/11/2020 2:33 AM 8.66 KB
-7 Calendar juanchriste@d...  Lanny 9112020 2:33 AM .43 KB
-3 Contacts ishnamohan@d...  Hollywood's Eve 9/11/2020 2:33 AM 9.05KB
~{{3) Conversation Action Set] devikasharma@... Exhalation 9/11/2020 2:33 AM 8.03KB
{7 Deleted Items davidwebb@de... Elack Leopard 9/11/2020 2:33 AM 7.9KB
{3 Drafts timashford@de... Establishing Credibiity 9/11/2020 2:33 AM 2.93 KB
juanchristie@d...  Commerce 9/11/2020 2:33 AM 7.7KB

{7 ExternalContacts

-5

% "EDDDDDDDEDDEDDDDDD DB D

= | davidwebb@de... Commerce 9/11/2020 2:33 AM 12.08 KB ¥
= i timashford@de... Commerce 5/11/2020 2:33 AM 5.84KE ¥
) Notes pabloneruda@d... Commerce 9/11/2020 2:33 AM 11.25KB ¥
=) Outbox ninatanaka@de... Commerce 9/11/2020 2:33 AM 9.32KB
{3 Sent Items nikiportman@d...  Wealth 9/11/2020 2:33 AM 9.56 KB ¥
() Tasks juanchristie@d...  Wealth 9/11/2020 2:33 AM 9.55KB
{07 Yammer Root ishnamchan@d... Wealth 9/11/2020 2:33 AM 8.41KB
devikasharma@... Origins of Money 9112020 2:33 AM 7.9KB
< N davidwebb@de...  Division of Labour 9/11/2020 2:33 AM 11.05KB &
>
| Set Filter | | Clear filker | of 1 Messages: 1-220f 22 [4 < > A
@ a. Server Role: Archive Server Folder contents loaded FullAccess Archiver/Restorer

Every item in the folder has its icon which represents the status of the item. You can open the
legend foricons when you click the @ Show legend icon from the toolbar. The Legend window
with icon explanation opens.
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Legend

Explanation of icons

Icon

[ Y e

ki f o O

Mame

Mot archived kems
IPM.Note

IPM. Task

IPM. Contact

IPM. Post

IPM. Appointment
IPM.Document

Shorbouts

Archived mail

Archived mail Forwarded
Archived mail replied
Archived post item
Archived document
Archived calendar ikem
Archived contack
Archived task

Delayed shortcuts
Mail itrm

Description

These icans represent warious mailbox ikems
Standard email message

Task item

Contact item

Post item

Calendar ikems

Documents ar other message classes

Shartcuts are messages which were modified after archiving, The shor...

Delayed shortcuts are messages which were archived but were nat ye...

Close

Archive wizard

Administrators can archive several mailboxes at once and apply archiving filters for message

types and mailbox folders.

To archive items in multiple mailboxes:

1.
2.

In the Archive view click on the Mailboxes tab.

Right-click a mailbox, group or distribution list and select Archive wizard from the context

menu. The Archive messages wizard starts and the Selected mailboxes window opens.

3. The selected mailbox or mailboxes from the selected group are already listed.

4. Click the Add to open the Select mailbox list. Move selected mailboxes to the Selected Objects
list. Then click OK. You can click Remove or Remove all to manage the selected mailboxes to
archive.
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B Archive messages wizard

Selected mailboxes

T acchive Manager for Exchange

RDM
Administr abor

Select mailbox

Display name
Adrniniskrator

Type in the name or select From list:

If_-'j Lou Florence: low.Florence lou. florence@40demoz. local ~
<| [ =~ >

Display name Alias email address ~
[} user013 user0l3 user0]13@40demoz local
[ user014 user0ld user014@40demo local
If:_'l user01s user0l15 user015@40demoz local
If_-'j userdle userle userD16@40demoz. local
I:'l userdl7? user0l7? userD17@40demoz. local
f:_’l user01d user018 user18@40demo?. local
[ user01g user01s user019@40demcz local
[ user0z0 user0z0 userl20@40demcz local =
( aad “D P | | Remove al | (5 320y McLean Jerry,Mdean clean@40demo2 . local
ha ——— If:_'l Marianne Peters marianne. peters marianne . peters@40demoz local

¥ o
Selecked objects: -

f:_’l Adrminiskrator
f:l Jerry Mclean

_

5. Click Next. The Select archive options window opens. You can choose to archive all message
items or set filters for messages and folders:

e For message filtering

Select the options as described below:

a. Archive all messages - To archive all messages

b. Filter messages - To archive messages based on message classes.

1 | NOTE: The selected message classes must be set as supported message
classes in View > Manager > Settings > Message classes. If they are not
supported or excluded, they will not be archived.

Click Filter to open the Message filter window. Select the options as described
below:

o All supported message classes - all messages classes as defined.

o Selected message classes - select the message classes that you want to archive.
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B Archive messages wizard

Select archive options

B Archive Manager for Exchange

E. iy jiliag]
Archive all messages

@) Filter messages [<none ® Al supported message classes

() Selected message classes

Message filter

FOTHEPILET [/] Mote
Past
Drocurnenk:

® archive sl Folders

y Filter <nones
() Filter Folders | I — [ appointment
I:‘ Conkact
[ Task

HE e

e Forfolderfiltering

Select the options as described below:
a. Archive all folders switcher.

b. Filterfolders - To archive messages from specific folders

Click Filter to open the Message filter window. Select the options as described
below:

o Include mail folders —all mail folders (Inbox, Sent Items, Drafts etc.) in the
mailbox will be archived, including user defined mail folders

¢ Include non mail folders —all non mail folders will be archived (e.g. Tasks,
Calendar etc.)

o Default folders - select specific default folders.

B Archive messages wizard

Select archive options

B Archive Manager for Exchange

E Message filter

O allfolders
() archive al messages

(®) Filter messages <nane > @ Selerted folders

£ v 1nclude mail folders
£3 [ Include rnan mail Falders

Diefault folders:
) archive all folders 5[] 1nbox

[ (®) Filter folders Filter ] <none [ [#] sent Trems
&1 [ Deleted Items
@] [] Drafts

m [] calendar

5 o
8[| Contacts

B Jounal
o] [ Mates

6. Click Next. The Retention category window opens. Select a retention category from the
dropdown list.

7. Click Next. The Summary window opens.
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8. Click Start. When the process completes, click Finish.

Archiving items in a mailbox or folder

You can archive all items in a mailbox or folder. For archiving items in public folders, see

Archiving items in public folders.

To archive all items in a mailbox or folder:

1. In Archive view, click on the Mailboxes tab.

2. Find the mailbox or folder in the left pane. You may use the Look for combo box.

3. Right-click the mailbox or folder. From the context menu, click Archive mailbox or Archive

folder.

Archive Manager for Exchange

Session  MWiew  Tools  Help

FRBme X Db EBeaoe

+1-{7) Contacts

|7 Conwersation Action
|7 Deleted Items

|7y Drafts
=1-{7) from Sandra

5 mhox | Archive folder |

-7 Junk.E

5 Journal 3 Restore folder s

{7 Motes
{7 Outbo
-7 Quick 5
|7y RS5 Feg
-7 Sent Tte:

Refresh itemn list

Repair shortcuts
Promote delayed shortcuts

Promote backup shorbcuts

-7y Tasks

Malboxes | Archive | Public Folders || Public Folders Archive
Look For: Filter in: Filter bext:
iser| w | | <nafilker = A | [] (Blarks)
—|-4¥ Search results ~ From Subject
=) Adrinistrator [1] =1 Admiristrator anything that went on that evenir
{5 Calendar ﬁ Adrinistrator universal historians sometimes, wl

4. the Archive Options window opens. In the Retention category dropdown select a retention

category.

5. Click Archive. The Processing result window opens. When the process completes, click OK.

Processing result

Mumber of ikems: 1
Processed items: 1

Processing finished.

Archiving specific items

You can archive specificitems in a mailbox, use the Mailboxes tab. To archive specificitemsin
publicfolders, see Archivingitems in Outlook public folders.

To archive specific items in a mailbox:

1. Click View on the Archive Manager for Exchange menu bar. Select Archive.
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2. Click on the Mailboxes tab.

3. Find the mailbox in the left pane. You may use the Look for combo box for that purpose.
Simply enter the name in the Look for combo box and then press Enter.

If you enter, forinstance, the letter "a” and press Enter, a list of all users whose mailbox name
contains the letter "a” will be displayed.

If you enter, forinstance, the asterisk "*” and press Enter, a list of all users will be displayed.

Archive Manager for Exchange FEFR

Session View  Tools  Help
FRERX Do P aon
Maiboxes || Archive || Public Folders | Public Folders Archive
Laok For: Filter in: Filter text: Messages
|"‘ v | | =nofilker= v| [ (Blanks) | Displayed 10
+@| SEA Pilate ~ From Subject Received Size
—@I test =1 Administrator arything that went on that evening. T...  26.08.201315:33:33 982
=I-[}) Admiristratar [1] ﬁ‘? Administratar and he gave way to an old man's sob. 26.08.201315:33:33 895
D) Calendar 51 Administator "Boiiz, come here." said she with asl..  26.08.2013 15,3333 321
2 Conkacts El & Administrator was ho one beyond the ditch now, 0., 26.08.201315:39:33 905
-0 EDF‘;E;;":'E” A2 administator reinin, and tuming back drew up at th...  26.08.2013 15:39:33 522
g e B Administrator his company. The crowd of Russians .. 26.08.201315.39:32 863
= Il:bao): ﬁ Adrniniztrator was a profound one. And it iz even m 26082013 15:33:32 1202
£ Journal ﬁ Adminiztrator Chigiriri talks. Piere pondered over th 2608.207131539.32 947
) Junk Email Gl Administator uriversal historians sometimes, when i, 26.08.20731539:32 1254
) Notes ﬁ Administratar face. 26.08.201315:39:32 13M
{7 Outbox
i) Quick Step Settin
--{7) R535 Feeds
{7 Sent Items
--{[7) Tasks
{7 Working Set
@3] SEA Pilote
—If:‘ user0ol [2]
i i) Calendar i
< m >
| St filker | | Clzar Filker
m
@ a | Server Role: &rchive Server Folder contents loaded Full&ccess Archiver/Restorer

4. Double-click the required mailbox, e.g. Administrator, to expand its subfolders and then click
on the one (e.g. Inbox).

5. Select the items in the right pane and then click on the Archive icon on the toolbar, or right-
click the item and then click Archive item in the context menu.

Archive Manager for Exchange PEER

Session

Wiew

Tools  Help

FRREeX DeRPReaae

Mailboxes | Archive | Public Folders || Public Folders Archive
Laook For: Filker in: Filter text: Messages
"" w | | =nofilker > v| [] (Blanks) | || Displayed 10 out of 10
+@| SEA Pilote - From Subject Received Size
—@I kest (=1 Administrator anything that went on that evening. T...  26.08.201315:33:33 982
= [} Administrator [1] & Administrator and he gave way to an old man's sob. 5
: A - ]
S|l @ adminsrafld  Archive item 1 26.08.201315:39:33 905
(51 Administratd @3 Restore itern a3 26.08.201315:39:33 9.22
(=0 Administratd : 26.08.2013 15:39:32 B8E3
Gl Administratd Repair shortcut 26.08.201315:39:32 1202
Gl Administratd Promote delayed shortcuts 26.08.201315:39.32 9.47
G Administratd Promote backup shortcuts 26.08.2013 15:39:32 1254
Gl Administratd 26.08.2013 15:39:32 13m
Refresh itern list for folder Inbox

6. The Archive Options window opens. In the Retention category dropdown select the retention
category. The basic characteristics for each category (HSM Schema, Retention time and Delete
time) will appear below the dropdown box.
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1 | NOTE: If no selection is made in the Archive Option window, the default retention
category will be used for the archived item.

E Archive Manager for Exchange

Archive option

Retention category:

i3 months | W
H5M Scheme: 1

Retention time: 3 months

Delete time: Mot defined

_| archive || Cancel |

7. Click Archive. When archiving is complete, the Processing result window will be displayed.
Click OK.

Processing result

e Fracessing finished.
W number of tems: 1
= Processed items: 1

8. The archived item will be displayed with a different icon as shown below.

Archive Manager for Exchange FEF®
Session View  Tools  Help
FlmBaXDeaBzgaen
Mailboxes ” Archive " Public Folders " Public Folders Archive ]
Look For: Filter in: Filter text: Messages
|* v | | <no Fikers v| [] Blanks) | H Displayed 10
@I SE4 Pilate A From Subjeck Received T Size:
E@I test (=1 Administiatar arything that went on that evening. T...  26.08.201315:39:33 982
=5 Ler Adrinistrator [1] @ and he gave way to an old man's sob, 26.08.2013 15:39:33 895
) Calendar a8 “Boil ne h ith a sl g
D Contacts &5 was o one beyand the ditch now. 0. 26.08.2013 15,3333 305
-2 Co:werdsatlon A =1 Administiatar rein in, and tuming back drew up atth...  26.08.201315:39:33 922
ministrator is company. The crowd of Russians ... .08, :35:
: ggei:e Trems 1 Admini hi The crowd of Fussi 26.08.2013 15:33:32 gEa
ministrataor was a profound ane. And it is even m... .08 139
E}In"‘;: Ad fourd one. And 26.08.201315:39:32 1202
ministratar igirin talks. Pierre pondered over th... 5. 133
) Jouml Admin Chigirir talks. Pi dered h..  26.08.201315:33:32 9.47
{£3) Junk Email &l Administiator universal historiang sometimes, when i 26.08.2013 15:33:32 1254
i3 Notes ﬁ-ﬁ Administator face 26.08.2013 15:39:32 13m

Restore wizard

Users may have deleted the shortcut of an archived item simply by clicking SHIFT + Delete on the
keyboard or by clicking the Delete icon on the Outlook toolbar.

1 | NOTE: This not the same as clicking the Delete archived messages icon and selecting Delete
from archive option, which is an Archive Manager Outlook AddIn feature.

In such cases the archived items are lost for the user. However, these items still reside in the
HSM store until their retention period expires. Such lost items have a blue icon on the Archive

Quest® Archive Manager for Exchange Administration Guide

194
Archive view



tab. They can be recovered manually by the administrator only on the Archive tab and lost items
from several mailboxes can be restored on the Mailboxes tab.

In this topic:

e Restoring all lost items in several mailboxes

e Restoring lostitems in several mailboxes by type

To restore all lost items in several mailboxes:
1. From the Archive view click on the Mailboxes tab.

2. Find one of the mailboxes in the left pane. You may use the Look for combo box for that
purpose.

3. Right-click the mailbox and select Restore Wizard from the context menu. The Restore
Mailbox wizard starts and the Select restore type window opens.

4, Select Restore lostitems and click Next.

& Restore mailbox wizard

Select restore type

(®) Restore lost items

Select this option to restore messages which were deleted from the
mailbox

() Restore items filtered

Select this option to restore messages from archive while you can filter the
messages you want to restore

_ ‘ - BaCK : Wit Cancel

5. In the Settings window click Add to add more mailboxes.

¥ Restore mailbox wizard

Settings for lost items restore

Selected maiboxes:

Administrator [1]
[] Mark the document as deleted after restore
Create shortcut

ﬁ Filter

Filter out the messages

— ermleales

6. The Select mailbox window opens. Move selected mailboxes to the Selected objects list. Click
OK.
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7.

8. To restore specificlost items in the selected publicfolders, click Filter to set afilter. Itis a

9.

M Archive Manager for Exchange

Select Mailbox

Type in the name or select from list:

i =

Display name
[ Administrator
f’_:’l Aman Al

[ David Webb
[} Devika sharma
f_:’l Ishna Mohan
() Juan Christie
[ Karl Jordan
f’_:’l Miki Portman
f’_:ﬁ Nina Tanaka
[ Pablo Neruda

[T S PR

<

Alias

domadmin
amanali
davidwebb

devikasharma

ishnamohan
juanchristie
karljordan
nikiportman
ninatanaka
pabloneruda

R

emai address

domadmin @democorp,com
amanali@democorp.com
davidwebb @democorp.com
devikasharma@demacorp.com
ishnamohan @democorp.com
juanchristie @democorp.com
karljordan @democorp.com
rikiportman @democorp.com
ninatanaka@democorp.com
pabloneruda @democorp. com

PR Y S

Selected objects:

¥

»

In the Settings window all selected mailboxes will be displayed in the Selected mailboxes list.
Choose one of the following options:

a. Mark the document as deleted after restore - lost item(s) will be restores and displayed in
the user’s mailbox as non-archived; all versions of the lost item(s) will be marked for
deletionin the archive.

b. Create shortcut - shortcut of the item(s) will be displayed in the user’s mailbox and all
versions will be accessible.

search-based filter. You can filter by sender, subject and other parameters. Specify your filter

parameters and click Start search in the filter window. Then click Apply.

“+ Search based filter ©®

Messages | Settings

Find items that match these criteria:

And/Or  Field
+ Add new dause

Cperator

Value

Search only in the following mailboxes

|Adminish'ator

Start search

In the Summary window click Evaluate if you want to display the number of lost items to be

processed. Then click Finish.
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¥ Restore mailbox wizard PERR

Summary @

Sumnmary:

Processing mailboxes: 2 ~

- Administrator [1];Lou Flarence [24]

- will create shortouts

- Filker is applied

w

- - BaCK | | F‘n‘Sh | | Cance'

To restore lost items in several mailboxes by type:

1
2.

In the Archive view click on the Mailboxes tab.

Find one of the mailboxes in the left pane. You may use the Look for combo box for that
purpose.

Right-click the mailbox and select Restore wizard from the context menu. The Restore Mailbox
wizard starts and the Select restore type window opens.

The Restore mailbox wizard opens. Choose Restore items filtered and click Next.
In the Settings window click Add button to add also other mailboxes.

The Select mailbox window opens. Move selected root public folders to the Selected objects
list. Click OK..

In the Settings window all selected mailboxes will be displayed in the Selected mailboxes
list.

Mark the document as deleted after restore - if selected, restored messages will be marked
for deletion in the archive.

Click Filter message class to choose the message classes to restore. In the Message filter
window, select the message classes that you want to restore and click OK.

1 | NOTE: The selected message classes must be set as supported message classes in View
> Manager > Settings > Message classes. If they are not supported or excluded, they will
not be archived.

Click Filter to open the Message filter window. Select the options as described below:
o All supported message classes - all messages classes as defined.

¢ Selected message classes - select the message classes that you want to archive.
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B Archive Manager for Exchange B

Message filter

O all supported message classes

(®) Selected message dasses

Moke

Post
Document
[ appointment
|:| Contack

[ Task

B

9. You can also filter messages by date when they were received or modified with the following
options.

a. Select Filter by date.
b. Select Receive date or Modification date

c. Click Change filter. In the Filter by date window specify after, before or between from the
Date dropdown. Then enter the date and click Apply.

ﬂ} Restore mailbox wizard @ H L’:i
Settings for restore @

Selected mailboxes:
Administrator [1]

add  |[ Addal [ clear |
[ Mark the document as deleted after restore @ Filter by date =
Date filter

Filter out the messages you want to restore

Filter by date i i
& ¥ (® Received date Chanage Filker 07.10.2022 17-12:5, =

() Modification date

_

10. Click Next. In the Summary window click Finish.

When the processing completes, you can check the restoration result. Next to every restored
mailbox folder you can see the number of all folder items, number of items processed and
number of errors. For example, "Folder Inbox processed 125/19/0".

If no items satisfy the entered criteria, no summary is displayed.

11. Click Close.

Restoring specific items

To restore individual items, use the Mailboxes tab in Archive view. To restore items in public
folders, use the Public folders tab. For more information see the section Public folders tab

(Archive view).
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To restore individual items:
1. In Archive view click on the Mailboxes tab.
2. Find the mailbox in the left pane. You may use the Look for combo box for that purpose.

3. Double-click the mailbox to display its subfolders. Select the folderin the left pane. Its
content will subsequently be displayed in the right pane. Only the left pane is active for
switching between folders.

4. Right-click the archived item in the right pane and then, in the context menu, select Restore
item. You can also select the archived item and then click on the Restore icon on the toolbar.

Archive Manager for Exchange PFERRR

Session  Miew  Tools  Help
FlERXDeg Dz e
Mailboxes || Archive || Public Folders | Public Folders Archive

Look For: Filter in: Filter text: Messages
|"‘ v | | <nofilkers= v | [] (Blarks) | | | Displayed 10
+@| SEA Pilobe ~ From Subject Received Size
—@I test = Administrator arwthing that wert on that evening. T...  26.08.201315:39:33 982
ﬁ Adminiztrator and he gave way to an old man's zob. 2608.20131539:33 8595
@ Alministr zbar ! e bare ! oid cha itk o ol el {
=1 Administy ] Archive item 36.08. 33
=0 Administy @3 Restore item M, . 26.08.201315:39:33
=1 Administ &3 26.08.201315:33:32
&1 Administ Repair shortcut 26.08.2013 15.35:32 1202
G Administ Pramote delayed shortcuts 26.08.201315:39:32 .47
G Admivist Promote backup shortcuts 26.08.201315:39:32 1254
ﬁ Adminishy 26.08.201315:39:32 130
[#1 Dafrach itam lick fav faldar lnbaw

5. The Restorer options window opens. If you select the Delete all versions of the document
checkbox then all versions of that document in the HSM store will be marked for deletion and
can be deleted with Delete Files job when their retention time elapses. If the checkbox is not
selected, versions will be displayed as lost on the Archive tab of Archive Manager for
Exchange. Click Accept.

Restore

Restore options

[[] Delete all versions of the item

6. When restoring is complete, in the Processing result window click OK. The respective item
will be restored and its icon will change, too.

1 | NOTE: When restoring an item having several versions archived, those versions will be
displayed in the right pane. You may choose to restore any of those versions.
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Archive Manager for Exchange PERR

Session Wiew  Tools  Help R
BXIDRSDOE RN Versions
Mailboxes H Archive H Public folders " Public Folders Archive | \
Look For: Filter in: Filter kext: Messages ersion | Subject
I”‘ j |<n0 Filker = j | | Displayed: 31, total: 31 | =] Fs Mulkipl
@] Tech Support - | From | Subject | Received | Size NER Fuld: Multip
2] TelnetClients (=4 stv_exchange Latest documentation 20,01.,2009 15:07:31 456.2 KB
£ Terminal Server License = [] sandraBullack Tentative: Strategic mesting  07.07.2008 10:42:34 974 B
Test & AlPacino Updated documentation 13.06.2008 12:30:45 254 KB
2] testgroupt (2 SardraBulack  Fu: hi 23.10.2007 16:07:31 593,42 KB
2] testgraup? 5 Administrator P 08.10,2007 11:16:49 576 k8
Users o = Nio again best 20,09,2007 14:15:34 1.52 MB
'%m:'l';::: Adthorization & || oy, test2 20.09.2007 14:14:22 412,89 KB
g ;3 Mel Gibson Install guide 11.09.2007 14:11:58 Z13KE
= g?sar;;_;;sl::::mr [4] (=1 userool 15.08,2007 09:49:34 457, 33 KE
[i@ archive ;'Q sry_exchange 2‘6 B
nge ng
. g Ez:f;dcf; ;3 srv_exchange Fwi: Administrakor guide
[ Deleted Ttems &1 srv_exchange Fid: erhrt 15.08.2007 09:29:56 1.96 KB
-{C7) Drafts ﬁ srv_gsechange Fi: erhrt 15.08,2007 09:23:56 1.96KE
B0 Tmport &l usertod Backup 31,07.2007 12:00:20 2.33KB
#-7 Inbox & usernnd Backup 31,07.2007 12:00:20 233K
{7 Journal ;} sry_exchange 31.07.2007 11:568:17 3.29K6
{7 Junk E-mail e g} sry_exchange pickure 18.07.2007 13:02:59 3.35KB
{5 Motes & srv_exchange akjhi 17.07.2007 15:22:29 AEEKE
{3 Others (=1 Admiristrator 17.07.2007 15:17:54 1.38 MB
-3 Outbax 5 Administrator 17.07,2007 15:17:54 1,33 MB
{0 Sent Dtems |2 adninistrator 17.07.2007 15:17:54 138 MB
o D svne s _’l_l 2 administrator 17.07.2007 15:17:54 138 MB
D Syskem Adminis...  Undeliverable: hello 17.07.2007 09:53:32 630,07 KB
| Set filter ‘ | Clear filter ‘ ‘]\ Eomchus ozl sbthibon o AE_OF SONT_A20A0, = I'EILI 3 5
] ﬂ Folder contents loaded Fullaccess Archiverf/Restorer

Restoring items in a mailbox or folder

Restoring of all items in a specific mailbox or folder is done in Archive view on the Mailboxes tab.

1 ‘ NOTE: To restore items in a public folder see Restoring lost items.

To restore all items in a mailbox or folder:
1. In Archive view, click on the Mailboxes tab.

2. Find the mailbox or folder in the left pane. You may use the Look for combo box for that
purpose.

3. Right-click the mailbox or folder in the left pane and then, in the context menu, click Restore
folder/Restore mailbox. You could also select the folder in the left pane and then click on the
Restore icon on the toolbar.
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Archive Manager for Exchange

Session  Miew  Tools  Help
FRBRRXIDYGS B aen
Mailboxes " Archive " Fublic Folders " Public Folders Archive ]
Look For: Filter in: Filker bext: Falders
Liscr| w | | <nafilker = v‘ [] (Blarks) ‘ || Displayed 15 out of 15
@ Distribution lists ~ Falder
@] Domain Admins I3 Colendar
@] Domain Users ) Contacts
] Managed fvaiabiity Ser L3 ContactsH0BIE77S3-274D-40B2-43EB-D7FIET...
=& EZW ) Contacts/{A9F 2BCA6-B340-4243-8315-500 991
[=] .
= Q Archive mailbox |e.nl Cache
tion Settings
2 E|"j Restore rrailbox |
E Refresh item list g
- Repair shortcuts
i Prarmote delayed shortcuts
E Prormote backup shortouts
-l Refresh mailbox
| Ayrchive wizard
.. E - .
] e P estore wizan
< m > |
| Set filker | | Clear Filker |
@ Server Role: Archive Server Falder contents loaded Full&ccess Archiver/Restorer

In the Restorer options window click Accept. If you select the Delete all versions of the
document checkbox then all versions of items placed in that mailbox or folder will be marked
for deletion in the HSM store and can be deleted with the Delete Files job when the retention
time elapses. If the checkbox is not selected, versions will be displayed as lost on the Archive
tab of Enterprise Manager.

Restore aplions

[ ] Delete all versions of the item

| Accepk

Cancel |

When restoring is complete, in the Processing result window click OK. All items placed in that
mailbox or folder will be restored.

Processing result B

@l Processing fin

k. -

ished.
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Repairing shortcuts

Shortcuts can be repaired when:
e some shortcuts are not working properly in Outlook

e general shortcut settings on Tools/Options/Archive settings/Shortcut tab were changed and
these new settings must be applied to all shortcuts of a group, mailbox or folder

To repair shortcuts for a group, mailbox or folder:

1. Inthe Archive view click on the Mailbox tab.

2. Right-click the group/mailbox/folder in the left pane of the window and select Repair
shortcuts option in the context menu.

Archive Manager for Exchange

Session  View Teols  Help

FlEBEeaXx Do B eaan
Mailboxes || Archive | PublicFolders | Public Falders Archive
Look for: Filter in:

\ﬂ ~ | | <no filter > ~ O
[ =88 Distribution lists —
i Group Accounts ) -
@ Group Democorp [ Administrator
@ Group Products [} Devika Sharma
@I h Do 1asekb

@l Al mailb 'B Archive mailboxes
@ Search r '-7:.3 Restare mailboxes

| Repair shortcuts

Archive wizard

Restore wizard

Refresh item list

Creating a shortcut for an archived item in a mailbox

In the Mailboxes tab on the Archive view some items can be displayed with the following icon:

i1 (delayed shortcut) or % (backup shortcut). This indicates that the email has been archived but
no shortcut was created for it. That happens when the email has been archived with retention
category which retains the original email or delays shortcut creation. It is possible to create a
shortcut for such email items in the Mailbox tab.

To create a shortcut for an archived item:
1. From the Archive view go to the Mailboxes tab.

2. Find the mailbox in the left pane. You may use the Look for combo box for that purpose.
Double-click it to expand its subfolders.
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3. Locate the item with a delayed shortcut or backup shortcut icon in the right pane. Right-click
the item and click Promote delayed shortcut or Promote backup shortcuts in the context

menu.

Archive Manager for Exchange PFEER

Session View  Tools  Help

FRRX DR Be aen

Mailboxes " Archive " Fublic Folders " Public Folders Archive ]

Look For: Filter in: Filter kext: Messages
|admin v | | <no filker > v| [ {Blarks) | || Displayed 10 aut of 10
+@| Domain Admins ~ From Subject Received % Size Atta
+@| Daomain Lsers (=1 uger002 dark-haired, remark.ably slim, pretty gil...  26.08.2013 15:39:32 298 MB
+@| Managed Avallability Sers ﬁ uzer002 occupy a position he had not himself ... 26.08.201315:39:32 8.892KB
+@| e Gl userll2 hwrry. “Howe can | think of the bright si.. 26.08.2013 15:38:32 917 KB
+@| SEA Pilote @ i [T TR N T KE
oG test Sl |G usemnz | Archive itern 26082013 153932 938 KB
=] Allmaibboxes B userlD2 [¥3  Restore itemn 26.06.2013 153932 BE3KE
= Search resuls 1 userd02 - 26.08.2013 15:39:31 T.EEKB
-2 Administrator [1] 51 userd02 Repair shortcut 26.08.2013 15:39:31 827 KB
(2 userdnl [2] c a0
_‘l 20z 3] B userdD2 ‘ Promote delayed shortcuts ‘ 26.08.201315:38:3 107 B2 KRB
| userl
) Colerdsr 1 useD02 Pramote backup shortcuts L\\g 26.08.20M315:33:31 927 KB
-7 Contacts . . .
) Corwersation Actian Refresh item list for folder Inbox
~{2) Deleted ltems . Showe all iterns
~{2) Drafts a i T
£ Inbox ow anly archived iterns
-3 Journal Show only not archived iterns
I Junk Email v
< m >
| Set filker | | Clear filter
m >
@i El Server Role: Archive Server Falder contents [oaded Full&ccess Archiver/Restorer

4. When the processingis over, click OK in the Processing result window.

Archive tab

This tab is used for

e to restore lost items that have no shortcut in MS Outlook, but they physically remain in the

HSM store during their retention time.

e as a mailbox browser
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Archive Manager for Exchange FEERR

Session  View Tools  Help
FRBREREXDRIQBE2 N

Mailboxes | Archive || PublicFolders | Public Folders Archive

Look for: Filter in: Filter text:
| | <no fiter> v| O (lanks) |
B@ Distribution lists Display name Alias Rudn e-mail address
%3] Group Accounts
@‘ Group Democorp [ Karl Jordan karljordan karljordan karljordan@democarp. com
@‘ Group Products [ Juan Christie juanchristie juanchristie juanchristie @democorp.com
@I Group Sales 2 1shna Mohan ishnamohan ishnamohan ishnamohan@democorp. com
@ Al mailboxes 2 administrator domadmin domadmin domadmin@democorp. com
+ Deleted mailboxes
i Search results
< >
| Set filker | | Clear Filker Maiboxes: 4 of 4
(=] ﬂ % Server Role: Archive Server Folder contents loaded Fullfccess Archiver/Restorer

The Archive tab has a navigation pane on the left and the detail pane on the right.

The navigation pane displays the following nodes:

o Distribution lists - this node displays the groups and the mailboxes contained in the groups
from Address Book Manager. Expand the node to view the groups and mailboxes.

o All mailboxes - this node displays all (active and deleted) mailboxes from Address Book
Manager. Expand the node to view the mailboxes.

o Deleted mailboxes - this node displays all deleted mailboxes from Address Book Manager. If
there are no deleted mailboxes then this node will be not visible. Expand the node to view the
mailboxes.

e Search result - this node displays the result of a search using the Look for field above the
navigation pane.

To locate a mailbox:

1. Enter a mailbox name in the Look for field. The names you enter are added to the dropdown
and available through the duration of the Archive Manager session. You can enter an asterisk
(*) to retrieve all mailboxes.

2. Click Enter on your keyboard. The results are displayed under the Search results node.

The detail pane displays the contents of the group or mailbox selected in the navigation pane.
You can filter the contents of the detail pane using the filter fields:

o Filterin - the dropdown presents predefined properties that you can use to search the contents
of the detail pane. The dropdown is contextual to the selection made in the navigation pane.
For example, if you select a group from the distribution list, the dropdown options available
are <no filter> and each of the columns available in the list such as Display name, Alias, Rdn and
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e-mail address. If you select a mailbox in the navigation pane, then the options available in the
dropdown are <no filter>and Folder.

e Blanks - select this checkbox to filter all results where a blank value is present for the selected
dropdown in the Filterin field. The Filter text field is deactivated.

o Filtertext - enter atextin this field to refine the filter based on text thatis presentin the
property selected in the Filterinfield.

1 | NOTE: Mailboxes have a unique identity number which is displayed in square brackets to
distinguish mailboxes in the case where two mailboxes have the same display name. The
unique identity helps the administrator to identify the correct mailbox.

Every item in the folder has its icon which represents the status of the item. You can open the
legend foricons when you click the @ Show legend icon from the toolbar. The Legend window
with icon explanation opens.

B Blue - archived items are lost, i.e. they remain in the HSM store at least during their retention
time but they have no shortcut in Outlook. User cannot reach them. Such lost items can be
recovered manually only by the administrator on this tab or on the Mailboxes tab.

1] Green - archived item has a shortcut in Outlook. It can be restored.

- Yellow - shortcut in the mailbox folder belongs to a different user.

Restoring lost items

Users may have deleted the shortcut of an archived item simply by pressing the SHIFT key along
with the Delete key on the keyboard or by clicking on the Delete icon on the Outlook toolbar and
not by clicking on the Delete archived messages icon and selecting Delete from archive option,
which is an Archive Manager Outlook AddIn feature.

In such cases those archived items are lost for the user. They cannot be reached by the user, but
they still reside in the HSM store at least until their retention time expires. They can be
recovered manually by the administrator only. Such lost items have a blue icon on the Archive
tab.

On this tab the administrator can restore:
e one lostitem
e all lostitems of a folder

e all lostitems of a mailbox

1 | NOTE: In all three cases mentioned above the administrator can restore one or more items
to another folder or a mailbox (see Restoring lost items to another folder ). For restoring
lost items in several mailboxes at once, see Restore wizard)




To restore one or more lost items:

1. Click View on the Archive Manager for Exchange menu bar. Select Archive. Then switch to the
Archive tab.

2. Inthe left pane find the user whose lost item(s) you want to restore. You can use the Look for
combo box where you do not must enter an exact name of the user.

3. Torestore ONE LOST ITEM, open the folder in which the shortcut to this item was originally
kept. A list of all items of the folder will be displayed in the right pane. Right-click the lost
item (blue icon). In the context menu select Restore lost item.

To restore ALL LOST ITEMS OF A FOLDER right-click that folder in the left pane. In the context
menu select Restore lost folder items.

To restore ALL LOST ITEMS OF A MAILBOX right-click that mailbox in the left pane. In the
context menu select Restore lost mailbox items.

1 | NOTE: To display lost items only, right-click in the right pane and, in the context menu,
click Show only lost items.

Archive Manager for Exchange PFERERR

Session  Miew  Tools  Help
FRlReaX DaRleaas
Maiboxes || Archive | Public Folders || Public Folders Archive
Look for: Wersion  Subject Cre
|| <nofilters (Blanks) ‘ H existed only in the head... 1)1
@ Distribution lists Fram Subject Recetved Size Atk
El-@l graup0z
=) _(1’ user00l [20] B userni1 of the heap, something indestruckibl, .. 2/3/2021 3:04 PM 14,95 KB
T‘"\.:l Calendar B usern1t Following the superintendent of polic...  2/9/2021 3:04 PM .96 KB
{7 Contacts B userniy To understand the laws of this conti,.,  2/2(2021 3:04 PM 229,72 KB es
|7 Conversation Action [} usernii a f a donac Sini 10 it 17 o
|3 Deleted Items B usernl1 Restore st item
15) Drafts EH user0lt "0n the 4th, the first courier arri Restare lost item to
{7 ExternalContacts B usernit little hand,
7 Inbox B usernit elsewhere, he was surrounded b Show all iterns
-1 Journal B userni1 shouted "Hurrah!" and "Wive IEmy Showy only lostiterns
~+{2) Junk Emai B usernn scrutiny, es
- Motes B usern1t trace of you remain here!,.." Archive Wizard
1) Outbox B usernin His Serene Highness has passed Restare Wizard
-+ Sent tems BH usernii Kaluga road and began to enter . es
-|5) Tasks Refresh item list for folder Inbox
() Yammer Root B usernin by & sword,
(3 userntz [15] B usern1t serfs ta the Three Hills quarter of M., 2/9/2021 2:59 PM 12,57 KB
(':, Userni3[18] B userntt the distance in that birch and fir fore... /92021 2:59 PM 12,24 KB
(1 usernia[17] BH usernii s, then..." 2{9/2021 2:53 PM 17.07 KB
..(:» userdls [16] B userni1 thought--teferring to the little prince...  2/3/2021 2:59 PM 812 KB
(:t userdle [15] EH usernit three weeks surrounded by a court b, 2/2/2021 2:59 PM 8.15 KB
(:r user017 [14] B usero1t anvything else. ... You have not been..,  Z/9/2021 2:59 PM 20,69 KB Yes
[ user018[13]
[ usern1a[12]
[ usernzo[11]
- Al maiboxes
EF Search results
< > < >
| Set: filter ‘ | Clear filker Page: of 1 Messages: 1 - 20 of 20 K < > A < >
@& ﬂ ™| Server Role: Archive Server Folder contents loaded Fullfccess Archiver/Restorer

4. Inthe pop-up Restore window choose between two Restore options:

a. Delete all versions of the document checkbox —all versions of the lost item(s) will be
marked for deletion in the archive, and the latest one will be displayed in the user’s
mailbox as non-archived.

b. Restore shortcut only checkbox —shortcut of the item(s) will be displayed in the user’s
mailbox and all versions will be accessible
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1 | NOTE: If no option is checked, email is returned to the user’s mailbox as non-archived
and its versions, if any, are displayed as lost in Archive Manager for Exchange.

Restore opkions

[ ] Delete all versions of the item

Reskaore shorbcut only

_ | Accept || Zancel |

5. Click Accept. The respective archived item will be restored to the folder its shortcut had been
deleted from.

6. When restoring is over, in the Processing result window click OK.

Restoring lost items to another folder

Using this option lost items can be restored to a mailbox different from the original one.
However, when only shortcut is restored (i.e. not the original message) to a different mailbox,
the mailbox user is not the owner of such item. It means that the user will not be able to delete
or modify the archived item using that shortcut. The user will be able to restore the shortcut and
perform the changes but cannot control the archived counterpart. On the Archive tab such item is
displayed with a yellow icon L.

To restore lost item(s) to a folder or a mailbox different from the
original one:

1. Click View on the Enterprise Manager menu bar. Select Archive. Then switch to the Archive
tab.

2. Inthe left pane find the user whose lost item(s) you want to restore. You can use the Look for
combo box where you do not must enter an exact name of the user.

3. Torestore ONE LOSTITEM, open the folder in which the shortcut to this item was originally
residing. A list of all items of the folder will be displayed in the right pane. Right-click the lost
item (blue icon). In the context menu select Restore lost item to.

To restore ALL LOST ITEMS OF A FOLDER right-click that folder in the left pane. In the context
menu select Restore lost folder items to option.

To restore ALL LOST ITEMS OF A MAILBOX right-click that mailbox in the left pane. In the
context menu select Restore lost mailbox items to option.

1 | NOTE: If you want to display lost items only, right-click in the right pane and, in the
context menu, click Show only lost items.
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Archive Manager for Exchange PFERR

Session Miew  Tools  Help

FRRBX DY E® ]an

Mailboxes || Archive | Public Folders || Public Foldars archive
Look Far: wersion  Subject Cre
v | | <nofiters {Blanks) ‘ i existed only in the head... 1)1
@g]%tnhuhngzhsts Fram Subject Received Size: Atka
- groupl
(2 useront [20] B usernii of the heap, something indestruckbl...  2/9/2021 3:04 PM 14.95 KB
" B userni1 Following the superintendent of polic...  2/3/2021 3:04 PM 9,96 KB
{[7) Calendar
H-{[3) Contacts B usernit To understand the laws of this conti,., — 2/3/2021 3:04 PM
(7 Conversation action| | I SIECHE N exi il in th 5 ;
() Deleted Items B userni There was no o estore lost item
—{(5) Drafts B userni1 "On the 4th, the Restare lost item to 12.06 KB
{5 ExternalCantacts B usernit little: hand. 9.64 KB
¥ | Sh 11 it
- Inbox B usern1t elsewhere, he WE o all ftems 12,66 KB
-2 Journal B usernin shouted "Hurrah! Show only last items 10.39 KB
{2 Junk Email H usero1l scruting. eTre— 100,48 KB Yes
i) Notes B usernn trace af you rem 14,89 KE
g S“tf?t" B useroil His Serene Highn Restore Wizard 12.16 KB
ent Items
{5 Tasks B userott kaluga road and Refresh item list for folder Inbox 552.6 KB es
(=) Yammer Root B usernil by & sword, — 14.16 KB
- user01z [19] B usernin serfs to the Three Hills quarter of M., Z{9f2021 2:59 PM 12,57 KB
f:‘ userD13[18] B usern1t the distance in that birch and Fir Fore...  2/9/2021 2:59 PM 12,24 KB
=y B usernin s, then..." 2/9/2021 2:59 PM 17.07 KB
() usern14[17]
-[h user015 [16] BH usernii thought--referring to the little prince...  2/9/2021 2:59 PM 812 KB
(:t user0i6 [15] B userni1 three weeks surrounded by a court k.., 2/902021 2:59 PM 8.15 KB
[ usernl7F [14 B usero1t anything else. ... You have not been...  2/9/2021 2:59 PM 20,69 KB Yes
[14]
() usern15[13]
() usern1a[12]
(7 userozo[11]
]--@I All mailboxes
- Search results
< >« >
| Sek Filter ‘ | Clear filker Pags: af 1 Messages: 1 - 20 of 20 K < o < 5
@ ﬂ 5| Server Role: Archive Server Folder contents loaded Full&ccess Archiver/Restorer

In the pop-up Restore To window choose between two Restore options:

a. Delete all versions of the document checkbox —all versions of the respective lost item(s)
will be marked for deletion in the archive, and the latest one will be displayed in the
user’s mailbox as non-archived.

b. Restore shortcut only checkbox —shortcut of the respective item(s) will be displayed in the
user’s mailbox and all versions will be accessible.

1 | NOTE: If none of the options is checked, email is returned to the user’s mailbox as non-

archived and its versions, if any, are displayed as lost in the Enterprise Manager.

Then click the Change button to specify the destination where the item(s) will be restored.

In the Mailbox folders pop-up window define a mailbox (using the Change button) and a
folder of that mailbox where the lost item(s) must be restored. If the folders are not
displayed, click Refresh. Click OK.
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7.

Restore To

Restore options
Destination:

x|
& Mailbox folders B

[] Delete all versions of the item

[T restare sharkeut only

{{3) Recipient Cache E
et [ caneel || o Conversation ction settings

I| Change | Wailbo:
|ndministratnr || Change. .. || Refresh |

Mailbox Folders:
{7 Calendar ~
(=) Contacts
@ {06967 759-2740-40B2-A3EB-DFFET 372707
{7) {A9EZBC46-B3A0-4243-6315-600991 004455+

{73 GAL Contacts

{7 Deleted Items

"=

(=145 from Sandra
[T e

{7 Inbasx

-3 Journal

{3 Jurk Email

{3 Motes

;
_

In the Restore To window the selected folder is displayed in the Destination field. Click Start.

Then OK.

Restore To [~

Restore oplions
Destination:

Mailbos: Administrator [1]
Folder: Drafts

[ ] Delete all versions of the item

Restore shortout only

e

| Change

Restoring mailbox folders

When mailbox folders or sub-folders with archived items are deleted, the information about the
folder structure is available to Archive Manager. The entire folder structure can be restored.
Deleted folder names appear in blue color.

To restore the folder structure:

1.

2.

Select the root node of the deleted folder structure.

Right click and select Create folder structure from the context menu. The folder structure will
be restored along with any archived items in those folders and the folder names will be
displayed in normal black color.
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Public Folders tab

You can archive and restore items in a Public Folders manually. Manual archiving and restoring of
the items in public folders requires additional permissions.

Granting permissions to the super-user

1. Open Microsoft Exchange Administrator Center.

2. Click public folders and then click the public folders tab.

3. Select a publicfolder from the list (click through sub folders to reach a descendant sub-
folder). Then click Manage under Folder Permissions on the right.

Exchange admin center

public folder mailboxes

public folders

ompliance management + Te -
o \hccounts-News\Conference 3]
SUBFOLDER ... & | HAS SUBF.. MAIL ... MAILBOX
Vendors No No pfmbx-democ.

public folders
unified massaging

Servers

hybrid

0 selected of 1 tota

4. Inthe pop-up window click Add (plus sign). Then click Browse to select the super-user that

you have configured in Archive Manager.

= Public Folder Permissions - Google Chrome |;|i-

@ amxexch/ecp/PublicFolders/PublicFolderPermissions.aspx?pwmcid=28L..
Conference

Add or remove users who can access this public folder and edit their permissions. -
+ |75 =

NAME PERMISSIOM LEVEL siD

O Apply changes to this public folder and all its subfolders.

Cancel

Mail settings - Disabled

Enable

Folder permissions

Manage
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5. Set Permission level to Owner. Then select the Folder owner option.

= Public Folder Permissions - Google Chrome |;|i-

@ amxexch/ecp/PublicFolders/PublicFolderPermissions.aspx?pwmcid=28L..
public folder permissions
*User:

domadmin Browse..

Permission level:

Cwner V]
Create items Folder owner
Read items Folder contact
Create subfolders [ Folder visible
Edit own Delete own
M Edita 3 Delete all
Save Cancel

6. Click Close in the confirmation dialog and then click Save to exit.
7. Toverify the permissions, open your Outlook client and follow the steps below:

a. Copy any archived email into that public folder: select an archived email and press CTRL
while dragging that email into that public folder. Then try to restore it. Only for this mail
item (an mail items that were previously archived with this process), you will get a warning
message saying "Failed to restore 1item".

b. Forall otheritems subsequently archived to the publicfolder, archiving (as well as
restoring) will work properly.

After completing this process you can archive and restore items with the MS Outlook using
Archive Manager Outlook Addin, the Public Folders tab using toolbaricons or the context menu
as described in the following topic.

Archiving items in public folders

Administrators can archive several public folders at once and apply archiving filters for message
types.

1. Inthe Archive view click on the Public Folders tab.

2. Right-click a publicfolder and select Archive wizard from the context menu. The Archive
messages wizard starts and the Selected mailboxes window opens.

3. The selected publicfolders from the selected group are already listed.

4. Click the Add to open the Select mailbox list. Move selected root public folder mailboxes to
the Selected Objects list (you will see more roots public folders if you are managing more than
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one exchange servers from the AMAC). Then click OK. You can click Remove or Remove all to
manage the selected mailboxes to archive.

. Click Next. The Select archive options window opens. You can choose to archive all message
items or set filters for messages and folders:

Select the options as described below:
a. Archive all messages - To archive all messages

b. Filter messages - To archive messages based on message classes.

1 | NOTE: The selected message classes must be set as supported message
classes in View > Manager > Settings > Message classes. If they are not
supported or excluded, they will not be archived.

Click Filter to open the Message filter window. Select the options as described
below:

o All supported message classes - messages classes as defined
e Selected message classes - select the message classes that you want to archive.

. Click Next. The Retention category window opens. Select a retention category from the
dropdown list.

. Click Next. The Summary window opens.

. Click Start. When the process completes, click Close.



Restoring archived items in public folders

Eﬂ -"_‘E-I s Public Folder - Public Falders - Administrator@40derno.local - Outlook T E - O X
HORE SEMD S RECENE FOLDER WIEYY
* lj Ignare x b3 '-\4 E\% t’-\/] 2 Mesting U Mawe to: 7 ¥ Mave - (= Unread/ Read | Search People
E_ — — E
N ‘I\T’j Clean Up Del P « Renks R Ie . 9‘1 =R Manager v t=Rules~ ==| Categorize * [EE address Book
e ey elete ast eply  Reply Forward [5 - - ; .
Post  lermns - aﬁ"m”k' Feply Al EEMnre E Team Emall - .,m OneMate  |* Follow Up~ Filter Ermail
e Delete Respond Quick Steps Ta have Tags Find ”~
<
Search Public Folder [Ctri+E] £ - 2 Reply 2 Reply 211 (£ Forward
4 Administrator@40demoz.local
— Al Unread By Date = Mewest & Mon 87262013 317 PM
noox
e e 4 Older Administrator
,JS ol Administrator =] "Baris, come herg," said shewith a sly and significant ook, "l
= L41) 23 L]
= atything that went o.. 8/26/2013 To  Administrator
g Deleted ftems "pihat! To whom?.. .
[ Calendar op\ease treat this as Personal,
b B Contacts Administrator iy =) We removed extra line breaks from this message,
= and he gave way to a. agrae/2013
i lonie] of that scoundrel?” he -
[ Junk Email
Motes Administrator = Suddenly he heard Denisov shouting in a vibrating voice behind the
&) Outhox 2] “Boris, come here,"sal., 8262013 hut, evidently much excited, Rostov moved to the window to see
[ RSS Feads Sttty i (e whom he was speakingto, and saw the quartermaster, Topcheenko,
=1 Tasks Administrator ! .\ A
his company. The cro... 842612013 | ordered you not to let them eat that Mashka woot stuff!" Denisov
£ Search Folders Matasha ate of was shouting. "and | saw with my own eyes how Lazarchuk bwought
o some fwom the fields."
4 public Folders - Administrator... Administrator J’
A Pl Gl Cr:g"":hm"s"(']_'e':tp“' 812612013 "I have given the order again and again, your hanar, but they don't
- WEE FElEEE wihere the oak 15 bu 0 U

- Public Folder

4 Favorites e

Mail Calendar People Tasks -

ITEMS: 5 UNREAD: 2 OMLIME |

Assume that you have archived items in a public folder as shown in the image above (see
Archiving items in Outlook public folders ). You can restore any archived item from the Archive
View > Public Folders tab by selecting it and clicking on the Restore icon, or by clicking Restore
Item.

Restore wizard

The Restore wizard allows administrator to restore all lost items or previously archived items by
item type filters in one or more Public Folders.

In this topic:

e Restoring lostitems in public folder

e Restoring public folder items by type

To restore lost items in public folders:
1. From the Archive view click on the Public Folders tab.

2. Select aroot publicfolderin the left pane.
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Right-click the public folder and select Restore Wizard from the context menu. The Restore
Mailbox wizard starts and the Select restore type window opens.

Choose Restore lost items and click Next.

In the Settings window click Add to add more root public folders (you will see more roots
publicfolders if you are managing more than one exchange server from the AMAC) .

The Select mailbox window opens. Move selected root public folders to the Selected objects
list. Click OK.

In the Settings window all selected root public folder mailboxes will be displayed in the
Selected mailboxes list. Choose one of the following options:

a. Mark the document as deleted after restore - lost item(s) will be restores and displayed in
the user’s public folders as non-archived; all versions of the lost item(s) will be marked for
deletion in the archive.

b. Create shortcut - shortcut of the item(s) will be displayed in the user’s public folders and
all versions will be accessible

. To restore specific lost items in the selected public folders, click Filter to set a filter. Itis a

search-based filter. You can filter by sender, subject and other parameters. Specify your filter
parameters and click Start search in the filter window. Then click Apply.

If you have finished, click Next.

In the Summary window click Evaluate if you want to display the number of lost items to be
processed. Then click Finish.

10. When the process completes, click Close.

To restore public folder items by type:

1
2.

In the Archive view click on the Public Folders tab.
Select aroot public folder in the left pane..

Right-click the mailbox and select Restore wizard from the context menu. The Restore Mailbox
wizard starts and the Select restore type window opens.

Choose Restore items filtered and click Next.

In the Settings window click Add button to add more root public folders (you will see more
roots public folders if you are managing more than one exchange server from the AMAC) .

The Select mailbox window opens. Move selected root public folders to the Selected objects
list. Click OK.

In the Settings window all selected mailboxes will be displayed in the Selected mailboxes
list.

Mark the document as deleted after restore - restored messages will be marked for deletion
in the archive.



8.

0.

Click Filter message class to choose the message classes to restore. In the Message filter
window, select the message classes that you want to restore and click OK.

1 | NOTE: The selected message classes must be set as supported message classes in View
> Manager > Settings > Message classes. If they are not supported or excluded, they will
not be archived.

Click Filter to open the Message filter window. Select the options as described below:
o All supported message classes - all messages classes as defined.
o Selected message classes - select the message classes that you want to archive.

You can also filter messages by date when they were received or modified with the following
options.

a. Select Filter by date.
b. Select Receive date or Modification date

c. Click Change filter. In the Filter by date window specify after, before or between from the
Date dropdown. Then enter the date and click Apply.

10. Click Next. In the Summary window click Finish.

When the processing completes, you can check the restoration result. Next to every restored
public folder you can see the number of all folder items, number of items processed and
number of errors.

If no items satisfy the entered criteria, no summary is displayed.

11. Click Close.

Creating a shortcut for archived item in a public
folder

In the Public Folders tab on the Archive view some items can be displayed with the following
icon: # (delayed shortcut) or %! (backup shortcut). This indicates that the email has been
archived but no shortcut was created for it. That happens when the email has been archived with
retention category which retains the original email or delays shortcut creation. It is possible to
create a shortcut for such email items in the Public Folders tab.

To create a shortcut for an archived item:

From the Archive view go to the Public Folders tab.

Find the publicfolderin the left pane. You may use the Look for combo box for that purpose.
Double-click it to expand its subfolders.

Locate the item with a delayed shortcut or backup shortcut icon in the right pane. Right-click
the item and click Promote delayed shortcut or Promote backup shortcuts in the context
menu.
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4. When the processing is over, click OK in the Processing result window.

Public Folders Archive tab

This tab is generally used

e torestore lostitems in public folders (they have no shortcut in MS Outlook, but they physically
remain in the HSM store during their retention time)

e as apublicfolder archive browser

1 | NOTE: On the Public Folder Archive tab the administrator can browse through folders and
sub-folders. For each folder there is a list of all its items displayed in the right pane of the
window. Different colors of the icon represent different status of the item. You can open
the legend foricons when you right-click an item in the right pane and select Show legend
from the context menu or you can click the Show legend icon on the toolbar (g ). The
Legend window with icon explanation appears.

Icons for public folder item

B Blue indicates that the respective archived items are lost, i.e. they remain in the HSM store at
least during their retention time but they have no shortcut in Outlook. User cannot reach them.
Such lost items can be recovered manually only by the administrator on this tab or on the Public
Folder tab (see the section How to restore archived items of an Qutlook public folder).

1] Green indicates that the respective item is archived and has a shortcut in Outlook. It can be
restored.

- Yellow indicates that the shortcut in the mailbox folder belongs to a different user.

Restoring lost items

Users may have deleted the shortcut of an archived item simply by pressing the SHIFT key along
with the Delete key on the keyboard or by clicking on the Delete icon on the Outlook toolbar and
not by clicking on the Delete archived messages icon and selecting Delete from archive option,
which is an Archive Manager Outlook AddIn feature.

In such cases those archived items are lost for the user. They cannot be reached by the user, but
they still reside in the HSM store at least until their retention time expires. They can be
recovered manually by the administrator only. Such lost items have a blue icon on the Public
Folder Archive tab.

From this tab the administrator can restore specific lost items.

1 | NOTE: For restoring lostitems in several public folders at once, see Restore wizard)
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To restore speicific lost items:

1

Click View on the Archive Manager for Exchange menu bar. Select Archive. Then switch to the
Public Folder Archive tab.

In the left pane find and open the public folder whose lost item(s) you want to restore. A list
of all items of the public folder will be displayed in the right pane.

1 | NOTE: To display lost items only, right-click in the right pane and click Show only lost
items from the context menu.

Right-click the lost item (blue icon). From the context menu select Restore lost item.
In the Restore options window choose between two options:

a. Delete all versions of the document - all versions of the lost item(s) will be marked for
deletion in the archive, and the latest one will be displayed in the public folder as non-
archived

b. Restore shortcut only - shortcut of the item(s) will be displayed in the public folder and all
versions will be accessible.

1 | NOTE: If none of the options are checked, email is returned to the public folder as non-
archived and its versions, if any, are displayed as lost in Archive Manager for Exchange.

Click Accept. The respective archived item will be restored to the folder its shortcut had been
deleted from.

When the items have been restored in the Processing result window click OK.

Restoring public folders

When publicfolders or sub-folders with archived items are deleted, the information about the
folder structure is available to Archive Manager. The entire folder structure can be restored. For
example, the image below indicates that the sub-folder tree Conference > Vendors was deleted.
Deleted folder names appearin blue color.
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Archive Manager for Exchange

PEREFR
Session  View Tools Help
SRReXDasPe aen
Mailboxes "Archwe " PublicFolders " Public Folders Archive ]
View: Filter in: Filter te:
|DeFau|tview ~ | | <no filter= (Blanks) |
B--ﬁ_" democorp.com [AMXEXCH]
EHED) Accounts-News
¢ =+ Conference
{3 Vendors
i--{[7) Companyews
-{[7) Products-News
{7 SalesNews
] l Server Role: Archive Server Folder contents loaded FullAccess Archiver/Restorer

To restore the folder structure

1. Select the root node of the deleted folder structure.

2. Right click and select Create folder structure. The folder structure will be restored along with

any archived items in those folders and the folder names will be displayed in normal black
color.
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7

Post Processing is a service which allows running customer specific tasks over archived emails

Post Processing

and their attachments across selected mailboxes. So those clients who are using other software
programs and wish to process within those software programs archived emails and their
attachments may do so via the Post Processing service.

How to use post processing

To use the Post Processing service, the user must use the Archive Manager Configuration tool.

1. Make sure that the Post Processing service has started.

will not run and therefore no post processing will be performed.

Services [ [ = [

File  Action Wiew Help

I EEEE ERRCE

4 Services (Local) Marne Description Status Startup Type Log Onds  ~
Lo MAN Auditing Auditing ser..  Running  Automatic A0DEMO A
S MAM Exchange Archive Support Service prov., Autarnatic AODEMONAG =
L MAM Exchange Core WCF service., Running  Automatic A0DEMO A =
S MAM Exchange Direct Archive Handles the.,  Running  Autornatic A0DEMONAL
L MAM Exchange Handler Handlerarc..  Running  Automatic A0DEMO A
S MAM Exchange Manager Server Enter..  Running  Autornatic 40DEMONAC
S MAM Exchange Motification Email notifi..  Running  Autornatic 40DEMOZVAC
S MAM Exchange Scheduler Starts and st Running  Automatic A0DEMO A
S MAM FEA Archive Service Scheduling .. Running  Autornatic A40DEMONAL
Lo MAN S8 Handler Service Core service., Running  Automatic A0DEMO A
S MAM FSA Mini-filter Servce Fsmini-filte.. Running  Automatic 40DERONAL
Lo MAN FS8 Rermote Server Service Rermaoting 5., Running  Automatic A0DEMO A
S MAM WARI Cornmmunic..  Running  Autornatic A0DEMONAL
S MAK KMonitoring Automates .. Running  Automatic A0DEMO A

st sing Running  Automatic AODEMC

S MAM PET lmparter Handlesim... Running  Automatic Local System
2/ M&hd Search Illr|1dexinu an, Running  Automatic 4ODEM02\.§C h
Extended )\Standard/

2. Add the plugin to the Post Processing for Exchange scope.

3. Select all mailboxes to which post processing is to be applied.

4. Define the initial bookmark date for the plugin if necessary.

NOTE: A bookmark indicates the date and time where the the indexing process has
reached. All emails and their attachments that are archived after this bookmark date will
be processed unless they have already been indexed. There can be several plugins running
in parallel, each with a different bookmark date. However, do not start post processing
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service on multiple servers for the same database. Running the post processing service on
multiple servers is not recommended since that can cause conflicts in bookmarking. The
same database must not be indexed by more than one post processing service.

The Post Processing service manages (starts and stops) the plugins at regular intervals. Advanced
Post Processing settings can be configured after clicking the General Settings tab on the Post
processing tab.

Each plugin is loaded by default with the date and time (initial bookmark date). This means that
the plugin processes emails and their attachments having been archived after this initial
bookmark date. If post processing must begin from some other bookmark date, then make sure
to reset the initial bookmark date.

Enhance your ArchiveWeb search by a new search option. Besides Subject and From text boxes in
the Exchange Archive search a brand new searching option can be added to the search query —To
field. In this way user can search for items sent to specific recipient.

To activate the above mentioned searching by recipients, a post processing plugin must be
installed. This plugin indexes mail recipients.

Steps to install the SearchindexPluginRange post processing plugin

1. Open Archive Manager Configuration Tool from <installdir>\Program Files (x86)
\Common Files\PAM\PAMConfig\PamConfig.exe.

2. Open the Post Processing tab.

3. Open the Post Processing scopes tab.

4. Right-click on the scope and from the context menu and select Configure.
5. Click Add.

6. Installed plugins will be loaded in the Add Plugin pop-up window. Select
PostProcessPAMsearchindex.SearchindexPluginRange from the dropdown box and click Add.

“ ¢ Add plugin

Select a plugin From the list of installed plugins:

PostProcessPAM3earchindex:, SearchIndexPlugink.ange

PostProcessPAM3earchIndes, SearchIndexPluginDel
PostProcessPAMSearchIndex, SearchIndexFPluginPurged

7. The pluginis listed in the Plugins list in Configuration tab. By default it is active.
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iix}-x-ﬂ'_r_'aﬁ-.'ﬂbl.'-_-?-_?:d.y or EXchange e
¥ Enabled Location: | 1-Default
HSM server: AMXSERVER Reset
Index directory: C:'Program Files (x86) \Metalogix\MAMSearchiIndex \Mail Browse
Mailboxes in index: 50::I
LY
i’:r.-aan_j_-;u_.-,-: Database e
Provider: Microsoft SQL Server
Server name: AMXSERVER
Initial catalog: MAMEXCH
Configure
7 Plugins —
Plugin Mame Active | Bookmark Add
PostProcessPAMSearchIndex. SearchIndexPluagin Yes 02.04.2023 19:27:16
PostProcessPAMSearchindex, SearchIndexPluginRangs Yes 20.05.2023 00:00:00 | | PEMOVE |
Properties
Refresh
[al'4 Zancel Apply

Steps to Configure a Plugin

When a new plugin is added to the Plugins list, there are no mailboxes specified by default. You
must specify the mailboxes as well as the Bookmark Date. If no mailboxes are selected then post
processing will not process any archived emails and attachments.

1. From the Plugins list, select the PostProcessPAMsearchindex.SearchindexPluginRange plugin.
Either click the Properties button or right-click the selected plugin and click Properties from
the context menu.
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.
D

ost Frocessmg ior Exchange:

v Enabled Location: 1-Default

H5M server: AMXSERVER Reset
Index directory: C:VProgram Files (x86) \Metalogix\MAMSearch\Indesx \Mail Browse
Mailboxes in index: 50::I

Provider: Microsoft SQL Server
Server name: AMXSERVER
Initial catalog: MAMEXCH
Configure
Plugin Mame | Active | Bookmark Add
e et oo et e

Add new plugin

Refresh Refresh

Remaove plugin

“3  Properties

Set Bookmark
Dizable
Statistics

[al'4 Zancel Apply

2. Inthe Post Processing plugin properties window set the properties as described below.
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“. Post Processing plugin properties

General
&&HJ&EE.—J]J;Q—}JJLLJJJ L ———

Plugin Mame :
|PnstProcessPAM5eard’11ndex.SearmlndexPluginRange |

Plugin assembly :
|:essPAM5earchIr1dexRar1ge\PostProcessPAMSearﬁIndexRange.d|||

¥ Plugin is active

{* Applyforselected mailboxes

= Apply forall mailboxes

Start date : 20.05.2023 04:21:11 |
End date : IZU.UE.ZDZE 2021011 LI
Bookmark date : |20.05.2023 042111 ~|
¥ Reindexkeywords ¥ Reindex recipients

Statiskics

e

The plugin properties are as follows;

a. Pluginis active - select this checkbox to activate the plugin.

b. Apply for selected mailboxes - the plugin scope is determined by the mailboxes that
you can select when you click Mailboxes.

i. Inthe Plugin mailboxes window click Add to add mailboxes.

ii. Inthe Select mailbox enter the name of a mailbox in the text box to search for the
mailbox. Double-click the mailbox in the list to transfer it to the Selected objects
section. In the Selected objects section you can check which users you have selected.
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M PostProcessing Plumn

Select mailbox El.
Type in the name or select from list:
|
Display name | Alias | email address A
f.:j, public_AMXEXCH public_AMXEXCH domadmin@democom com
[ Tim Ashford timashford timashford @democorp.com
f.:j, Pablo Meruda pabloneruda pabloneruda@democomp.com
[ Nina Tanaka ninatanaka ninatanaka@democorp.com
f:j Mili Portman nikiportman nikiportman@democorp.com
f.:j, Kar Jordan karjordan karjordan @democorp com
[ Juan Christie juanchristie juanchristie@democorp.com
f.:j, lshna Mohan ishnamohan ishnamohan@democom .com
[ Devika Sharma devikasharma devikashama@democorp.com
f.:j, David Webb davidwebb davidwebb @democom com
(2 Aman A amanali amanali@democorp.com
[ Administrator rdnmadmin dnmadmin@demaocom com N
< >
Selected objects: i
[} Karl Jordan
() Devika Sharma
[ David Webb
o e

iii. Confirm by clicking OK. The selected mailboxes appear in the Plugin mailboxes
window.

|

Plugin mailboxes

List of mailboxes assigned to plugin:

Display name | Alias | email |
Eﬁ David Webb davidwebb davidwebb@democaor...
[ Devika Shama devikasharma devikashamma@democ...
Eﬁ Kar Jordan karjordan karjordan@democom....

Add Remaove | Remove &l | | Close |

iv. Click Close.
Apply for all mailboxes - the plugin scope is across all mailboxes.

Start Date - indicates the date when email indexing starts. Click the dropdown to set
the date from the calendar popup.

End Date - indicates the date when email indexing ends. Click the dropdown to set the
date from the calendar popup.

Bookmark Date - indicates the most recent index date and time. Click the dropdown to
set the date from the calendar popup. When the plugin is installed, the Bookmark Date
must be the same as the Start Date. If you want to index old email items, set the Start
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Date and the Bookmark Date to the same date in the past from where you would want
the indexing to begin.

g. Reindex keywords - select this checkbox if keywords must be re-indexed within the
specified data range.

h. Reindex recipients - select this checkbox if email recipeinets must be re-indexed
within the specified data range.

Steps to specify a bookmark date and time
1. Right-click the plugin and click Set Bookmark from the context menu.

2. Inthe Enter bookmark window specify the time. Click OK.

Enter bookmark

Select date

|20.05.2021 00:00:00

NOTE: The bookmark date is displayed in the Plugins list in the Configuration tab. If you
reset the bookmark date, the change takes effectimmediately, and there is no must
deactivate and activate the plugin again. If you remove a plugin using the Remove button,
it will stop entirely without remembering where it stopped. You must reconfigure the
plugin if you reload it.
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8

Advanced Search

The Advanced Search feature helps an administrator to search for archive items. It cannot be used
to search non-archived items. This feature is a component of Archive Manager and is installed by
default. Advanced Archive Search has some special capabilities:

e |t can search for emails in the archive that are marked for deletion. Items that are marked for
deletion are not visible in the Archive tab but they still reside in the archive until their
retention time expires.

e |t can perform an OCR search in attachments that contain scanned content. However, characters
that are too small may not be correctly recognized. This capability must be activated in the
Archive Manager Configuration tool > Post Processing > OCR engine tab.

Steps to search for archived emails

1. Click the Advanced Search icon &} on the toolbar. The Advanced archive search window
opens.

2. Click the Messages tab.

+ Advanced archive search PEERR
Messages | Settings
Find items that match these criteria:
And/Or  Field Operator Value
+ Add new dause
Search only in the following mailboxes
User From Subject Folder Received Size  Retention Version GUID
£ >
| Search | | Clear |

3. Click Add new clause and enter the search criteria using the fields as described below:

a. Field - click the dropdown to select the property of the email to be searched. For example,
select Subject as the field to search.

b. Operator - click the dropdown and select a search operator.
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c. Value - Specify the search text. If the selected Field requires a date value, a date picker
icon appears to help you choose a date. This field supports wildcard characters as
described in the table below:

Wildcard Description Example

& A substitute for zero or more * pdf
characters

? A substitute for a single Sales201?.pdf

character to match

4. To add more criteria, click Add new clause again. When you add more than one search clause,

the logical operator dropdown box appears. You can select either the And or the Or operator.
The default operator is And. You can even group clauses to create nested search criteria by
selecting consecutive checkboxes and clicking the [=icon.

To restrict your search to one or more mailboxes, click the button with the three dots in the
Search only in the following mailboxes section.

From the Select mailbox window that opens, select one or more mailboxes and then click | ¥
to move them to the Selected objects box. Click| % |toremove them from the Selected
objects box.

W Archive Manager for Exchange 1
Select mailbox !

Type in the name or select from list:

Display name Alias email address &
f’_t', public_AMXEXCH public_AMXEXCH domadmin@democorp.com

f:', Domain Administrator domadmin domadmin@democorp.com

f’_‘_’, Aman Ali amanali amanali @democorp. com

() David Webb davidwebb davidwebb @democorp.com

() Devika Sharma devikasharma devikasharma @democorp.com

f’_‘_’, Ishna Mohan ishnamohan ishnamohan @democorp.com

f’_'f, Juan Christie juanchristie juanchristie@democorp.com

f:', Karl Jordan karljordan karljordan @democorp.com

f’_‘_’, Miki Portman nikiportman nikiportman@democorp. com

() Nina Tanaka ninatanaka ninatanaka @democorp. com
LS N PR R PR R TN S

»

w
¥

Selected objects:
[} Devika Sharma
() Aman Al

() David Webb

_

Click OK to close the window. The selected mailboxes will appearin the Search only in the
following mailboxes field.

8. Click the Settings tab.
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+  Advanced archive search PERERFR

Messages | Settings

Maximum number of search results: 10000

[ search in archived and deleted documents
[ search in deleted documents
[] search in versions. The match wil be shown for each version separately.

User From Subject Folder Received Size  Retention Version GUID

| Search | | Clear

9. Configure the settings if needed, as described below:

a. Maximum number of search results - restricts the number of emails that can be displayed
in the search result list. The maximum number of search results allowed is 1,000,000.

b. The search options lets you specify the category of documents to search:

e No selection - only archived documents are searched. Previous versions of these
documents are not included.

Select one of the following options:

e Search in archived and deleted documents - all documents will be searched. Previous
versions of these documents are not included.

e Search in deleted documents - deleted documents and documents that are marked for
deletion will be searched. All other archived documents will be ignored. Previous
versions of these documents are not included.

Add an additional criteria:

e Search in versions - Previous versions will be included for the document category
specified. The match will be shown for each version separately.

10. Click Search to search for archived emails based on the selection criteria, the mailboxes
specified and the settings that are applied. Items marked for deletion are displayed with a
blue icon in the search result list.
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+ Advanced archive search PERFR

Messages || Settings

Find items that match these criteria:
And/Or  Field Operator Value Clear

+x [0 [Receivedbae ~|[< ~|[12/10/2020 |

+ % O|[E[and ~][subject “|[= | [wealth |

+ % [ |Or V||Subject V||Cnntains V||Cnmmerce |

=+ Add new clause

Search only in the following mailboxes

|davidwebb | o
User From Subject Falder Received Size Retention Version GUID ™
Ed  David webb [9] ishnamoha...  Wealth Inbox 9/11/2020 2:33 AM 9.03KB 3 1 ABIF¢
B4 David webb [5] juanchristie... Wealth Inbox 9/11/2020 2:33 AM 9.34KB 3 1 31ED+
B4 David webb [9] karljordan. .. Wealth Inbox 9/11/2020 2:33 AM 9.08 KB 3 1 EABIE
BA David Webb [9] nikiportman... Wealth Inbox 9/11/2020 2:33 AM 10.04 KB 3 1 T74E8:
B David Webb [9] ninatanaka... Wealth Inbox 9/11/2020 2:33 AM 10.95 KB 3 1 AJEF!
B David webb [9] pablonerud...  Comme... Inbox 9112020 2:33 AM 13.68 KB 3 1 1BF&F
4 David webb [9] timashford...  Comme... Inbox 9112020 2:33 AM 9.01KB 3 1 BBB1zW¥
£ >
Page: | 1| of 1 Messages: 1-Bof 8 K L4 3 b
| Search | | Clear |

IMPORTANT: In the search results list, a green or blue icons represents the state of the
information about an email and not the actual email. A green icon & indicates that
information items about the archived email stored in the database and HSM store is active,
and the original email is archived. A blue icon ®indicates that the information items about
the archived email stored in the database and HSM store is marked for deletion, and the
original email has been restored.

Example of a nested search query

Consider the following search request: All email items that were received by David Webb before
10th November 2020 and the subject contains either the words Wealth or Commerce.

Search criteria contains only email properties. Therefore the nested search criteria can be written
as follows:

Received Date < 11/10/2020 AND (Subject contains Wealth OR Subject contains
Commerce)

The context of the search query is restricted to a single mailbox called David Webb, but there are
no restrictions to the scope since All items are required to be searched in the specified mailbox.

To define the query in the Advanced archive search window, follow the steps described below:

1. Click the Advanced Search icon &} on the toolbar. The Advanced archive search window
opens.

2. Click the Messages tab.

3. Click Add new clause and enter the search criteria using the fields as described below:
a. Field: Received Date
b. Operator: <
c. Value: 11/10/2020
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4. Click Add new clause and enter the search criteria using the fields as described below:
a. And/Or: And
b. Field: Subject
c. Operator: Contains
d. Value: Wealth
5. Click Add new clause and enter the search criteria using the fields as described below:
a. And/Or: Or
b. Field: Subject
c. Operator: Contains
d. Value: Commerce

6. Since Subject Contains Wealth Or Subject Contains Commerce are nested criteria, select the
two checkboxes where the Field value is Subject. Then click the [Sicon that appears. The
fields that are grouped are marked as shown on the image below:

+ Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

AndfOr  Field Operator Value
+x0 [Receivedpate  ~|[< | [11/10/2020 |
+ x [E|.-'-\nd V||5ubject V||C0nta|ns V||Weahh ‘
+ X O |:|Or ~ | |Subject ~ | |Contains ~ | |Commerce ‘
<+ add new clause

Search only in the following mailboxes

[pavid webb |

1 | NOTE: If there are nested criteria within a nested criteria, start the grouping with the
innermost nest. When the grouping is successfully applied, the checked boxes are
cleared and the group icon disappears.

7. Click the button with the three dots in the Search only in the following mailboxes section.

8. From the Select mailbox window that opens, select David Webb and then click. ¥ to move
them to the Selected objects box.
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M Archive Manager for Exchange
Select mailbox

L =

Type in the name or select from list:

Display name Alias email address 2
() public_AMXEXCH public_AMXEXCH domadmin @democorp,com

f’_‘_’-, Domain Administrator domadmin domadmin@democarp.com

f’_‘_’l, Aman Al amanali amanali@democorp.com

E’,'_‘n, David Webb davidwebb davidwebb@democorp.com

f’_‘_’n, Devika Sharma devikasharma devikasharma @democorp.com

() Ishna Maohan ishnamohan ishnamohan @democorp.com

[} Juan Christie juanchristie juanchristie @democorp.com

f’_‘_’-, Karl Jordan karljordan karljordan @democarp.com

f’_‘_’l, Miki Portman nikiportman nikiportman @democorp.com

E’,'_'n, Mina Tanaka ninatanaka ninatanaka@democorp. com

5 et mreeas i s e

L4 >
Selected objects: i E3

If:'w David Webb

_

9. Click OKto close the window. The selected mailboxes will appear in the Search only in the
following mailboxes field.

10. Since the scope of the search is All items, there is no must change any properties in the
Settings tab.

11. Click Search to search for archived emails based on the selection criteria, the mailboxes
specified and the settings that are applied.

Building search queries

This topic describes how to build search conditions using the advanced search capabilities of
Archive Manager for Exchange. A search condition (or query) can contain zero or more search
clauses that are combined using operators and grouping of search clauses.

Simple Conditions

A simple search conditions needs no search clause or can contain one search clause.

Example 1

Click Search without adding a search clause. In this case, you will get back all the archived items.

Quest® Archive Manager for Exchange Administration Guide

231
Advanced Search



#  Advanced archive search PEREFR

Messages | Settings

Find items that match these criteria:

AndfOr  Field Operator Value
=+ Add new clause
Search only in the following mailboxes
User From Subject Folder Received Size  Retention Version GUID *
Ishna Mohan [5] amanali@d... Return... Inbox 9/11/2020 2:33 AM 8.93KB 3 1 B9l
B  1shna Mohan [5] davidwebb..,  Division... Inbox 9/11/2020 2:33 AM 8.79KB 3 1 47FX
A  Karl Jordan [7] davidwebb... Division... Inbox 9/11/2020 2:33 AM 1L79KB 3 1 AC4D
B=A  1shna Mohan [5] devikashar... Division... Inbox 9/11/2020 2:33 AM 9.17KB 3 1 9B2F
BA  Ishna Mohan [5] juanchristie... Wealth Inbox 9/11/2020 2:33 AM 12.09KB 3 1 6F530
A Ishna Mohan [5] karljordan...  Wealth Inbox 9/11/2020 2:33 AM 9.33KB 3 1 FOFC
BEA  1shna Mohan [5] nikiportman... Wealth Inbox 9/11{2020 2:33 AM 9.25KB 3 1 B&DF5
b=d Ishna Mohan [51  ninatanaka... Comme... Inbox 9/11/2020 2:33 AM 9.86 KB 3 1 BCeED. v
< >
Page: | 1 | of 1 Messages: 1- 27 of 27 4 L4 » A
Search | Clear

Example 2

Add a single search clause with a condition where the field Subject contains the word "wealth”.
When you click Search, you will get back all the archived items where the Subject contains the

word "wealth”.

+ Advanced archive search PERFR

Messages | Settings
Find items that match these criteria:
And/Or  Field Operator Value
+ X O |Subject ~ | |Coniains ~ | |wea|th
=+ Add new clause
Search only in the following mailboxes
User From Subject Folder Received Size Retention Version GUID
B4 Ishna Mohan [5] juanchristie... Wealth Inbox 9/11/2020 2:33 AM 12.09KB 3 1 8F5302.,
B4 1shna Mohan [5] karljordan. .. Wealth Inbox 9/11/2020 2:33 AM 9.33KB 3 1 FOFCE...
B=A  1shna Mohan [5] nikiportman... Wealth Inbox 9/11/2020 2:33 AM 9.25KB 3 1 6DFSC...|
< >
Page: | 1| of 1 Messages: 1-3of 3 K L4 ¥ b
Search | Clear

AND/OR operators

The AND/OR operatoris used between two search clauses. With these operators, you can
combine two or more search clauses. The AND operator will return a search result if both the
search clauses separated by the AND operator are fulfilled. The OR operator will return a search
result if any one of the search clauses separated by the OR operator are fulfilled. The AND
operator has a higher priority over the OR operator. When a search condition contains both the
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AND and OR operators, the search clauses that are combined with the AND operator must be

fulfilled first.

Example 1

To find all items where the Subject contains word "Division" AND the Sender is
"davidwebb@democorp.com", you must combine two search clauses as shown:

+ Advanced archive search PEREER
Messages | Settings
Find items that match these criteria:
AndfOr  Field Operator Value
+ X O |Subject v | |Comains v | |Diviston
+ X O |And ~ | |Frcm ~ | |= ~ | |davidwebb@demcmrp‘mm
=+ Add new clause
Search only in the following mailboxes
User From Subject Folder Received Size Retention Vei
bA  Karl Jordan [7] davidwebb @democorp.com Division... Inbox 9112020 2:33 AM 11.79 KB 3
< >
Page: | 1| of 1 Messages: 1-1of 1 K 4 ¥
Search | ‘ Clear
Example 2

To find all items where the Subject contains word "Division" OR the Sender is

"davidwebb@democorp.com", you must combine two search clauses as shown:

+ Advanced archive search

Messages | Settings

PEEER

Find items that match these criteria:

And/Or  Field Operator Value
+ X [0 |Subject ~ | |Coniains ~ | |Divis40n
+ X O |Or ~ | |Frcm ~ | |= ~ | |davidwebb@demcmrp‘mm

=+ Add new clause

Search only in the following mailboxes

[

User From Subject Folder Received Size  Retention Vel
B=d Ishna Mohan [5] davidwebb @democorp.com Division... Inbox 9/11/2020 2:33 AM 8.79KB 3
BA  Karl Jordan [7] davidwebb@democorp.com Division... Inbox 9/11/2020 2:33 AM 11L.79KB 3
BA  Ishna Mohan [5] devikasharma@democorp.com  Division... Inbox 9/11/2020 2:33 AM 9.17KB 3
A Karl Jordan [7] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 13.66 KB 3
B4 Karl Jordan [7] davidwebb @democorp.com BlackL... Inbox 9112020 2:33 AM 8.64KB 3
B4 Karl Jordan [7] davidwebb @democorp.com AnAm... Inbox 9112020 2:33 AM 9.24KB 3
< >
Page: | 1| of 1 Messages: 1-60f6 K 4 > A
Search | ‘ Clear
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Grouping

Sometimes simple combinations of search clauses with the AND and OR operators are not
enough. Grouping is a good solution to change the priority between the operators. The grouped
search clauses have a higher priority than the operator before or after the group. The examples in
this section describe how the grouping works.

Example 1

To find all items where the Subject contains word "Division" AND the Sender is
"davidwebb@democorp.com", and all these items must also have an attachment then the search
condition is as shown:

+  Advanced archive search PEER

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+x Ol [subject | [contains | [pivision |
+x O |:|Or | [From ~[= | [davidwebb@democorp.com |
+ X O |»'-\nd V||Has Attachment V||= V||Yes V|
=+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size  Retention Vel
Ishna Mohan [5] devikasharma@democorp.com  Division... Inbox 9112020 2:33 AM 9.17KB 3
B Karl Jordan [7] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 13.66 KB 3
< >
Page: | 1| of 1 Messages: 1-2of2 4 L4 » A
| Search | ‘ Clear |

Query: (Subject contains "Division" OR Sender is "davidwebb@democorp.com")
AND has attachment

We can split this search condition into two parts
1. (Subject contains "Division” OR Sender is "davidwebb@democorp.com") which is a group
2. AND has attachment

Since a grouping has a higher priority, the search condition in the group must be fulfilled first. In
this case each item in the search result will have a Subject that contains the word "Division” AND
the Sender is "davidwebb@democorp.com”, and the item will also have an attachment

Example 2

To find all items where the Subject contains word "Division” or, the Sender is
"davidwebb@democorp.com" and at the item must have an attachment, then the query is as
shown:
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+  Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+ X O [subject | [contains | [pivision |
+x O [or ~][From ~[= | [davidwebb@democorp.com |
+ X O |And V||Has Attachment V||= V||Yes V|
=+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size  Retention Vel
Ishna Mohan [5] davidwebb @democorp.com Division... Inbox 9/11/2020 2:33 AM 8.79KB 3
B Karl Jordan [7] davidwebb @democorp.com Division... Inbox 9112020 2:33 AM 11.79KB 3
B4 1shna Mohan [5] devikasharma@democorp.com  Division... Inbox 9/11/2020 2:33 AM 9,17 KB 3
BA  Karl Jordan [7] davidwebb@democorp.com Comme... Inbox 9/11/2020 2:33 AM 13.66 KB 3
< >
Page: | 1 | of 1 Messages: 1-4o0f4 (4 4 > A
| Search | ‘ Clear |

Query: Subject contains "Division" OR Sender is "davidwebb@democorp.com" AND
has attachment

This query can be splitinto two parts
1. Subject contains "Division" OR
2. Senderis "davidwebb@democorp.com" AND the item has an attachment

The AND operator has a higher priority so the search clauses combined with the AND operator
must be fulfilled first. In this case the search result will contain items where the item must have
an attachment and the Sender must be "davidwebb@democorp.com", or Subject must contain
the word "Division".

Example 3

To find all items where the Subject contains the word "Division” or, the Sender is
"davidwebb@democorp.com", or the item has attachment, and the item must be in the "Inbox"
folder then the search condition is as shown:
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+  Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+ x O |5ubJect V||Coma|ns V||DI\¢'IS\OH |
+ % O[E[and ~][Frem ][ | [davidwebb @demacorp. com |
+ %X O [or ~|[Hes attadment  +|[= | [res ]
+ % O [and v|[Folderpath |- | [nbox |
+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size Retention Vel
Karl Jordan [7] davidwebb @democorp.com Division... Inbox 9112020 2:33 AM 11.79KB 3
B  1shna Mohan [5] devikasharma@democorp.com  Division...  Inbox 9112020 2:33 AM 9.17KB 3
< >
Page: | 1 | of 1 Messages: 1-20of2 K < ¥ A
| Search | ‘ Clear |

Hi

Query: Subject contains "Division" AND (Sender is "davidwebb@democorp.com"
OR has attachment) AND Folder path is "Inbox"

This query can be splitinto three parts

1. Subject contains "Division" AND

2. (Senderis "davidwebb@democorp.com" OR the item has an attachment)
3. AND Folder path is "Inbox"

The grouped search clauses have the higher priority in this query so the search condition in the
group must be fulfilled first. In this case the search result will contain items where the Subject
must contain the word "Division" + Sender must be "davidwebb@democorp.com" or the item has
an attachment + the folder path must be "Inbox".

Example 4

To find all items where the Subject contains the word "Division" and Sender is
"davidwebb@democorp.com", or the item has an attachment and these items must be in the
"Inbox" folder then the search query is as shown:
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+  Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+ x O |5ubJect V||Coma|ns V||DI\¢'IS\OH |
+ % O [ad ~[Frem |- | [davidwebb @demacorp. com |
+ %X O [or ~|[Hes attadment  v|[= | [res ]
+ % O [and v|[Folderpath |- | [nbox |
+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size Retention Vel
B4 Ishna Mohan [5] amanali@democorp.com Return ... Inbox 9112020 2:33 AM 8.93KB 3
B Karl Jordan [7] davidwebb @democorp.com Division... Inbox 9112020 2:33 AM 11.79KB 3
B4 1shna Mohan [5] devikasharma@democorp.com  Division... Inbox 9/11/2020 2:33 AM 9,17 KB 3
B=A  1shna Mohan [5] timashford @democorp. com Comme... Inbox 9/11/2020 2:33 AM 16.96 KB 3
BA  Ishna Mohan [5] davidwebb @democorp.com Comme... Inbox 9/11/2020 2:33 AM 11.57KB 3
A Karl Jordan [7] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 13.66 KB 3
< >
Page: | 1| of 1 Messages: 1-60f6 K < ¥ A
| Search | ‘ Clear |

Query: Ssubject contains "Division" AND Sender is "davidwebb@democorp.com" OR
has attachment AND Folder path is "Inbox"

This query can be splitinto two parts
1. Subject contains "Division" AND Sender is "davidwebb@democorp.com" OR
2. Item has attachment AND Folder path is "Inbox"

The AND operator has a higher priority in this query so the conditions with the AND operators
must be fulfilled first. In this case the search result will contain all items where Subject contains
the word "Division" and Sender is "davidwebb@democorp.com" or the item must have an
attachment and the folder path must be "Inbox".

Example 5

To find all items where the Subject contains word "Division" or these items are in the "Inbox”
folder, and the Senderis "davidwebb@democorp.com" or the item has an attachment, then the
qguery is as shown:
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+  Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+ x O|IE |5ubJect V||Coma|ns V||DI\¢'IS\OH |
+ % O] [or |[Felderpath |- | [nbex |
+ % O [E[and ~][From ~[= | [davidwebb @democorp.com |
+x O] [or v|[hesattachment  +|[= | [res |
+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size Retention 2
B4 Ishna Mohan [5] amanali@democorp.com Return ... Inbox 9112020 2:33 AM 8.93KB 3
B Karl Jordan [7] davidwebb @democorp.com Division... Inbox 9112020 2:33 AM 11.79KB 3
B4 1shna Mohan [5] devikasharma@democorp.com  Division... Inbox 9/11/2020 2:33 AM 9,17 KB 3
B=A  1shna Mohan [5] timashford @democorp. com Comme... Inbox 9/11/2020 2:33 AM 16.96 KB 3
BA  Ishna Mohan [5] davidwebb @democorp.com Comme... Inbox 9/11/2020 2:33 AM 11.57KB 3
A Karl Jordan [7] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 13.66 KB 3
B4 Karl Jordan [7] davidwebb @democorp.com BlackL... Inbox 9112020 2:33 AM 8.64KB 3 o
< >
Page: | 1| of 1 Messages: 1-80of 8 K < ¥ A

| Search | ‘ Clear |

Query: (Subject contains "Division" OR Folder path is "Inbox") AND (Sender
is "davidwebb@democorp.com" OR has attachment)

This query can be split into two parts
1. (Subject contains "Division" OR Folder path is "Inbox") AND
2. (Senderis "davidwebb@democorp.com" OR item has attachment)

The grouped condition has the higher priority in this query so the conditions in the group must be
fulfilled first. In this case the search result will contain items where Subject must contain
"Division" word or folder path must be "Inbox” + Sender must be "davidwebb@democorp.com"
or the item must have an attachment.

Example 6

To find all items where the Subject contains the word "Division" or, these items are in the
"Inbox” folder and the Sender is "davidwebb@democorp.com", or the item has an attachment,
then query is as shown:
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+  Advanced archive search PERFR

Messages | Settings

Find items that match these criteria:

And/Or  Field Operator Value
+ x O |5ubJect V||Coma|ns V||DI\¢'IS\OH |
+ % O [or |[Felderpath |- | [nbex |
+ %X O [and ~][From ~[= | [davidwebb@democorp.com |
+x 0O [or v|Hesatacment  ~|[= | [res |
+ Add new clause

Search only in the following mailboxes

User From Subject Folder Received Size Retention 2
B4 Ishna Mohan [5] amanali@democorp.com Return ... Inbox 9112020 2:33 AM 8.93KB 3
B  1shna Mohan [5] davidwebb @democorp.com Division... Inbox 9/11f2020 2:33 AM 8.79KB 3
A  Karl Jordan [7] davidwebb @democorp. com Division... Inbox 9/11/2020 2:33 AM 11.79KBE 3
B=A  1shna Mohan [5] devikasharma @democorp.com  Division... Inbox 9/11/2020 2:33 AM 9,17 KB 3
BA  Ishna Mohan [5] timashford @democorp.com Comme... Inbox 9/11/2020 2:33 AM 16.96 KB 3
A Ishna Mohan [5] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 11.57KB 3
B4 Karl Jordan [7] davidwebb @democorp.com Comme... Inbox 9112020 2:33 AM 13.66 KB 3 v
< >
Page: | 1| of 1 Messages: 1-90of 9 K < ¥ A

| Search | ‘ Clear |

Query: subject contains "Division" OR Folder path is Inbox AND Sender is
"davidwebb@democorp.com" OR item has an attachment

This query can be splitinto three parts

1. Subject contains "Division" OR

2. Folder path is "Inbox" AND Sender is "davidwebb@democorp.com"
3. ORitem has an attachment

The AND operator has a higher priority so the conditions with the AND operator must be fulfilled
first. In this case the search result will contain items where Subject must contain the word
"Division" or folder path must be "Inbox” and Sender must be "davidwebb@democorp.com" or
the item has an attachment.

Search result options

You can perform the following operations on the emails that are displayed in the search result
list:

Restore a copy

Restore To

Restore

Save search result to file

Export data

Mark for deletion

Recover a document
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Restore a copy

A copy of one or more archived emails are restored to their original location. This is useful when
a user has deleted an email that was archived and would like to restore it from the archive again.

Steps to restore emails to their original mailboxes

1. Select one or more emails. Then right-click and select Restore a copy from the context menu.

4+ Advanced archive search PERFER
Messages | Settings
Find items that match these criteria:
AndfOr  Field Operator Value
+ x O |SubJEEt V||Cnntains V||Divisinn

=+ Add new clause

Search only in the following maiboxes

User From Subject Folder Received Size  Retention Ve

=] Ishna Mohan [5] jvicin n a/11/2020 2:3 3

B4 Karl Jordan [7] davidwebb @demot Select all items 1/2020 2:33 AM 11.79KB 3

B4 IshnaMohan[3]  devikasharma@der Restore a copy 1/2020 2:33 AM 9,17 KB 3
Restore to
Restore
Save search result to file

< >
Export data

Page: | 1| of 1 K < > A
Mark for deletion
Recover document Search | | Clear

2. The Restore window opens.

Restore options

Delete all versions of the item

[] restore shortout only

| Accept || Zancel |

¢ Delete all versions of the item - select this option to restore the email to the mailbox and
delete all other versions.

o Restore shortcut only - select this option to restore only the shortcut.

NOTE: Either the shortcut or the email is restored to the mailbox even if the original
shortcut/email is also in the mailbox, i.e. duplicate items can be created. If no checkbox

is selected, the whole email is restored to the mailbox without marking any version for
deletion.

3. Click Accept.
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Restore To

One or more archived emails can be restored to another location.

Steps to restore emails to another location

1. Select one or more emails. Then right-click and select Restore a copy from the context menu.

+ Advanced archive search FPFEREFR

Messages | Settings
Find items that match these criteria:
AndfOr  Field Operator Value
+ X O |5L.IbJECt ~ | |Ccmﬁins ~ | |Division
+ add new cause
Search only in the following maiboxes
User From Subject Folder Received Size Retention Ve
|| Ishna Mohan [5] NTal 2112020 2:33 AM 3
B4 Karl Jordan [7] davidwebb @demod Select all items 11/2020 2:33 &AM 11.79KB 3
i Ishna Mohan devikasharma@der 11/2020 2:33 AM 9.17KB 3
Restore a copy
Restore to
Restore
Save search result to file
L4 >
Export data
Page: | 1| of 1 K > A
Mark for deletion
Recover document Search | | Clear

2. The Restore window opens.

Restore options
Destination:

Delete all versions of the item

[] restore shortout only

Skark

Zhange

| Zancel

a. To specify a destination mailbox folder click Change. The Mailbox folders window opens.

b. Click Change to choose another mailbox or click Refresh to display the folders in the

selected mailbox.
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B Mailbox folders B

Mailboo:
|devikasharma || Change. .. || Refresh |

Mailbox folders:

=) Calendar A
L.{[3) Birthdays

£ Contacts

-{Th Conversation Action Settings

{7y Deleted Ttems

- Drafts

{7y ExternalContacts

4T Inbox

-5 Journal

-4 Junk Email

Ty Notes

-y Outbox

b=

-|[3) Sent Items

--{7) Tasks v

| o4 || Zancel |

c. Select afolder from the list of folders and click OK to close the window.

Restore

]

Restore options
Destination:

Mailbox: Devika Sharma [4] Change

Folder: Sales Event

Delete all versions of the item
] restore shortout only

| Skark || Cancel |

d. Check Delete all versions of the item to restore the email to the mailbox and delete all
other versions.

e. Check Restore shortcut only to restore only the shortcut.

1 | NOTE: Either the shortcut or the email is restored to the mailbox even if the original
shortcut/email is also in the mailbox, i.e. duplicate items can be created. If no
checkbox is selected, the email is restored to the mailbox without marking any
version for deletion.

3. Click Start to restore the selected emails to the new destination.
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Restore

One or more archived emails can be restored to their original location. This is useful when a user
has deleted an email that was archived and would like to restore it from the archive again.

Steps to restore emails to their original mailboxes

1. Select one or more emails. Then right-click and select Restore from the context menu.

# Advanced archive search PERFER

Messages | Settings
Find items that match these criteria:
AndfOr  Field Operator Value
+ x O |SubJEEt ~ | |Cnnt3ins ~ | |Divi5inn

=+ Add new clause

Search only in the following maiboxes

User From Subject Folder Received Size  Retention Ve

[| Ishna Mohan [5] davidwebb @democorp.com ivicic s 21020 9:33 AM 3

B4 Karl Jordan [7] davidwebb @democorp. com Select all items 2:33 AM 11.79 KB 3

B4 Ishna Mohan devikasharma@democorp. o 2:33 AM 9.17KB 3
Restore a copy
Restore to
Restore
Save search result to file

< >
Export data

Page: | 1| of 1 K < > A
Mark for deletion
Recover document Search | | Clear

2. The Restore window opens.

Restore options

[] restore shortout only
[[] recreate missing folders

| Accept || Zancel |

o Restore shortcut only - select this option to restore only the shortcut.

o Recreate missing folders - select this option to restore Outlook folders with archived items
that were accidentally deleted. This option can be combine with the previous option.

3. Click Accept. The Restore messages window opens.

4. Track the progress of the restore operation and click Close when done. The search resultis
refreshed.

1 | NOTE: If none of the options are selected, the default setting is Delete all versions of
the item which restores the email to the mailbox and deletes all other versions.
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Depending on your search settings, you may or may not see green and blue icons. If

you select items marked for deletion (blue icon) or a combination blue and green icons

from the search result, then the Restore option is deactivated because information

items marked for deletion cannot be restored.

Save search result to file

You can export all the items in the search result to an XML file.

Steps to export data

1. Right-click anywhere in the search result and select Save search result to file from the context

menu.

# Advanced archive search PERFER
Messages | Settings

Find items that match these driteria:

+ X
+ Add new clau

AndfOr  Field

Operator Value

|SubJe|:t ~ | |Ccntzins ~ | |Division

Se

Search only in the following maiboxes

[

User

Ishna Mohan [

Karl Jordan [7]

EEH

Ishna Mohan [5]

From

5] davidwebb Bdemocorp. com
davidwebb@democorp. com

Subject Folder Received
Division. .. PYEYIE T
Division... Inbg Select all items

devikasharma@democorp.com  Division...  Inbg Restore a copy

Restore to
Restore

Size Retention Ver

]
sE

Save search result to file

Export data

Page: |

1] of 1

Messages: 1-
Mark for deletion

Recover document

>

(4 ¥ A

Clear

2. The Save export file window opens.

3. Specify the name of the file and click Save.
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& Save export file x

T @ » ThisPC » Documents » v 0 Search Documents 0

Organize = New folder == o

ES

L Name Date modified Type Size

7 Quick access
[ Desktop

* Downloads
@ Documents

[] Conference Emailsxml 11/25/2019 9:51 PM XML Document 1KB

LN

| Pictures

Resources

&8 This PC
[ Desktop
@ Documents
; Downloads
J‘s Music
=

Pictures
v

File name: | Sales Event Emails.xml

Save as type: | XML files (*xml)

A Hide Folders Cancel

Export data

Archive Manager for Exchange allows exporting of found items to a mailbox or PST file by running
export tasks. Administrator can even export emails saved in several search result files by adding
one or more documents to one export task.

Steps to export search results

1. Right-click anywhere in the search result and select Export data from the context menu.

# Advanced archive search PFEREEFR
Messages | Settings

Find items that match these criteria:

AndfOr  Field Operator Value

+ X O |Subjev:t w | |Conmins w | |Division

+ add new clause

Search only in the following mailboxes

User From Subject Folder Received Size  Retention Vel
™| 1shna Mohan [5] davidwebb @democor e - g 2020 2:33 AM
B Karl Jordan [7] davidwebb @democar Select all items 2020 2:33 AM 11.79KB
B Ishna Mohan [5] devikasharma@demo Restore a copy (2020 2:33 AM 9.17KB

w0

Restore to
Restore

Save search result to file

Export data *
Page: | 1] of 1 - K < 3 A
Mark for deletion

Recover document | Search | | Clear |

2. The Export tasks window opens. You can also open this tool when you click Export tasks from
the Tools menu. For more information about exporting data see Export Tasks.
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Mark for deletion

This option marks selected documents as deleted. Only documents marked as deleted can be
purged from the archive after their retention time expires. They will be completely deleted with
the Delete Files job, if such a job is scheduled. Documents that are not marked as deleted will
never be purged unless you have defined a retention time for them.

Steps to mark items for deletion

1. Right-click the selected item in the search result list view and select Mark for deletion option
from the context menu.

# Advanced archive search PERFER

Messages | Settings
Find items that match these driteria:

AndfOr  Field Operator Value
+ X O Subject ~ | |Contains ~ | |Division

<+ Add new clause

Search only in the following maiboxes

User From Subject Folder Received Size Retention Ve
| 1shna Mohan [3] davidwebb @democorp N
Select all items
B Karl Jordan [7] davidwebb @democorp| 020 2:33 AM 11.79KB 3
i IshnaMohan [5]  devikasharma@democ Restore a copy 020 2:33 AM 9.17KB 3
Restore to
Restore
Save search result to file
¢ Export data 2
Page: 1| of 1 - K ¢ » A
| | ! Mark for deletion |
Recover document | Search | | Clear |

2. Thenclick Yes. As aresult the item will be marked for deletion. It will neither be accessible in
the Archive Manager for Exchange sever nor in the ArchiveWeb application. It can be only be
found with the Advanced Archive Search.

Recover document

Email items that are marked for deletion but available in the archive are displayed with blue
icons in the search results list. It is possible to recover these documents and view them in Archive
Manager for Exchange server and in ArchiveWeb.

To recover document marked for deletion:

1. From the Settings tab ensure that either of the options Search in archived and deleted
documents or Search in deleted documents is selected.
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option from the context menu.

#+ Advanced archive search PFEREERR
Messages || Settings
Find items that match these criteria:
AndfOr  Field Operator Value
+ x O |5ubJEEt ~ | |Cuntﬁins ~ | |Divi5iun
+ Add new clause
Search only in the following maiboxes
User From Subject Folder Received Size Retention Ve
B4 Karl Jordan [7] davidwebb @democorp. com Division... Inbox 9/11/2020 2:33 AM 1L.79KB 3
B 1shna Mohan [5] davidwebb@democorp.com Division... Inbox 9/11/2020 2:33 aM 8.79KB 3
| David webb [3] devikasharma@democar) o B 233 AM 68.34KB 3
Select all items .
i  Ishna Mohan [5] devikasharma@democory PO 2:33 AM 9.17KB 3
Restore a copy
Restore to
Restore
< >
Page: | 1| of 1 Save search result to file K ¢ 5 N
Export data
| Search | | Clear
Mark for deletion
| Recover document |

2. Right-click the selected item in the search results list view and select Recover document

3. Asaresultthe deletion mark will be removed and the item will be again displayed on the
Archive tab in the Archive view as a lost item. It will be also be accessible in ArchiveWeb.
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Appendix

e How to create a customized HTML shortcut template

How to create a customized HTML shortcut
template

On the Shortcut tab of the Archive Manager for Exchange (Tools/Options/Archive
settings/Shortcut tab) you can configure Archive Manager for Exchange to create HTML shortcuts
for archived emails. The appearance of the archived email in the Outlook Preview pane depends
on the template which you choose on that Shortcut tab. Besides the default template for the
shortcuts you can create your own templates satisfying your criteria and thus modify the design
of the Outlook preview pane for archived emails.

To create your own template:
1. Go to <installdir>\ Quest\MAM4Exchange\Tools\Templates.

2. Inthe Template directory create a new folder. Its name will be the name of your new
template displayed on the Tools\ Options\ Archive settings\ Shortcut tab of Archive Manager
for Exchange (in our example the name of the template is Beautiful).

& C:'.Program Files\Metalogix’PAM4exchange’ Tools, Templates 101 =l
File  Edit  Wiew Faworites Tools  Help | ;1.'
0 Back = . + T | ) search | Folders | & G X ) | -
Address I_.\ C:\Program Files\Metalogix|PaM4exchangel Tools Templates j Go
Mame | Sizel Type | Date Modified | Attributes |
[y Default File Folder 11/24/2008 11:05 AM
@Attachmentunk.html 1KB HTML Dacurnent 2/27[2007 4:56 PM 4
@samplenttachmentunk.html 1KE HTML Document 212712007 4:56 PM [
& sampleHTMLShartcut, html 3KE HTML Document 6142007 3:13 PM A
Beautiful File Folder 11/25/2008 4:03 PM

3. Copy the sampleHTMLShortcut.html file to the new template folder (in our case to Beautiful).
Or copy the html file from the Default folder, if the sample is not available.

4. Rename the sampleHTMLShortcut.html to HTMLShortcut.html.

5. Now you can modify the HTMLShortcut.html file in the new folder to create your template. To
do so, open the file in Notepad and edit the HTML code.

Important variables:

%ATTACHMENTS% - email attachments

Quest® Archive Manager for Exchange Administration Guide

) 248
Appendix



%BUTTONS% - buttons

%BODY% - message body

%PROPERTIES% - message specific properties needed for Macintosh clients

The original HTML:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtmll/DTD/xhtmll-strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">

<head>

<meta http-equiv="content-type" content="text/html; charset=utf-8"/>

<title>

</title>

<style type="text/css">
<!l--
body {

margin: 0;

text-align: center;
padding-top: 10px;

}

td.hlavicka {

display: block;

height: 20px;

color: white;
background-color: #6699FF;
font-family: arial;
font-size: 1l4px;
text-align:left;

td.hlavicka span {
font-weight: bold;
padding-left: 5px;
}

td.buttons {
vertical-align: bottom;
text-align: right;
padding-right: 10px;
padding-bottom: 10px;

}

td.buttons a {

color: #FFFFFF;
background-color: #6699FF;
font-family: arial;
font-size: 1llpx;

padding: 5px;

border: 1lpx solid #333366;
font-weight: bold;
text-decoration: none;
margin-left: 3px;
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td.buttons a:hover {
font-size: 12px;
font-weight: bold;
}

td.prilohy {
background-color: white;
font-family: arial;
font-size: 12px;
padding: 5px 5px bSpx 5px;
text-align:left;
}

td.prilohy a {
color: black;
margin-right: 15px;
margin-top: 15px;
font-style: normal;

}

td.prilohy a:hover {
text-align: center;
font-weight: bold;

}

td.ciara {
background-color: #333366;
width: 100%;

}

td.text {

display: float;

color: #2a2a2a;
text-align: center;
background-color: white;
font-family: arial;
font-size: 12px;
padding: 5px;
text-align:left;

td.stred {
border: 1lpx solid #333366;

}

td.pata {

display: block;

width: 99.9%;

height: 15px;
background-color: #6699CC;
padding-right: 0;

}

-—>

</style>

</head>
<body>

<table width="100%" border="0"

cellspacing="0" cellpadding="0">
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<tr>

<td bgcolor="white" class="stred" height="100%" >

<table width="100%" border="0" height="10" cellspacing="0"
cellpadding="0">

<tr>

<td height="100%" class="hlavicka"> <span>This message was

archived</span></td>
</tr>
</table>

<table width="100%" border="0" height="10" cellspacing="0"
cellpadding="0">

<tr>
<td height="100%" class="prilohy">%ATTACHMENTS%</td>
<td height="100%" class="buttons" nowrap>%$BUTTONSS%</td>
</tr>
</table>

<table width="100%" border="0" height="2" cellspacing="0"
cellpadding="0">
<tr>
<td bgcolor="#a0c3c9" width="100%" height="2px"></td>
</tr>
</table>

<table width="100%" border="0" height="10" cellspacing="0"
cellpadding="0">

<tr>
<td height="100%" class="text">
<pre WRAP="hard">%BODY%</pre>
</td>

</tr>

</table>

<table width="100%" border="0" height="10" cellspacing="0"
cellpadding="0">
<tr>
<td height="100%" class="pata"><b></b></td>
</tr>
</table>
</td>
</tr>
</table>
</body>
</html>
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Sample email Install guide
Adrrinistrator Iviel Gibson
To Vel e
Ce: Sandk Bubck
Amachments:

This message was archived
Joap Buihlzs bp
Bello,

tala iz a saple email.

Beat zegards

/] =

Default HTML shortcut in the preview pane Example of customized HTML shortcut

Registering in Entra ID for EWS

1. Open https://entra.microsoft.com/ and login as administrator.

2. From the navigation pane, click Identity > Applications > App registrations and then New
registration.

3. Enter a meaningful application name that will be displayed to users. For example,
ArchiveManagerClient. From the Supported account types section, select Accounts in this
organizational directory only . Then click Register.
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https://entra.microsoft.com/

Home » App registrations >

Register an application

* Name

The user-facing display name for this application (this can be changed later),

| ArchiveManagerClient “

Supported account types

Whao can use this application or access this API?
@ Accounts in this organizational directory only (Democorp Software only - Single tenant)
O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

O Accounts in any organizational directory (&ny Microsoft Entra ID tenant - Multitenant) and personal Microsoft accounts (e.g. Skype,
Xbox)

O Personal Microsaft accounts anly

Help me choose..

Redirect URI (optional)

we'll return the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but 2 value is required for most authentication scenarios.

Select a platform v ‘ e.g. https://example.com/auth

Register an app you're working on here. Integrate gallery apps and other apps from outside your organization by adding from Enterprise applications.

By proceeding, you agree to the Microsoft Platform Policies =
Your application is registered. Microsoft Entra ID assigns a unique Application (client) ID to
your application, and the application's Overview page opens.

1 | IMPORTANT: Copy and save the Application (client) ID to Notepad and store it in a safe
place.

From the navigation menu, click Certificates & Secrets. In the Client secrets section click New
client secret. The Add a client secret page opens.

Enter values as described below:
a. Description - enter a meaningful description. For example, ArchiveManagerClient Secret.
b. Expires - set the expiry term that best meets your company policy.

Click Add. the client secret is displayed on the Certificates & Secrets page.

Certificates (0) Client secrets (1) Federated credentials {0)

A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.

T New client secret

Description Expires Value O Secret 1D

ArchiveManagerClient Secret 11/8/2025 U3780~8IR~gQG)yivznLOiig~0j2Z81431..| [ | 67h25a57-09e5-4257-a8b4-03 1beeld648c [ [H]
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1 | IMPORTANT: Copy and save the client secret value to Notepad and store it in a safe
place. It will not be available when you navigate away from this portal.

8. From the navigation pane, click APl permissions > Add a permission to open the Request AP/

permissions window. Then click APIs my organization uses and select Office 365 Exchange

Online.

Home > App registrations > ArchiveManagerClient

- ArchiveManagerClient | APl permissions s

<
H Overview
Quickstart
# Integration assistant
Manage
B Branding & properties
3D Authentication
Certificates & secrets
il Token configuration
APl permissions
& Expose an API
HL App roles
& Owners

dh, Roles and administrators

A7 Got feedback?

© Refresh

@ The "Admin consent required" column shows the default value for an organization. Hov
where this app will be used. Leorn more

Configured permissions

Applications are authorized to call APls when they are granted permissions by users/:
all the permissions the application needs. Learn more about permissions and

t Add a permission | ~ Grant admin consent for Metalogix Software

API / Permissions name Type Description
~Microsoft Graph (1
UserRead Delegated  Sign in and read user profile

To view and manage consented permissions for individual apps, as well s your tenant's

Request API permissions

Select an API

Microsoft APIs | APls my organization uses| My APls

Apps in your directory that expose APIs are shown below

A Office 365 Exchange Online

Name Application (client) 1D

Office 365 Exchange Online 00000002-0000-0ff1-ce00-000000000000

9. Inthe Request APl permissions page, select Application permissions. Then select

full_access_as_app and Exchange.ManageAsApp. Then click Add permission to confirm your

selections.

Request API permissions

< All APIS

Office 365 Exchange Online

https://outlook.office.com

What type of permissions does your application require?

Delegated permissions

Your application needs to access the APl as the signed-in user.

Select permissions

X
Application permissions
Your application runs as s background service or dasman without a
signed-in user.
expand sl

2 Start typing a

permission to filter these results

Permission

~ Other permissions (1)

full_access_as_app @

Admin consent required

~ Yes
. Use Exchange Web Services with full access to all mailboxes
» Calendars
> Contacts
~ Exchange (1)
Exchange.ManageAsApp O
Yes

> IMAP

> Mailbox

Manage Exchange As Application

10. In the API permissions page, click Grant admin consent for Archive Manager Software.
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Configured permissions

Applications are authorized to call APIs when they are granted permissions by users/admins as part of the consent process. The list of configured permissions should include
all the permissions the application needs. Learn more about permissions and consent

Add a permission |~ Grant admin consent for ArchiveManager Software I

APl / Permissions name Type Description Admin consent requ... Status

~ Microsoft Graph (1) R
User.Read Delegated  Sign in and read user profile No @ Granted for Metalogix S, *++

v Office 365 Exchange Online (2) Lo
Exchange ManageAsApp Application  Manage Exchange As Application ‘fes @ Granted for Metalogix§,, ==
full_access_as_app Application  Use Exchange Web Services with full access to all mailboxes  Yes @ Granted for Metalogix S, *++

To view and manage consented permissiens for individual apps, as well as your tenant's consent settings, try Enterprise applications.

11. Before you start using the application you must assign the Exchange Administrator role to the
ArchiveManagerClient app. Open the app and click Roles and administrators.

12. From the navigation pane, go to Roles & Admins > Roles & Admins. Search for the Exchange
administrator role and double click it.

Home >
Roles and administrators | All roles X
* ArchiveManager Software - Microsoft Entra ID for workforce
N ew custom role [ Delete customrole & Download assignments (O Refresh [ Preview featuras & Got feedback?
& Allroles

& srotected act @ To create custom roles, your orgenization needs Micrasoft Entra ID Premium P1 o P2. Start a free trial,
& protected actions

# Diagnose and sclve problems

Activity A\ There are currently €8 privileged role assignments. It is recommended to not exceed 10.
5 Access reviews
(@ Your Role: Global Administrator and 6 other roles
& Audit logs
Administrative roles
Administrative roles are used for granting access for privileged actions in Microsoft Entra 1D, We recommend using these built-in roles for delegating access to manage broad application configuration permissions without granting
access to manage other parts of Microsoft Entra ID not related to application configuration. Leam more,

S Bulk operation results

Troubleshooting + Support
Learn more about Microsoft Entra ID role-based access control
& New support request

22 exehange Admin | g acd fiters
Role Ty Description Privileged T4 Ass.Ay Type
[ exchange administrator Can manage all aspects of the Exchange product 15 Built-in

13. Click Add assignments and find your application. For example, ArchiveManagerClient. Select it
and click Add to confirm.

Home > Roles and administrators | All roles > Exchange Administrator

Add assignments
2a Exchange Administrator | Assignments

All roles

Remove a @ Try changing or adding filters if you don't see what you're looking for.

K Diagnose and solve problems

Search ()
Manage - -
< @ You can also assign built-in roles to £ ArchiveManagerClient B
&2 Assignments
. R All Users Enterprise applications
[=l Description Search —_
‘ Search by name
Activity Type Name Type Details
#% Bulk operation results ‘ All A
ArchiveManagerClient Enterprise ap... 9d438109-233e-40dc-97ee-503c30afddcf

Name

Troubleshooting + Support

& New support request

14. Open the Archive Manager Administration Center and import Exchange Online server with
your Exchange Online administrator email, Client ID and Client secret.

Quest® Archive Manager for Exchange Administration Guide

) 255
Appendix



10

About Us

Quest creates software solutions that make the benefits of new technology real in an
increasingly complex IT landscape. From database and systems management, to Active Directory
and Exchange Online management, and cyber security resilience, Quest helps customers solve
their next IT challenge now. Around the globe, more than 130,000 companies and 95% of the
Fortune 500 count on Quest to deliver proactive management and monitoring for the next
enterprise initiative, find the next solution for complex Microsoft challenges and stay ahead of
the next threat. Quest Software. Where next meets now. For more information, visit
www.quest.com.

Contacting Quest

For sales or otherinquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and custome
rs who have trial versions. You can access the Quest Support Portal at https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal helps you to:

e Submit and manage a Service Request

e View Knowledge Base articles

e Sign up for product notifications

e Download software and technical documentation
e View how-to-videos

e Engage in community discussions

e Chat with support engineers online

e View services to assist you with your product
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